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Exercise 1

1. Getting Started

This exercise introduces the GEOPAK Drainage workflow to complete the setup
required for a new project. The user will review the project information and set the
preferences.

GEOPAK Drainage gives you the best design and analysis based on the input that
you enter. Engineering judgment must be used to evaluate the output that the
program produces. Refer to the TDOT Roadway Design Division Drainage Manual
for additional guidance.

1.1 Project Workflow

The GEOPAK Drainage workflow mirrors a conventional design process beginning
with the design of the surface collection system (inlets, drainage areas) followed by
the design of the conveyance system (subsurface pipes, channels).

Roadway alignments, vertical profiles, and digital terrain models (DTM) may be used
throughout GEOPAK Drainage to provide pertinent information to the drainage
design. All drainage components feature interactive graphical placement tools for
easy definition of the drainage system.

Each of these components (inlets, areas, and pipes) is composed of two basic types
of information:

o Spatial information describing its location, shape and connectivity.

o Hydraulic and Hydrologic information describing its properties, conventions
and other associated attributes.

1.2 Drainage Components

GEOPAK Drainage organizes the components of a drainage system according to
their spatial characteristics. Spatial information is stored as Nodes, Links and
Networks. This information is stored in a *.gdf file — GEOPAK Drainage File.

Nodes: A node (inlets, manholes, etc.) is a point with a user-defined location. The
location may be in Cartesian coordinates (x,y) or in curvilinear coordinates (station,
offset).

Links: A Link represents a linear feature depicting a path connecting two nodes,
traversing upstream to downstream. The path may be straight line or curvilinear
(along a graphic element).

Networks: A network is a system of interconnected nodes and links that form a
system through which water can flow to a single outlet node. A drainage project
accommodates any number of Networks.
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Other associated components in GEOPAK Drainage include:

Areas: A drainage area can be represented by a closed boundary or simply keyed-
in (acres or hectares). All flows from a single drainage area are tributary to a single
Node. There is a one to one correspondence between a node and an area.
Therefore areas and nodes share the same name (ID). A drainage area may contain
multiple subareas representing homogeneous features such as soil types and land
uses (“C” values), thereby allowing composite "C" value calculations.

Profiles: A profile represents a linear feature depicting a path connecting two nodes,
it is different than a link in that a path may span multiple links and traverse upstream,
downstream, or any combinations. The primary purpose of a profile is to allow
visualization of a profile view between any two nodes in a drainage network.

1.3 Directory Information
Class files are located in the directory c:\Projects\Drainage\*.*

1.4 GEOPAK User Preferences
a) Utilizing MicroStation, open DVSR1proposed.dgn using the tdot interface.

b) Activate GEOPAK by going to Applications > GEOPAK > Activate

GEOPAK. The GEOPAK User Preferences control the output format of data
produced using GEOPAK. Access the User Preferences by selecting Applications
> GEOPAK> Road > User Preferences.

U = VO LAIN] = LTEINage: UNTNEd = INeTWONG one

ities Workspace | Applications | Drainage Window T.D.0.T. Help

it = | GEOPAK b Deactivate GEOPAK
— —  Map 3 1
| ROAD

SITE
SURVEY
DRAINAGE
WATER SEWER
LANDSCAPE
Training Element Attributes

3PC AdHoc Attribute Manager

ROAD Tools
Project Manager
Cormidor Modeling

Site Modeling
Active Chain Control

About GEOPAK

|_ User Preferences
Geometry »

Design & Computation Manager
Quantity Manager

Plans Preparation »
DTM Tools

3D Tools »
Cross Sections 3

Utilities »

Help

c) Set the Units to English, Stationing to 12+34, and Working Directory to
C:\Projects\Drainage\ and click OK.

NOTE: For your project, this would be your working directory.
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Exercise 1

H Uzer Preferences EI
Unit System: Outpust Aocuracy
Distance:
Coordinates:
Station: | 5+55(9).12 -
Direction:
Angle Seconds:
Station:
Working Directory: | C:\ProjectsDrainage Q,

[ Feature Preferences...
| COGO Prefersncss

[7] Show this dialog at startup

Cancel

1.5 GEOPAK Drainage Menu

a) Access GEOPAK Drainage from MicroStation’s Applications menu:

osed.dgn [2D - V8 DGN] - Drainage: Untitled - Netwerk: None _

Tools

? ’Dea‘ault h. 4

Utilities  Workspace

GEOPAK ¥ Deactivate GEOPAK

t

Map »

Applications | Drainage Window T.0.O.T. Help

ROAD
SITE
SURVEY

DRAINAGE

Drainage

WATER SEWER
LANDSCAPE

Training

*r w | v | v w -

Help

About GEOPAK

All items in Drainage can be accessed through this main GEOPAK DRAINAGE

Menu Bar:

Project Component

Metwork  Reports

Utilities

Tool Boxes

25

Or by invoking the GEOPAK Drainage Main Tool Box from Tool Boxes>Main:
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M DRAINAGE - Untitled - [Mo Active Network] = ] Drainag... &)
| Project Component Network Reports  Utilities | Tool Boxes | w
v | Main @’ d]'
Project =
Area ﬂf’ .-'/'
Mede %r “E:’
Link i
Profile %] %
Network o
il
Routing T
Culvert
Reports
Utilities

Or they can be accessed through the Drainage Menu which has been added to the
main menu bar once you load GEOPAK Drainage.

osed.dgn [2D - V8 DGN] - Drainage: Untitled - Network: None

Tools  Utilities Workspace Applications | Drainage | Window T.D.OT. Help

? ok <) [Jo |l Poje o}l

Component

t Metwork

b
b
Reports k
Utilities 3

]

Tool Boxes

Exit

b) Open GEOPAK Drainage project file DrainageProject.gdf that was copied into the
project directory: C:\Projects\Drainage\.

M DRAINAGE - Untitled - [No Active Netwark] Drainag.. (&3] |
| Component  MNetwork Reports  Utilities Tool Boxes ﬁ'
e | fiE| 1 MNew Drainage Project
— | fLE] = g ]
L e @} 2 Open Drainage Project
L3
| gpen... = 4l 3 Save Drainage Project
Save > 633 4 Dei .
s \{ 4 Drainage Project Save As...
Save As... b
= %] 2 Drainage Preferences
Preferences .iﬁ'; w 6 Drainage Library
- . B
Drainage Library —@: 7 Import Drainage Project
Import » }ﬁ & Export Network
Export » [ 9 Exportto SWMMS
3 @ 0  Export to Preferences to ASCI
Exit
=31 Open asToolBox

NOTE: Every time that you open GEOPAK Drainage, an untitled project will
open. Therefore, you must go to Project>Open and select your project .gdf file
every time you want to edit or continue working on a project.
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1.6 Project Preferences

The Project Preferences control the graphic and computational options of the
drainage system. The Project Preferences may be changed at any time and the
system can then be redesigned or analyzed utilizing the new preferences.

a) Select Project > Preferences.

t‘ DRAINAGE - Untitled - [No Active Network] ‘ &J] Drainag... [z
| Project | Component MNetwork Reports  Utilities  Tool Boxes | E
_—
Open.. @Drainage Preferences
Save = /
Save As.. ciy
B 7,
Preferences
Drainage Library \T,, ",,
Import L %], %
Export 4 _‘ﬁb
Exit -
NOTE: Each Drainage Project should begin by copying the file

DrainageProject.gdf from C:\Users\Public\GeoPak Standards into the project
folder. This step automatically imports all needed preferences. If this step is missed,
TDOT Standard Preferences may be loaded after opening the Preferences window
and going to File > Open and navigating to the following file:
C:\Users\Public\Geopak Standards\TDOTdrainageprefs.dpf

Review the Preferences by selecting each option in the column and reviewing the
various options.

b) Units:

M Preferences - Units ¢|
File

Options
Units @ English ™ Metric

iject HOTp Drainage Area = Acres Drainage Area = Hectares

Rairtall Parameters Length = Feet Length = Meters

Land Use Options Dimension = Feet Dimension = Meters

Frequency Options Depth = Feet Depth = Meters

Intensity Option Discharge = Cubic Feet per Second Discharge = Cubic Meters per Second
Junction Losses Velocity = Feet per Second Velocity = Meters per Second

Inlet Options Intensity = Inches per Hour Intensity = Milimeters per Hour

MNode Options
Link Options
Profile Options
Plan Symbology
Updates

Save Options

QK Cancel
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c) Project Components:

o %
M Preferences - Project Components ‘ El_'lﬁ
File
Options Drainage Library File (DLB): | C:\Users“\Public®Geopak Standands’ Q
Units T ———
Ty pe— GPK Job Number: C, | User Preferences
Rainfall Parameters Drainage Cell Library: | C:\Users\Public\MicroStation Standi| <
Land Use Options e = - — 3o,
Frequency Options Criteria Directory: | C:\Users‘\Public\Geopak Standards
Intensity Option DDE; | CAlUsers\Public\Geopak Standards' | @
Junction Losses
Inlet Options Water and Sewer Project: a,
Node Options Superelevation Shapes File: | DVSR15EShapes.dgn Q,
Link Options
Profile Options [7] Site Project: Q
Plan Symbology Criginal Ground
Updates TiNFie ~ Sy
Save Options
Design Suface
TINFle  »| |finaltin Q
| OK | | Cancel |
— —_—

The following items are set to the defaults and NO CHANGES need to be
made:

Drainage Library File (DLB) — C:\Users\Public\Geopak Standards\TDOTEnglish.dlb

User Preferences — These settings are already set for you for this exercise.
Drainage Cell Library - C:\Users\Public\MicroStation Standards\cel\STDS.CEL
Criteria Directory - C:\Users\Public\Geopak Standards\Criteria

GEOPAK DDB: C:\Users\Public\Geopak Standards\tdot.ddb

For each Library and Directory file location, select the explorer button and go
to the following file locations:

GPK Job Number — Pick the GPK file and it will automatically set the correct
number (this only happens if it goes to the correct User Preferences)

Superelevation Shapes File — Choose DVSR1SEShapes.dgn from the project
directory

Design Surface — Choose final.tin from the project directory. This final tin is a
combination of the proposed tin and existing tin. The final tin includes the proposed
areas inside the slopes and the existing area outside the slopes. The tin file has
been created for your use in class. Refer to the Geopak Road Course Guide
Chapter 22 for instruction on how to create a final tin file for your project.
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d) Rainfall Parameters:

Exercise 1

' S B

File

Options

Units Rational Method

Project Components Rainfall Source: [Lebanon ']
Rairfall Parameters

Land Use Options SCS Method

Frequency Options : : T =
Intensity Option Rainfall Source: [None Awvailable ]
Junction Losses @ Antecedent Moaisture Condition |

Inlet Options (71 Antecedent Moisture Condition 11

Node OF_'t'O”S () Antecedent Moisture Condition 111

Lirk. Options - E

Profile Options Hydrograph Time Interval: | 0.000

Plan Symbology

Updates

Save Options

Select the appropriate rainfall source for the city closest to the project site.

See the TDOT Drainage Manual, Chapter 4, Figure 4A-1 or Appendix I.

NOTE: The Tennessee Department of Transportation Roadway Design Division
uses the Rational Method for drainage design.

e) Land Use Options:

“ Preferences - Land Use Options [= | | & |
File
Olions H.E_l?ion.al Method
Lnits i@ Single Land Use ftem: [H.I.IIE| Steep V]
Preict Chinparas () Muttiple Land Use ltem: . . .
Rainfall Parameters Land LUge ftem | Level | Color | Weight Style l
Land Use Options
Frequency Options
Intensity Option
Junction Losses - T
Inlet Options Urban v | Symbology: |
Mode Options SCS Method
Link Options @ Single Land Use tem: [Urban -]
Profile Options 7 Muttiple Land Use kem:
Plan Symbology e ]
Updates Land Use tem | Level | Color | Weight Style !
Save Options
[ 0K l [ Cancel l |Urban - | Symbology: .

.,

o

Set the Land Use Option to Single Land Use Item: Rural Steep for this class.
The Roadway Design Division does not use the option for Multiple Land Use
Items. All definitions for land use must come from a specific category.
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f) Frequency Options:

|‘|

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

MNode Options

Link Options
Profile Options
Plan Symbology
Updates

Save Options

H Preferences - Frequency Options = 8 | 22
File
Cptions
Units Drainage Librany (DLB): ...\Geopak Standards*TDOTEnglish.dlb

| OK | | Cancel |

Rational Frequency Options

Computation Funoff Coefficient

Frequency: Pesking Factor:

(50Year x| [1.0000 |
SC5 Frequency Options

Cumulative Funoff Coefficient

Frequency: Peaking Factor:

[ »] [1oo00 |

ot

g) Intensity Options:

|

Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options
Mode Options
Link: Options
Profile Options
Flan Symbology
Updates

Save Qptions

| oK | [ Cancel |

File

Options

Units Drainage Librany (DLEB): ... \Geopak Standards* TDOTEnglish dib
F'rc!jed Compints Minimum Time of Concentration: | 5.0000 j

Rairfall Parameters st

Accumulate Pipe Flow Time by: [ Unform Fow Velocity |
Imtensity Options
i@ Compute Intensity from Library Rainfall Data Source
(") Mbsolute Intensity: H}EEL‘L‘_'—|
[] Weight Time of Concentration

Inlet Computation Onty

[] Absolute Intensity: | 0.0000 |
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h) Junction Losses Options:

“ Preferences - Juncticn Losse
File
Options | Disable All Junction Loss Computations
Units -
Loss Vel ; b
Project Components B ey
Rainfall Parameters Description Loss Coefficient - K
Land Use Options e -
Frequency Options ok Pressure Expansion: | 0.3000
Irrteng:_t:.r Eptcxi :__: Free Surface Expansion: [_1]11][[!
Junction Losses — -
Inlet Options = Pressure Contraction: iEEDDD
Mode Options e
Link Options = Free Surface Cortraction: |_Q._'19pﬂ
Profile Options intat ;
Plan Symbalogy T Bend Loss:
Updiics = Terminal Inlet/Junction: | 1.0000
S om0 |
1 F Simple Junction:
[ oK l [ Eoneel ] o Complex Junction: [Method 1 =

i) Inlet Options:

tions LG_'I_M, —

—
# Preferences - Iniet 0
File

Options
Units Inlet By Pass Options: [ By Pass as Total Discharge = |

Froject Components ) o — 2 =
il P Link By Pass Flow Options: [ Do Mot Allow Inlet By Pass in Link Discharges |

Land Use Options Default Spread n Value: | 0.0160
Frequency Options A

Intensity Option [7] Bxtend Superelevation Shapes to Inlet at Shape Slope
Junction Losses
Inlet Options
MNode Options
Link Options
Profile Options
Flan Symbalogy
Updates

Save Options

(0K [Concsl]
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]) Node Options:

File

Options
Units
:gﬁjﬁ‘;g:;ﬁs [7] Scale Node Cells ~ Scale Factor: [ 1.0000
Land Use Cptions Minimum Freeboard: | 0.0000 I
Frequency Options 5 :
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options
Profile Cptions
Plan Symbology
Updates

Save Options

Default Node 1D Prefic: | CB- :

[ OK | [ Cancel |

k) Link Options:

, —_—
File
Options | Defautt Link ID Prefoc: | S5- ]
nits Link Profile Options
Project Components Design Optimization: | Minimize Depth of Cover »|
Rairfall Parameters : ik : =
ok At Ohoeie Blevation Option: [at Actual Link End  +|
Frequency Options Link Design Options
Intens.rt-_.r L @ Design for Maximum Capacity
Junction Losses it : ;
Inlet Options (71 Design for Full Capacity -
Mode Options () Design Partial Capacity (d/D) Ratio: | 1.0000 __]_
Link Options (*) Design Partial Capacity {3/Q) Ratio: | 10000 |
Profile Options ) ) — T
Plan Symbology Link Slope Decimal:
Sidaye Link Criteria File
Save Cptions e M| | Q
Hydraulic GradeLine Options
| ok | [cCancel | Hydrauic Gradslin Basis: [Equal Hydraulic Gradsiine |

NOTE: Do not set the Link Slope Decimal to rounding. This setting is for control of
Pipe Design not annotation. If set it will be impossible to design for minimum depth
drainage structures.

[) Profile Options, Plan Symbology, Updates and Save Options should be kept at the
default settings. Do not make any changes.

m) Click OK to save changes and dismiss the dialog.
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1.7 Drainage Library

The Drainage Library is used to store hydraulic, hydrologic, and construction
standards, which may be shared by different projects and designers. Each
GEOPAK Drainage project accesses items from the Drainage Library for use on the
specific project.

a) Select Project > Drainage Library. The library stored in the Preferences will be
opened by default.

The Drainage Library currently contains five (5) tabs as shown below:

'H Drainage Library - ..\Public\Geopak Standards\TDUTEng...[ = ﬁ

File Edit

|_F-Taﬁall_| Land Use | MNodes !I Linkes || Spread Section |

e o o o o
- Z
o
o
()
(2]

Rainfall Data Source

Land Uses, their corresponding “C” values and symbology
Inlets, Junctions, Manholes, Outlets, etc.

Circular Pipes, Elliptical Pipes, Pipe-Arch pipes, Boxes, etc.
Inventory of varying Spread Cross Sections

The Rainfall tab stores the rainfall data information to be used on GEOPAK
Drainage Projects. GEOPAK Drainage supports rainfall sources in the form of
intensity duration frequency (IDF) tables, or as coefficients for intensity-duration-

equation formats.

Hl DRAINAGE - DrainageProject.gdf - [Mo Active Network] | 2 | -
Drainag... @
| Project | Component Metwork Reports  Utilities  Tool Boxes | =
i
Mew... .
Open... @, C:IDrainage Library
Save o, / 5
Save As... %’ BE/:,
Preferences
—ey e
Drainage Library B
P =
Import ] o
= AN
Export » :
Exit
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b) Select the Rainfall tab, highlight Lebanon, and select Modify to review the various
options:

M Drainage Library - .\Public\Ge rds\TDOTEng... sl e
[ File Edit
arfal)] Land Use | Nodes | Lks | Spread Sectin |
_Bement ID | Description |
Shelbyville IDF Curve Data
Manchester IDF Curve Data )
Lebanon IDF Curve Data
Lawrenceburg IDF Curve Data _
Knoxville IDF Curve Data T
Johnson City IDF Curve Data odky:L bty Rem
Jackson IDF Curve Data
Cookeville IDF Curve Data
Clarksvile IDF Curve Data 8
IDF Curve Data

NOTE: See Appendix | for IDF Zone Location Map.

kem ID: | Lebanon | Description: | IDF Curve Data | Data Type: [Table

IUser Defined Frequencies
(200 |[500 |[1000 |[2500 |[50.00 |[100.00 |

Duration

5.0000 55100 63400 65300 77600 3.3600 3.5400
10.0000 44000 50700 55800 61500 66700 71000
15.0000 369500 42300 47100 52300 56200 59300
30.0000 25600 30400 34700 38700 42400 45300
60.0000 16000 1.9500 22200 25800 28700 @ 3.1600

| 1440000 | [0.150 |(0.180 |[[0210 |{0250 ||0.280 |[0310 |

Populate Table By:
| Ok | [ Cancel | [Import ASCII... |[ HYDRO-35... | [ TP40.. |

The table contains the Duration-Frequency Table for the Lebanon area.
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The Land Use tab is used to store runoff coefficients ("C" values) and corresponding
graphic symbology for each land use. Land uses can then be delineated
automatically using the selected symbology.

c) Select the Land Use tab, highlight the Rural Steep item and select Modify to review
the various options:

= = -
M Drainage Library - ..\Public\Geopak Standards\TDOTEng... =28l =h
File Edit

Raria (o U N | ks | Spead Secton |

Element ID Description |
Urban Residential & Commercial
Rural Steep Steep or Impemeable fa|
Rural Aat Fat or Permeable
{Modify Library Item
s
P23

temID: |RuralSteep | Description: | Steep or Impemeable |

Land Use Description Symbaology

Conc/Asphalt Pumt Lv:DESIGN - SCRATCH - User 1, Ca:1, Le:id
AsphattMacadem Pymt Lv:DESIGH - SCRATCH - User 1, Co:5, Le:l
Gravel i Lv:DESIGHN - SCRATCH - User 1, Co:2, Le:d
Bare Earth Lw:DESIGN - SCRATCH - User 1, Co:13, Le
Steep Grass (2:1) Lv:DESIGH - SCRATCH - User 1, Co:14, Lz
Tud Meadows i Lv:DESIGHN - SCRATCH - User 1, Co:8, Leid
Forested Areas ; Lv:DESIGHM - SCRATCH - User 1, Co:28, Lc
Cultivated Fields ; Lw:DESIGN - SCRATCH - User 1, Co:7, Ll

(TufMeadows | (0400 | [—— oK ] [Gos)

Note the various land uses and their associated symbology. Chapter 2 will discuss
how to make a land use file.
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The Nodes tab contains standard configurations for Grates, Curbs and Slotted drain
inlets, as well as Junctions, Outlets and Other nodes. The description, plan view
representation and dimensional information are stored for each node.

d) Select the Nodes tab, highlight a Grate inlet and select Modify to review the various
options:

M Drainage Library - \Publlc\Geopalc Standa rd-s\TDOTEng...Elﬂu
.
File Edit

| Rainfall | Land Use {(Nodes ) Links | Spread Section |

Node Types:

Element ID | Description -
CB#52 9X9 #52 =
CB#51 9X9 #51 a
CB#51 77 #51
CB#51 52°X52" #51
CB#46 9X9 1246 Modify Library Item
CB45 8X4 245
CB#44 9X9 #44
CB#43 8X52" #43
CB#43 8X4 #43 a
CB#43 8 DIA #43
CB#42 8 DIA #42

p e
ﬁ Drainage Library - Nodw

tem D [CB5152%67 | [ ok_|
Description: |#5'I a |

Payltem: | 51 |
Criteria File: i | Q, Plan Yiew Cell:

Plan View Cel: |CB§Z_X62H_, et
Mode Type: [Grate

Profile Type: [On Grade

Data for On Grade
Grate Type:
o [1 ............. _.I
Width: [ 1.813 |
Data for Sag

Area: ._'3-5??
Area Reduction Factor

Permeter

Permeter Reduction Factor

Note the various geometric values required for the nodes.
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Exercise 1

The Links tab contains all culverts to be used on drainage projects. Each link type is
categorized by three properties: Shape, Material and Type (for some combinations
of Shape & Material); and contains information regarding specific culvert geometry,

default roughness coefficient and material combination.

e) Select the Links tab, select Circular from the Shape dialog box and Concrete from

the Material dialog box. Highlight the first Circular Concrete pipe, and select Modify

to review the various options:

r | b’
M Drainage Library - ..\Public\Geopak Standards\TDOTEng... -
File Edit
Rainfall | Land Use | Nodes (irks) Spread Section
Shape: (Croular  v) Matedal: [Concrete +)
Element ID Description 4
102 Inch Dia. Circular PROP. 102" RCP
108 inch Dia. Circular PROP. 108" RCP &
114 Inch Dia. Circular PROP. 114" RCP 2
120 Inch Dia. Circular PROP. 120" RCP =
{126 Inch Dia. Gireular PROP. 126" RCP =
132 Inch Dia. Gircular PROP. 132" RCP EJM"d'f* Loy hem
138 Inch Dia, Circular PROP. 138" RCP |
15 Inch Dia. Cireular PROP. 15" RCP
18 Inch Dia. Circular PROP. 18" RCP a
24 Inch Dia. Gircular PROP. 24" RCP
30 Inch Dia. Circular PROP. 30" RCP -

—

# Drainage Library - Pipe Item

Pipe Properties

ltem 1D: | 15 Inch Dia. Circular
Description: | PROP. 15" RCP
.| 607D2.02

Roughness:
Thickness:

Trench Details
a: | 0500

: | 0.500

b
e 1.200
d: | 0.000

| Cancel ]

Note the various geometric values required for the links.
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The Spread Section tab stores standard spread cross sections for roadway,
shoulders and gutter that can be used on drainage projects.

f) Select the Spread Section tab, highlight any section, and select Modify to review
the various options:

M Drainage Library - ...\Public\Ge I:E andards\TDOTENg...
File Edit
Rainfal | Land Use | Nodes | Links {Gpread Section)|
Element ID | Description
5lane12S 5 lane with 12' shid
5Lane10S 5 lane with 10" shid |
5Lane 5 lane with no shid
4l anedS 4 lane with 8' shid
4lane12S 4 lane with 12" shid —
4Lane10S 4 lane with 10" shid = Meodify Library Item
4Lane 4 lane with no shid
3LanedS 3lane with &' shid
3Lane12S 3lane with 12" shid g
3Lane10S 3lane with 10" shid =
3lane 3lane with no shid
2laneds 2 lane with 8' shid bt

ftem 10 I_;Lane
Description: | 3 lane with no shid

Width % Slope Roughness

2.000 3.500 0.016
18.000 2.000 0.016

(o000 _|[000 | [0000 |

Note the spread cross section characteristics for the spread item.
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Exercise 2

2. Land Use DGN Files

This chapter is provided for REFERENCE ONLY. We have provided the land use file
for you so that all class participants will have the same areas.

For your own project, these exercises would have to be done prior to beginning GEOPAK
drainage.

This exercise allows the user to create a Land Use file.

2.1 Land Use DGN Creation

The shapes created in the land use DGN file are used to specify run-off coefficients
(C value) for different land use areas. These values are then used to calculate the
composite run-off coefficient. This composite value is used in conjunction with
rainfall data in the rational formula to calculate the Q discharge for the drainage
area. This composite run-off coefficient can be manually calculated and entered as a
value but by creating these shapes this can be done automatically for any drainage
area specified on your project.

a) Create a new DGN file for placement of land use shape elements from DGN seed file
SEED2D.DGN and open it. Reference your proposed file, which contains proposed
edges of pavement and slope lines. Also reference your survey topo file.

e Land use.dgn

NOTE: For further guidance in creating a new DGN file see Exercise 2 of the
MicroStation V8 Manual

b) Access D & C Manager from the MicroStation menu bar drop down location
Applications>GEOPAK> Road>Design & Computation Manager
or from task navigation with Geopak’s Civil Workflows, it is the second icon from the
end on the right.

posed.dgn [2D - V8 DGN] - Drainage: DrainageProject - Network: None

Tools Utilities Workspace | Applications | Drainage Window T.D.O.T. Help

? corac | pueomeiopax | 3 e 2
T — Mﬁp L Tasks
i = roap »  ROAD Tools X
Ak " Project Manager |: Civil Workflows
SURVEY v
ST , Corridor Modeling < E‘? LQ A e
: " sy 00,8, D L,
WATER SEWER »  Site Modeling = iy
LANDSCAPE »  Active Chain Control ,@;@1/}’@ .
Training Element Attributes -
3PC AdHge Attribute Manager #l Road W°rkﬂ°"ﬂ Design & Computation Manager
About GEOPAK -
= UserPreferences
Geometry 3
| Design & Computation Manager
Quantity Manager
Plans Preparation 3
DTM Tools
3D Tools »
Cross Sections »
Utilities 3
Help
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c) In D & C Manager go to the land use category under
Drafting Standards\Exist. Drainage\Land Use.
There you will see the three categories of land use items used by T.D.O.T.

ﬂ Design and Computation Manager | = | = 23 |
File Edit Settings Favorites Help

5~ 1d @R mn H e

& U sers \PublichGeopak Standards'tdot.ddb -
[ Drafting Standards
1 Toals
(C1 Cross Sections
£ Roadway Horzontal Alignments
£ Roadway Verical Alignments
(C3 Exist. Profiles
3 Survey Control
£ Pres. ROW.
1 Property Lines
1 Parcels
[£1 Political Boundaries
£ Prop. ROW.
£1 Prop. Easements
£ Roadway Linewaork
3 Private Drives
[ Exist. Drainage
[ Land Use
(£1 Rural-Fat/Permeable
(£7 Rural-Steep./Impemeable
=1 Urban ¥

m
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Exercise 2

d) Open the desired category and click on the land use item you wish to define on the
project. Click on Place Influence in the D & C Manager control strip.

ﬂ Pavement-5l concrete or as...l = | &8 |
[¥] Place Influence
7] Adhoc Attributes ' Match Point Text
[] New Blement Only | Draw COGO Element |
,ﬂ Design and Computation Manager | =B 2|

File Edit Settings Favorites Help

[~ Exist. Drainage -
[ Land Use

[ Rural-Flat/Pemeable
Pavement-FP  concrete or asphalt pavements
Macadem-FF  asphalt macadem pavemeant
Gravel-FP gravel roadways or shoulders
Earth-FF bare earth
Steep Grass-FP steep grassed area (2:1)
Meadow-FF  tud meadows
Forest-FFP forested areas, woods
Fields-FP cultivated fields

[~ Rural-Steep/Impemeable
Favement-5i concrete or asphalt pavements
Macadem-5I asphalt macadem pavement
Gravel-51 gravel rmadways or shoulders
Earth-5I bare earth
Steep Grass-5| steep grassed area (2:1) e
Meadow-5I turf meadows

m

Forest-51 forested areas, woods
Fields-5| cultivated fields
2= Urban

Residential-F30  flat residential, 30% impervious

Residential-F60  flat residential, 507% impervious

Residential-550  moderately steep residential, 50%: impervious
Commercial-570  moderately steep built up area, 705 impervious
Commercial-F50  flat commercial, $0% impervious i

NOTE: You should only use types from one section (i.e. Rural-Flat/Permeable or
Urban).
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e) Use any MicroStation shape command to draw shapes around the areas. You may
wish to copy graphics from the reference files to create complex shapes. This could
be the proposed edge of pavement lines from the proposed file to shape the
pavement area or perhaps the edge lines from a parking lot or woods area from the
survey topo file. Anytime you wish to change to a different land use type just click on
itin D & C Manager. If you have shapes already defined simply use the MicroStation
Change Element Attributes command to change their symbology.

NOTES:

Shapes must be continuous and closed. Set fill type to None.

It is not necessary to place shapes to cover all areas absolutely. Any areas not
delineated by a land use shape will use the Base C value entered in the Drainage
Area Definition dialog.

fy Once shapes have been set up simply reference the DGN file to your proposed DGN
file and they will be read when you use Delineate Subareas in the Drainage Area
Definition dialog.
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Exercise 3

3. DTM Drainage Tools

GEOPAK supports a wide range of tools that allows you to analyze and evaluate the
drainage patterns of a GEOPAK Digital Terrain Model or TIN file. These tools are
useful for delineating and distinguishing watersheds, flow paths, flow directions, and

hydrographic features.

This exercise allows the user to become familiar with the Digital Terrain Model (or
DTM) Drainage Tools.

See Exercise 22 in the TDOT GEOPAK Road Course Guide for guidance in creating a
final merged TIN file.

3.1 Accessing DTM Drainage Tools
a) Open the file DVSR1proposed.dgn file.

Note: The landuse.dgn file has already been referenced into this file for your use.
Refer to the previous exercise (Exercise 2) or to the Land Use DGN Creation
document for instructions on creating the land use file.

b) Open GEOPAK Drainage and select from the Drainage Menu Bar:
Utilities > DTM Drainage Tools

M DRAINAGE - Untitled - [No Active Network] e S
| Project  Component  MNetwork Reports | Utilities | Tool Boxes |
Mavigator
Conflict Finder
Labeler Drainag...[5]
Display 30 ﬁ
DTM Drainage Tools i b
8./,
Bs, F,
=P -
-iﬁ:- -lﬁ:l- 1 Drainage Mavigator
2 Conflict Finder
k‘@ 3 Drainage Labeler
/ 4 Display 3D Elernents
%T 5 DTM Drainage Tools
=1 Open as ToolBox
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3.2 Delineate Watershed

The Delineate Watershed tool outlines and defines a watershed at any location within
the TIN surface. The pour point of the watershed is the most downstream point of a
desired watershed. Once a data point representing the pour point of the watershed is
indicated the contributing watershed area is computed and delineated. Pour points
must be located near sumps (i.e. low points) in the terrain since a point lying on the
side of a hill does not actually have a contributing area.

a) Use the Select File button to select the final merged TIN for the project. Then select the
DTM Drainage Icon Delineate Watershed.

ﬂ Delineate Watershed o S
TIM File: | final tin Q
Options

SNBSS S

Selection Criteria
Fick Boundany DF DpP
Elements Pour Point Create Shape
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Exercise 3

b) Click the Pick Boundary Elements button and select the element representing the tin
hull (the boundary of the TIN file) as shown in the screenshot below. Data Point to
accept. Make sure Graphic Group Lock is OFF.

B View1, Default = E=R

E-@d - ARV I BE|HFLE
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c) Click the DP Pour Point. Data Point in the dgn file in the approximate location shown
below:

B View1 Default |-
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Exercise 3

d) Click the DP Create Shape button and data point inside the drainage area delineation
from the previous step. This procedure will place a temporary fill in the drainage area.
Data Point to accept this shape and Update the Microstation View to remove the
temporary fill. The Drainage Area Shape has been drawn in the dgn file.

NOTE: Scrolling or zooming between Step (c) and Step (d) will cause the temporary
watershed delineation to disappear. However, the information is still present and
following Step (d) will still create the Drainage Area Shape.

B View1 Default =N =R

B-@d#+-AQRQRBEY I EHAEIFRE
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3.3 Drainage Patterns

The Drainage Patterns tool evaluates the flow paths contained within the TIN. This tool
performs a downstream trace from the centroid of each triangle.

a) Select the DTM Drainage Icon Drainage Patterns. Toggle ON Display Only and click
the Apply button to exhibit the Drainage Patterns for the tin file.

NOTE: Throughout this exercise, Display Only will be chosen (except where noted), so
that the graphics will delete when the view is refreshed.

M Drainage Patterns l =1 |ﬂh]
TIN File: | final tin Q
Options

& &S <y
S é_Dralnage Patterns|

7] Display Ony; —

Load Within Fence
Set Graphic Group

| Apply |

NOTE: Pressing the Escape button (on the keyboard) will terminate the current
process before completion.
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Exercise 3

3.4 Downstream Trace

The Downstream Trace tool delineates the flow path downstream from a given point in
the TIN. The indicated path follows the steepest descent from the point through the TIN
terminating at a low point or the edge of the TIN.

a) Select the DTM Drainage Icon Downstream Trace. Toggle ON Display Only and click
the Apply button.

# Downstream Trace = L=
TIN File: | final tin Q
Cptions

o
o
i
y
&
iy
2
{':D
z
=
=
m
Cu
3
—
g
™
| m |

[7] Display Only [—]

Minimum Low
Point Depth: | 0.000

[ Apply |

NOTE: Setting the Minimum Low Point Depth to a value above 0.00 will allow the
downstream trace to pass through small, localized depressions and continue
downstream.
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b) Click in the design file within the limits of the tin hull. A downstream trace will appear
from the cursor data point location to the nearest low point to which the water will drain.

B View1, Default =N E=R
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Exercise 3

3.5 Flow Arrows
The Flow Arrows tool indicates the direction of flow within the triangles of the TIN.

a) Select the DTM Drainage Icon Flow Arrows. Toggle ON Display Only, set the arrow
size as shown, and click the Apply button.

a Ny
M Flow Arrows I. = -ﬁh—J

TIN File: | final tin Q,

Options

AEB S S\
Alp e 4@ @ g Flow Arrows]

/| Display Cnby | ———— |
Load Within Fence
Set Graphic Group Amow Size: | 22.000

| Apply |

The Drainage Flow Arrows are drawn in the design file.

B Viewl, Default
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3.6 Delineate Low Points

The Delineate Low Points tool locates all low points within a region of a TIN. A flow
arrow is placed and the text "LP" is placed at the triangle vertex. This is an excellent tool

to use when choosing an initial location for catch basins on sag points as well as
locations in ponding areas.

a) Select the DTM Drainage Icon Delineate Low Points. Toggle OFF Display Only, set
the arrow size as shown, and click the Apply button.

L

M Delineate Low Paints I. = |ﬁ]
TIN File: | final tin Q
Options

&LEB S SY,
_ ot S ey
Displa!ES:EreatE Low Points|__

Load Within Fence

Set Graphic Group
Mirimum Low
Paint Depth:

Amow Size: | 100.00

0.000

| Apply |

The Low Points are drawn in the design file.

B View 1, Default

Braw- AQIRMY I |BIEH LG

[E=8|EoE >
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Exercise 3

3.7 Ridge Lines

The Ridge Lines tool indicates the ridgelines within a TIN. A ridge line is defined as a
triangle edge where the flow on each side of the edge is away from the edge

a) Select the DTM Drainage Icon Ridge Lines. Toggle ON Display Only, and click the
Apply button.

M Ridge Lines [
TIN File: | final tin Q,
Options

&dE S Y
7| Display Only Ridge Lines

Load Within Fence
Set Graphic Group

| Apply |

The Ridge Lines are drawn in the design file.

B View1, Default =5 = T

B-dw-ARQRHEY | BadLE
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3.8 Surface Ponds
The Surface Ponds tool delineates the area(s) of ponded water within the specified TIN.

a) Select the DTM Drainage Icon Surface Ponds. Toggle ON Display Only, and click the
Apply button.

M Surface Ponds l = |-r':h]
TIM File: | final tin Q
Options

ALBS SY
Surface Ponds
| Display Onky Ponds:

Islands:

Set Graphic Group

| Apply |

The surface ponds are drawn in temporary fill as shown below:

B View1, Default =N e

R-Ow-ARQRBHY I BN IR
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Exercise 3

3.9 Pond Analysis

The Pond Analysis tool traces a point downstream to a low point and fills it giving the

volume, maximum depth, and maximum elevation. In addition, the pond delineation is
graphically displayed

a) Select the DTM Drainage Icon Pond Analysis. Toggle ON Display Only, and click the
Apply button.

M Pond Analysis I. = |-";-"vh
TIN File: | final tin Q
Options

AEB S <Y
% Py B e
7] Display Only Borde ﬂd Analysi

zlands:

[ Volume Cubic Feet -| n/z
Pond Suface Area: n/a
Madmum Surface Elevation: n/a
Madmum Pond Depth:  n/a

| Apply |

d

b) Data Point near the location shown below:

B View 1, Default

= B

B-@%-|ARQREHYS O B HLE
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c) The Pond is filled and pond characteristics computations performed:

ﬁ Pond Analysis

TIN File: | final tin
Options

[¥#] Display Only

[ Volume Cubic Fest =

&LB S Y,

Ponds: | —
|slands: =

Pond Surface Area:
Maximum Surface Blevation:
Maximum Pond Depth:

T

2360.450 CF
657781 5Y
843.065
1.065

NOTE: Other DTM Tools are available from Applications> GEOPAK> ROAD>DTM
TOOLS. Surface analysis tools are the second from the end. All of these tools are
available under task navigation through DTM Tools when Geopak’s Civil Workflows is

active.

l! 5y To & [Ty #

]

&
4

—+r,
e ?'iin'

5y}
[

Height/Slope
Profile

Volumes

Elevation Difference

Slope Area
Themes
Drainage Tools
Visibility

Trace Slope Path
DTM Camera

o 10 10 [ [N (o (w4 [l [ho = [

Trench Volumes

I ey EHas

Open as ToolBox

' DTM Tools HB=EEaA

g e M& rra e
ol ."Jhd iz DEMII BET

mT@ammi
Eﬁ«. Elk z=¢
T i ,.a+|r\ i

Lt iht %4
1R Sad
2o, § BT

81 39* & ¥ |Elevation Difference

SR+ -
wéaaﬁvm

RSCIT RECTT

£
10101 10201 A E E a o

XML MxX Mx DTM T'N MX  MX
4 T+ 4 TIN DTM T i
-
A,
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Exercise 4

4. Culverts

This exercise shows the user how to use the culvert module to design a culvert. The
culvert module acts as a standalone component of GEOPAK Drainage, meaning it does
not directly interact with Drainage Areas, Nodes, Links or Networks.

4.1 Delineate the Drainage Area

a) Use DTM tool Delineate Watershed to create the drainage area shown
below. If necessary, refer back to exercise 3.2 to create the drainage area.

The following shape will be used below as the drainage area for this exercise.

NOTE: The area shown below on level SURVEY - DRAINAGE - Area Shapes extends
to the limits of the current TIN file. Inspection of the contours will reveal that the
drainage area most likely extends beyond these limits. Appendix B will discuss options
to approximate the full extent of the drainage area.

B View1, Default
g~ .:JY';.( - 48 QRIEHS I BG S "&Yl_';,
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b) From the GEOPAK Drainage menu bar select Component>Area>Add.

M DRAINAGE - DrainageProject.gdf - [No Active Network] % Drainag... ||
‘ Project | Component | Network Reports  Utilities  Tool Boxes ‘ ﬁl
Area P Add.. IEI
Mode v Edit [
- » - i -
Link 1D o} ,_ADramageAreas. Add Drainage Area
: Delete
Profile | -
Rename %' '}j’
Culvert 4
Routing y  Update All Yy '?r
L = g
Land Uses dj;]' L
Miscellaneous Utilities 2 1@?’

Type in 23+20 for the Area ID. Click OK.

( Add a Mew Area |
Area ID: | 23+20
Description:
| ok | | Cancel |

c) Click the Select Shape button. Select and data point to accept the shape
shown in the first step. The area is automatically calculated.

8 View1, Defaukt == s |
R-@ AR qHY e Je s B

To Hode ID: 2320

Area Selection / Crastion
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Exercise 4

d) Setthe Base C Value to 0.350 and click on Compute TC

M Drainage Area Definition = B [
Window Center
Area D 2320 - Cl
S d I ¥ F Highight @ & W &) [ ey |
Dietailz
Optiong Description: To Node ID: 23+20 ﬁf@‘
Definitian 3 :
- Drainage Area: | 20,679 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ gﬁle'ﬂ | DTCI'IH'IE;thE ‘
Time of Conc.: | 5.000 - ___

Hydro. Method ‘ Fick Boundary | DF ‘

i@ Rational Hements Create Shape
i 5C5

When the following Dialog will appears, use the explorer button to select the correct TIN
file.

r“ Time of Concentration = |I = | M ]

Drainage Area |D:  23+20

[TIN File_~]; final fin SN
Define Path

v
[ Sheet How
Method: [FHA - Length: | 0.000
n Value: | 0.000 Slope: | 0.000

[ Shallow How

Length: | 0.000
Imter. K: | 0.000 Slope: | 0.000
[ Concentrated How
Method: |Continuity = | Length: | 0.000

o

Welocity: | 0.000

Accum. Distance: 0.000
=
Accum. Avg. Slope:  0.000

Te= 0.000 [D::mpute] [ Apphy ]

GEOPAK Drainage V8i (SELECT Series 2) Culverts 4-3



e) Expand window to show details and set Max Sheet Flow Distance to 300’ and
Max Shallow Flow Distance to 100’.

ﬂ Time of Concentration o ] = |-‘E:&|
’_Details
Drainage Area ID:  23+20 | Distance Slope  Avg. Slope Flow
final tin Q
(|
Define Path
. 2
V| Sheet How X
Method: |[FHA  ~| Length: | 0.000 &7
n Value: | 0.400 Slope: | 0.000
V| Shallow FHow
Length: | 0.000
Inter. K: | 0.457 Slope: | 0.000
/| Concentrated How e Soos '
Method: (Continuty ~) Length 0.000 ot T LE” Flow
Velocty; | 51000
Max Sheet Flow Distance: | 300.000
Accum. Distance: 0.000 @ Max Shallow Flow Distance: | 100.000
Accum. Avg. Slope: 0.000
Te= 0000  [Compute | [ Apply | (oot ]

Collapse the window, toggle ON Sheet Flow, Shallow Flow and Concentrated Flow and
fill in the values as follows:

n Value: 0.400
Inter. K: 0.457
Velocity: 5.000

n Values for different surface types are available in the TDOT Drainage Manual, Table
4-3 Manning’s n Values for Overland Flow

Intercept K values are below:

Land Cover / Flow Regime k
Grassed waterway (shallow concentrated flow) 0.457
Unpaved (shallow concentrated flow) 0.491

Paved area (shallow concentrated flow); small upland gullies | 0.619
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Exercise 4

NOTE: See Appendix D for additional Manning's N and Intercept K Values.

f) Click Trace and data point at the furthest hydraulic point. Once values are calculated,
click Compute. Then click Apply.

B Viewl, Default =3 EoR =<7

Br@d-ARQRHS Y DR HLE

lruTirmen:lFE':n:lr'n':vantratin:lr1 El =] @

Drainage Area ID: 2320

[TIM File = || final tin Q,
Define Path

v
J Sheet How
Method: [FHA | Length: | 300.000
n Value: | 0.400 Slope: | 2.357

v Shallow How
Length: | 100.000

Imter. K: | 0.457 Slope: | 3.575

¥ Concentrated How
Method: |Continuity | Length: | 1651.534

Velocity: | 5.000
Accum. Distance: 2097534 .
Accum. Avg. Slope: 2299 -
Te= 35411 | Compute | | Apply |
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The Drainage Area Definition is now filled out.

M Drainage Area Definition e B ([
: : Window Center
Area IO 123+20 - | I
2ID: 4 | i Y vighight & & W &
Details
Options Description: To Mode ID: 23+20 G%J'
Definition : 3
. Drainage Arsa: | 20.679 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ Select ‘ Create
Time of Conc.: | 35.411 Shape DTM Shape

Hydro. Method ‘ Pick Boundary ‘ DP

i@ Rational Bements Create Shape
™ SC5

NOTES:
Minimum Time of Concentration is 5 minutes. If computed time is less than 5 minutes

input 5 manually.
For urban areas adjust maximum sheet flow as required.

For areas that drain directly from sheet flow to concentrated flow, uncheck the Shallow
Flow box. Leaving this box checked and setting it to zero will not allow TC to be calculated

correctly.

After the drainage area has been set up, runoff coefficients can be automatically computed
with the use of Land Use Items from the Drainage Library. Click on Subareas in the
Details list on the left.

ﬁ Drainage Area Subareas = 2% |
[ Window Center

Area D 4 [23:20 - Il

2 4| ¥ [] Highlight & & W &
Details
Options To Node ID: 2320 Gt
Definition Subarea C Value Description )
Subareas ' e FH.I‘FDI'I‘IEI‘FIC
Computation B Delineation

(] Display Only

Hydro. Method ¥

i@ Rational

i 5C5

0.000 0.000
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Exercise 4

g) Toggle ON Display Only and then click the Automatic Delineation button. The file is

scanned for closed shapes matching the Land Use symbology specified in the Drainage
Library (Land Use Tab).

o Drainage Area Subareas E [=] @
Window Center
Area D: 23+20 A ;
aiD: 4 | | P e 9 @ A &) (el ]
Details
Options To Node ID:  23+20 St
Definition Subarea C Value Description
Automati
Subareas 33341 0900  Conc/Asphak Pymt —
Computation 28738 0.600 Gravel a
44832 0.200 Forested Areas 7| Display Only
Hydro Method | 43610 0400 Cultivated Fields %
@ Rational
SCS
431 0.400 Cuttivated Fields
® View1, Default E=8 5= =

O~ ARRRBEY O BHLHRE

h) Click the Apply button to apply the land uses (and their “C” values) to the Drainage
Area.
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i) We want to compute the discharge for a 50-year storm so if that is not already set; select
Project>Preferences>Frequency Options and change the Frequency to the 50-year
storm. Click the OK button to accept the new preference setting.

File

Options

Uriits Drainage Library (OLB): .. \Geopak Standards'.TDOTEnglish.dlb
Project Components Rational Frequency Options

Rainfal PE"E"T!EtEFS Comptation Runoff Coefficient
Land Use Options Frequency: Peaking Factor:
T —

Intensity Option il Yo BRLLLL

Junction Losses .

Inlet Options SCS Frequency Options

Mode Options Cumulative Runoff Coefficient
Link Options Frequency: Peaking Factor:
Profile Options L. =] | 1.0000

Plan Symbology :

|pdates

Save Options

| oKk | | Cancel |

]) Return to the Drainage Area Computations>Computation dialog box and click the
Compute Discharge button:

” Drainage Area Computations = = ”ﬂ]
Window Center

Area 1D 2320 - [l

= I'¥ 5 highight W & W & [y ]
Details
Options | Area C Value Compute
Definiti -
b Total Subareas: 15.098 0521 Discharge
Computation Remainder: 5.581 0.350

Hydro. Method Composte: 200679 0475

@ Rational Computed Intensity:  3.953

0 5Ls Computed Discharge: 39200

Verify the Computations; then click Apply to add the Area to the Project.
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Exercise 4

k) Jot down the Computed Discharge from the 50-year storm computed in the step above

here:

I) Recompute the drainage area discharge for the 100 Year storm. Select
Project>Preferences>Frequency Options and change the Frequency to the 100 year
storm. Click the OK button to accept the new preference setting.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Cption
Junction Losses
Inlet Options

Mode Options

Link Optians

Profile Options

Plan Symbology
Updates

Save Options

| oK | [ Cancel |

, coept the new preference

[ P

Drainage Library (OLB): ...\Geopak Standards' TDOTEnglish.dib
Rational Frequency Options
Computation

SC5 Frequency Options

Cumulative
Frequency:

(—

Runoff Coefficient
Peaking Factor:

1.0000

Runoff Coefficient
Peaking Factor:

1.0000

m) Return to the Drainage Area Definition dialog box and click the Compute Discharge

button:

ﬂ Drainage Area Computations

Area ID: 4 [23+20

Details
Options
Defintion
Subareas
Computation

Hydro. Method
(@ Rational
@ 5C5

- » [ "n"l.!'ind.nw
[] Highlight
Area C Value
Total Subareas:  15.098 0.521
Remainder: 5.581 0350
Composite: 20679 0475
Computed Intensity:  4.324
Computed Discharge: 42 445

=] = ]
Cerrter@ @ @ &)

Compute
Dischange

n) Jot down the Computed Discharge from the 100-year storm computed in the step above

here:

0) Close the Drainage Area Definition dialog box.

p) Change the Frequency back to the 50 Year storm

GEOPAK Drainage V8i (SELECT Series 2)
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4.2 Design the Culvert

a) From the Drainage main menu, select Component > Culvert> Add.

M DRAINAGE - DrainageProject.gdf - [No Active Networl_ [

‘ Project | Component | Metwork Reports  Utilities  Tool Boxes Drainag... 5]
Area 3 ﬁ
— i 1], 4
Link ’ =
Ve
Profile 4 #,,
Culvert b Add. = }::’
Routing ¥ Edit \fb ./" .,‘l 1 Add Culvert
) 79 2 Edit Culvert
Land Uses D d“], E ',‘ =
Miscellaneous Utilities »| Delete qu ? 3 Id Edit Drainage Culvert
L]
Rename y‘ 4 Delete Drainage Culvert
Tt el =1 Openas ToolBox
Update with Pay Items

b) Click on the Add button to add a new culvert. Enter the Culvert Name as 23+20 (station
of the culvert) and Click OK.

.
Add Mew Culvert

Mame: | 23+20

Description: |
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Exercise 4

c) The Culvert dialog will open as seen below:

d) Enter the culvert discharges from Steps 11 and 14 in the previous exercise. Key-in the
discharges in the key-in field and click the Add List Item button for each discharge

e B2 2> v+ P B
Details
[ Culvert Profile H Overtopping H Computations |
Parameters | Configuration I Headwal Location [|
Discharge Tailwater
Design  Discharge | Tailwater Blevation
35.200 (@] d
42449
X X
S |

e) Highlight the 50-yr storm and click Select Discharge. This will be the Discharge that the
culvert is designed for.
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ﬁ Culbvert

Cuvert 1D 4 >

Description:
Details

¥ ¢

[o] ® ==

F FE Apply

| Culvert Profile |

Qvertopping "

Computations |

| Parameters |
Discharge

User Supplied

Dizcharge
39.200
42449

Design
X

< X[Ono

39.200

Corfiguration "
Tailwat

Headwall Location |

X 0o

0.000

You could also just double click to set the desired Design Discharge that the culvert is

designed for.

f) Define the tailwater. Set the Tailwater option to Compute and key-in the slope and N

Value.
NOTES:

This slope is the longitudinal slope of the downstream channel. This slope can be
determine utilizing the Analysis tool: Height/Slope located in
Applications>GEOPAK>ROAD>DTM Tools

N Values for different surface channels are available in the TDOT Drainage Manual,
Table 5A-1 Values of Roughness (See Appendix E).

B Culvert

Culvert ID: 4 |23+20
Description:
Details
Culvert Profile
Parameters
Discharge
User Supplied

Design  Discharge
x 39 200
42449

X O o

39.200

- X
v ¢ % O E Foply
Cwertopping Computations
Corfiguration Headwall Location
Tailwater
Compute - Extract Cross Section
Slope %: | 1.200 N Value: | 0.040
Adjust Tailwater Depth: | 0.000
Dist, Blevati
istance evation a
X
0.000 835.519 =

Set the Slope % to 1.200 and the N Value to 0.040 and click the Extract Cross

Section button.
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Exercise 4
g) The Define Culvert Tailwater Cross Section dialog will open. Set to Drape Element
on Model/TIN and TIN File.

Click on the Select Files button and select final.tin .

P T T s
M Define Culvert Tailwater Cross Section = iﬂ]

| Section | Symbology
(Drape Bementon Model / TIN ) [TiNFle v | finaltin
\SeJect Eemenl-_ Place Element

|Setect File|

Bxtracted Profile
Profile ID: 23+20 Description:

Horiz. Scale: | 10.000
Vert. Scale:  1.000
Max. Elevation: | 662.169
Min. Blevation: | 650689
Max. Station: 97.020
Min. Station: 0.000

LS ”

h) Click the Place Element button to locate the postion of the tailwater cross section that
is to be extracted (this is notated as the ‘Extracted Profile’ on the dialog).

B View1, Default o[ ]
B-@ ARQRBEHS I EEHERG

You can also place a line in MicroStation and click Select Element.
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i) The Define Culvert Tailwater Cross Section dialog will now contain the profile along
the element placed representing the channel cross section at this location.

#L Define Culvert Tailwater Cross Section L= =] s
0 — OK | [ Cancel |
Section | Symbology
[ Drape Element on Model / TIN =] [TINFle =] | finaltin Q

| Select Element | | Place Elemert |

Extracted Profile
Profile ID:  23+20

Description:

Heriz. Scale: | 10.000
Vert. Scale: | 1.000
Mzx. Blevation: | 342.050
Min. Bevation: | 826.854
Mz, Station: 331.650

Min. Station: 0.000

— (O e @O 1

Place Profile

J) Click the OK button and the main culvert dialog will open again. The values for the
tailwater section will now be populated.

M

Culvert ID: 4 |23+20
Description:
Details

i~ =

Y =]}

=

Parameters

Discharge
User Supplied

Design  Discharge

-

X 35.200
42,443

39.200

KL o

¥ EHE Apply

Cwvertopping Computations
Configuration Headwall Location
Tailwater
Compute - Extract Cross Section

Slope % | 1.200 M Value: | 0.040
Adjust Tailwater Depth: | 0.000

Distance Hevation ~ 1
0.000 319 558

12.480 319381
15.368 339338 v w
0.000 339519 =
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Exercise 4

k) Select the Configuration tab to define the type of Culvert. Make settings as listed below.

[ H Culvert | = | \&f
Culvert D4 [23+20 | vl o # & = o]
Description: et S
Details
Culvert Profile Overtopping Computations
Parameters - Headwall Location
Entrance Type Shape: [Circular ]

Material: |Concrete |

Culvert Size
[Design Size = | Headwater Elevation = | | 836.500
Maximum Rise: | 5.000 Minimum Rise: | 1.500
Headwall bevel = 45~ + | Design Barrels Number of Barrels: II_-
Roughness: 0.013
Select Entrance. . | Entrance Ke: 0200

Shape: Circular
(Culvert Shape: Circle, Box, Ellipse, Etc.)

Material: Concrete
(Culvert Material: Concrete, Steel, Plastic, Etc.)

Headwater Elevation: 836.50
(The maximum elevation the water can reach at the upstream end of the culvert).
By default this option is set to Allowable Headwater which uses a height value,
click to change to Headwater Elevation.

Maximum Rise: 5.000
(The maximum diameter, height of the culvert)

Minimum Rise: 1.500
(The minimum diameter, height of the culvert)

Design Barrels: Toggle ON
(Allows the program to design multiple barrels, if required)

Number of Barrels: 1

Roughness: 0.013
(Determined by the type of Material, See the TDOT Drainage Manual Section
6.04.2.4.3, Culvert Roughness Coefficients)

NOTE: If you know the size of culvert you need beforehand you may set Culvert Size to
‘Library Item’ and pick from the list of defined items.
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[) Click Select Entrance and select the appropriate entrance condition. The most
commonly used for TDOT projects is Headwall beveled 45”". Select this condition and

click ok. This will automatically set the Entrance Ke value.

-

Select Entrance Type

ey
@D Headwall square edge  (7) Projected

@ (7) Headwsall groove end

{@ Headwall beveled 45
{7) Headwall beveled 33.7"

m) Select the Headwall Location tab to define the location of the Upstream Headwall and
Downstream Headwall (nodes). Make settings as listed below.
l —) H:H

“ Culvert
cuvertiD: 4 [23+20 ] =
: T I— v 4 » Bl 5 [ Ay
Description:
Details
Culvert Profile Overtopping Computations
Parameters Configuration | _Headwall Location >
Type: [Plan View  ~| [TINFile  ~] finaltin el | Create Profile |
Upstream Headwall Downstream Headwall
v | Reference Chain: |CL v |

Reference Chain: [('.'ﬁ'l'.
Node ID:  23+20-UP Node ID: 23+20-DN
Library ltem: |Culvert Endwall | Library tem: |Culvert Endwall v |

[ Tangentto Ref Chain v #| | Tangent io Ref Chain  ~| #

Chain Sta.: || Mirror Cell  Chain Sta.: | Mirror Cell
|| Offset: | 0.000 + Angle: | 0.000 | Offset: | 0.000 + Angle: | 180.000
Invert Elev.: [TIN/Model  ~| 0.000 v.| [TIN/Model  ~| 0.000

[ Dynamic Place ] Keyin Place ] Dynamic Place I [ Keyin Place
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Exercise 4

Type: Plan View

Reference Chain: CL
(Roadway Centerline)

TIN File: final.tin

Library Item: Culvert Endwall

Alignment: Tangent to Ref. Chain

+ Angle.: 0 or 180
(For headwalls parallel to the roadway on the right side use an angle
adjustment of 180 and on the left use 0. In this case the upstream is on
left so that value should be set to 0.)

NOTE:.Another option is to use Mirror Cell. Set angles to 0 and Toggle
ON for headwalls on the right of the roadway and Toggle Off for headwalls
on the left of the roadway. Do NOT use Mirror Cell along with Angle
Rotations as this adds confusion.

Invert Elev.: TIN / Model

(Reads TIN elevations. Use ‘User Supplied’ inverts are known or are
different than TIN file.)

n) Locate the Upstream Headwall by clicking the Dynamic Place button and setting the
upstream headwall at a location similar to that shown below:

B View1, Defaukt = [Eoh

B~ A_HHS I BE|SHFEE
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Watch the Headwall Cross Section dialog box r = s
.o M Headwall Cross Secti..| =

appear upon mouse-movement. Use this viewer

to place the Headwall at the upstream |ow point. Offset: | 10.000 | [Link Angle ] | 45.000

Station and offset values for the headwall location
should change dynamically in the dialog as you
move your mouse. If not, reset the chain name
and try Dynamic Place again. It may be
necessary to close the tool and reopen.

NOTES:
To set the headwall locations for 90 degree cross drains, you can enter the centerline
crossing station with a given offset and click the Keyin Place button.

You may wish to utilize the DTM Tools>Low Point Tool as discussed in the DTM Tools
Section 3 in order to predetermine the low point locations.

0) Locate the downstream headwall by clicking Dynamic Place under the Downstream
Headwall group.

B View1, Default =8 ol =

B-@-ARQRNEHY O | BE|HEE
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Exe

rcise 4

Reference Chain: [CL

Node ID:  23+20-UP

v
Library ltem: |Culvert Endwall ~ | .

H Culvert
-4 » e
Culvert ID: 23+20 - | v ¢ » gl =l Apply ]
Description:
Details
Culvert Profile Overtopping Computations
i Parameters | Configuration i Headwall Location >
Type: [PlanView  ~| (TINFile =] finaltin Ql | Create Profile ]
Upstream Headwall Downstream Headwall

Reference Chain: CL

Node ID:  23+20-DN

v
Library tem: |Culvert Endwall v | -

(Tangentto Ref. Chain _ ~| #| (Tangentto Ref. Chain __~] #

Chain Sta.: | 23+07.99 || Mirror Cell ~ Chain Sta.: | 23+36.61 || Mirror Cell
[] Offset: | -66.344 + Angle: | 0.000 ] Offset: | 63.525 + Angle: | 180.000
Invert Elev.. [TIN/Model  ~| 832847 Invert Elev.: [TIN/Model  ~| 820688

| DynamicPlace | | KeyinPlace | | DynamicPlace | |  Keyin Place

p) Select the Overtopping tab to define the limits of roadway overtopping. Make settings
as listed below and click Extract PGL Profile.

NOTE: This step is only necessary if your culvert is in a sag condition. If you are not in a
sag condition you may proceed to Step 17.

I'\

Width: | 48.000

Overtopping Source:

V| Pavement

i Extract PGL Profile

)

Adjust Constant Delta Blevation: | 0.000

(M Culvert =il 2
Culvertt ID: 4 [23+20 | » =
Description: ey
Detalls
| Parameters | Configuration | Headwall Location ,
| Culvert Profile I { Overtopping ) | Computations |

Distance Blevation

IHd"ermce Chain

Ref. PGL

Begin Station:
End Station:
X Increment:

: ek

x|

. [DESIGNCL

3

22+00.00
25+00.00
5.000

B XCD

0.000 0.000
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Overtopping Source: PGL
(This option sets the roadway profile as the controlling surface elevation for
overtopping. Other options include ‘User Supplied’ or constant elevation and
‘DTM’)
Width: 48.00
(This is the width of your roadway)
Pavement: Togdle ON
(This should be checked unless your road is not paved)
Reference Chain: CL
(Roadway Centerline)
Ref. PGL: DESIGNCL
(Roadway Profile)
Begin Station: 22+00.00
(Use the DP button to select a point before the Culvert.)
End Station: 25+00.00
(Use the DP button to select a point after the Culvert.)

X Increment: 5.000

(This may be automatically adjusted depending on the distance between the
begin station and end station.)

g) Once the Nodes have been located, and the elevations appropriately calculated, the
Culvert can be added to the project. Click the Apply button and the culvert will be drawn
and labeled according to the symbology in the Preferences.

r) The information to this point is enough to check the culvert computations. Select the
Computations tab. Toggle on the option to view the Culvert calculations. Click the
Compute Culvert button to perform the calculations.
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Exercise 4

Il

Culvert ID: 4 [23+20 =¥ 9 W = o |
Description: |
— Details -
Parameters I Configuration | Headwall Location
Cubvert Profile | Owvertopping l Computations

Culvert Design Resulta for 23+20 j
Circular
Concrete

36 Inch Dia. Circular

|pise = 3.000 ﬂ
— Output -
Compute | I Culvert ¥ Output to ASCI: Create ¥ | m'
Culvert r Tﬂlhﬂtﬂl' |23+20 ‘.
™ Overtopping Lout

NOTE: You may include Tailwater and Overtopping calculations (if you need them) by
toggling ON the option to view them.

To view the Culvert Design Results, simply press the "View" button on the lower right of
the "Culvert" menu to access the output file or you could open the file "23+20.out" from
your Project Folder. View and/or print the Culvert Design Results that the Geopak
Drainage software has calculated for you. Alternate design options have been found that

may be considered.

The report also includes hydraulic computations such as Maximum Head Water Depth and
Outlet Velocity for Q50 and Q100 which are helpful in analyzing the culvert design.

Culvert Allow. MA Inlet Outlet Tailwater
Discharge HW HW HW HW Elev.

39.200 836.500 <B835.926 2 835.926 835.926 B829.770
44,429 §36.500 B836.240 836.240 836.240 829.800
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For the 50 year storm, the Head Water Depth is 835.926 ft. Using the DTM Height/Slope
tool, a shape may be drawn at that elevation which represents the water surface for this
storm event. This is the white shape in the picture below.

=o| x|
TIN File: [final.tin Q
Mode : Elevation vI [ Display Only
— Options
Text: B

|7 Show Contour: _I
|_ Show Triangle: _I

|_ Show Flow Arrow: _I

— Cursor Point Vialues

X :4845.1728

Y : 3328.6586

Z :835.9253
Slope : 10.0107%

Start |

The Microstation Change Element Fill Type tool can be used to illustrate the ponded water
for visual analysis. Use the Change Attributes tool to change the color to blue if desired.

g Change Element Fill Type Fill Color: Element ¥ |
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% change Attributes

|_ Use Active Attributesé

|_ Level:

|DESIGN - SCRATC - |

[ Color: L] 69 =l
[~ Style: ——— 13 B3
[~ Weight | 0 B3
[ Transparency: | J 0 ;I
[ Priarity: | 0 ;I
[~ Class: Primary

[ Template: INcme ;I
| Use Fence Inside ¥ |

[T Make Copy

[ Change Entire Element

Exercise 4

DTM___
ﬁltt*)‘ AATJ-{‘Wr)W”A

Be sure that your Fill is toggled On in the View Attributes menu.

BT =FE S - e[

| Fe Edit Element Settings Took Utiies V
K A N = 2 B G I

=7 o

Civil Workflows
[ # Drainage Workflow

Drawing
N SR+ NMMN
OR e

) view Attributes - View 1 _ =) x|
View Number: 1 -[% & |
[®] presentation HEES
Display Style: I (Wirafrsme Display) LI Q
T ACS Triad
[ Background #H Grid
&'j Level Overrides
Line Styles
= Line Weights
p Front Pattem,’Bump Maps
Clip Volume !Pﬁnems
Constructlons -' Default Lighting
HDimensiDns Tags
[z Data Fields [A]Text
X-' Displayset % Text Nodes
[ Fast Cells @ Transparency
2\ Fast Curves
Global Brightness: 9 LI _>| -
Iﬂ View Setup
Saved Views: [Select... 'l w-Q
Models: Default
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Similarly, a visualization of the Tail Water pond may be created.

The Drainage Manual states that outlet velocities on Culverts should be based on the 50
year storm. In our file 23+20.0ut, we see that Geopak Drainage has calculated the Outlet
Velocity for the 50 year storm at 13.567 fps.

Culvert Outlet Uniform Critical Critical Friction
Discharge Velocity Depth Depth Slope Slope
39.200 1.284  2.038  0.005 0.024
44 429 14.024 1.378 2.172 0.0086 0.024

The use of riprap as scour protection at a culvert outlet is discussed in Section 6.04.3.3 of
the Drainage Manual. It says that riprap can be used to provide protection at a culvert
outfall for velocities between 5 fps and 12 fps. Since our velocity is greater than 12 fps, we
would either need to lessen the slope of the culvert, thereby reducing the velocity at the
outlet, or we would need to design a stilling basin or some other type of energy dissipator.
See the Drainage Manual for guidance.
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Exercise 4

Before the next step, go back to “Configurations”, change Culvert Size to “Library
Item” - 36 Inch Dia Circular. Then, select the Culvert Size drop down and switch
it to Design Size and set the Maximum Rise to 3.

L) culvert ' _ ] x|
Cutvert ID: 4 [23+20 = v ¢ 9 O B
ok Apply
Description: | —I
Details
| Overtopping | Compiutations
Parameters | Configuration | Headwall Location

Entrance Type Shape: Circular ¥ :I
Material: Concrete "|

Cul i
| Library ltem ¥ |  [36 Inch Dia. Circular =]

Headwall bevel = 45~ Mumber of Barrels: 1 ¥ I

Roughness: !D.D‘I 3

Entrance Ke: 0.200

Select Entrance. ..

4.3 Culvert Profile

At this point, the designer has the pipe size that will be required and can use regular

Geopak proposed cross section tools to set up a culvert section to finalize the length &
inverts for the cross drain.

The next several steps illustrate the functionality available through Geopak Drainage to set
up a culvert section in profile format along the cross drain.

a) On the Headwall Location tab click on Create Profile to set up a culvert section and

finalize headwall locations. The Create Plan View Culvert Profile dialog will open up.
Make settings as shown below.

Set Horiz scale 10 and Vert scale 10.

Change max and min elevations to be the next even 10' up or down.

Use default values for Max and Min station.
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i‘( Create Plan View Culvert Profile

T

Section | Symbology

OK Cancel

| Drape Element on Model / TIN  ~| | TIN File ~ | | final tin

Select Element Place Element
Extracted Profile
Profile ID:  23+20

Description:

Horiz. Scale: | 10.000
Vert. Scale: | 10.000
Max Elevation: | 850.000
Min. Elevation: | 820.000
Max. Station: 152986
Min. Station: 0.000

| Place Profile

al

- @ W @

b) Click on the Symbology tab and make the following settings:

l“ Create Plan View Culvert Profile

e

Section | Symbology
Ground Line Symbology

Vertical Grid

+ | Major Interval: 10.000
Minor Interval: 2.500

Maorsym:  SERSEEEEN

Minor Symb.: ———|

Major e n

| OK | | Cancel |

Boundary Symbology

Horizontal Grid
+ | Major Interval: 10.000

Minor Interval: 0.250

vaorsymo: EESEREEEY
Minor Symb.: e

Major Text :

Ground Line Symbology (Proposed Roadway):

LV= DESIGN - TYPICAL - Finished Grade and

Subgrade
CO= 6, Style=0, WT=4

Boundary Symbology:

LV= DESIGN — SHEET - Light Grid
CO=2, Style=0, WT=4

4-26 Culverts

GEOPAK Drainage V8i (SELECT Series 2)




Exercise 4

Vertical Grid Major Interval:
ON, Value=10
Vertical Grid Minor Interval:
OFF
Vertical Grid Major Symbology:
LV= DESIGN — SHEET - Light Grid
CO=0, Style=1, WT=1
Vertical Major Text:
LV= DESIGN — SHEET — Corner Text
CO=6, WT=10, TH=2, TW=2, FT=LEROYMON(3)
Click the Top Center to set Justification
Horizontal Grid Major Interval:
ON, Value=10
Horizontal Grid Minor interval:
OFF
Horizontal Grid major symbology:
LV= DESIGN — SHEET - Light Grid
CO=0 Style=1 WT=1
Horizontal Major Text:
LV= DESIGN — SHEET — Corner Text
CO=6, WT=10, TH=2, TW=2, FT=LEROYMON(3)
Click the Middle Right to set Justification

c) Once symbologies are set click on the Section tab and click on Place Profile in the
lower right of the dialog. Culvert Section graphics will appear on the cursor, Data Point
out in the open somewhere to place the graphics. Click OK on Create Plan View
Culvert Profile dialog to dismiss and reopen the Culvert Edit dialog. Click Apply to
store the culvert information.

d) Now that we have placed our culvert section we can finalize our inlet and outlet
locations. On the Headwall Location tab change Type from Plan View setting to Profile
View. When prompted to "Convert Plan View Culvert to Profile Culvert” click OK:
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Alert

N

Convert Plan View Culvert 23+20 to Profile Culvert

e) The Headwall location tab will change to show Profile view controls.

“ Culvert | = |ﬁr
cuvertiD: 4| [23+20 +].» it o —
Description: 5
Details
Culvert Profile Overtopping Computations
Parameters l Configuration
Type: [ProfileView ~|  [TINFile  +] finaltin Ql [ Create Profie|
Upstream Headwall Downstream Headwall
Reference Chain: |[CL - | Reference Chain: |CL v
Node ID: 23+20-UP Node ID: 23+20-DN
Library Item: [Culvert Endwall ~ | - Library ltem: |Culvert Endwall - ]
Drape Angle: 2952613 + Angle: 257572 Drape Angle: 2952613 + Angle: 77572
InvertSta: | 12.190 il |InvertSta: | 145643 il
| Invert Elev.. 832.901 Invert Elev.: 829.669
Chain Sta.. 23+08.46 Chain Sta.. 23+37.18
Chain Offset. -64 206 Chain Offset.  66.120

f) Under Upstream Headwall controls click Station DP button. Move cursor over
culvert section profile near the upstream end of pipe. That end will start dynamically
tracking with cursor movement. Relocate inlet so that the upstream invert of the pipe
coincides with roadway side slope.

NOTE: This location could be located previously with Microstation commands or
calculated and input as values in the Invert Sta. & Invert Elev. Keyin fields.
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Exercise 4

g) Repeat this procedure on the Downstream Headwall by clicking on Station DP and
locating in culvert section profile.

h) Once Headwall locations have been reset click on Apply in the upper right corner of the
Culvert Edit dialog. Now go back to the Computation tab and this time before clicking
on Compute Culvert, toggle ON option for Output to ASCII, keyin name 23+20.txt and
set file to Create option.

When Compute Culvert is clicked the output data in dialog is updated and text output
file is created.

M Culvert = .o [
vert ID: 4 [ v | B | Aoy |
Culvert ID: 4 [23+20 /b 9 ¢ P | Apply
Description: \ .I
Details

Parameters Configuration Headwall Location

Overtopping ' Computations

~

Output | -
Compute | | Culvert V] Output to ASCII: Create ~] View...
Tailwater |
\ Gt J Overtopping 23+20 bd Q
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i) To place drainage info with culvert section profile :

Set active text settings by going to TDOT>Cross Sections>XS Text Styles Plus, set
Scale to 10 and select XS Drainage - Prop.:

X5 Text Styles Plus.. | 2%
Click to set Text style,
Level. Weioht & Color =
%5 Bridge Limits - Prop. "
¥5 Drainage - Exist, 1;
" %5 Drainage -Prop,

%5 Finished Grade - Prop.
%5 Finished Grade Slopes - Prop,
X5 Pavement - Exist.

%S Retaining Wall - Prop.

X5 ROW - Exist.

X5 ROW - Prop.

Scratch

%5 Subgrade Slopes - Prop. ﬂ

Set Alternate STD Place Label with
Text Size Leader Line

Scale 1a Cancel

Go to Microstation's File>Import>Text and pick the file 23+20.txt in your project
directory. Data Point in the DGN file for placement near the culvert section profile. This
data can now be used when filling out TDOT Standard Drainage Data cells or can be
edited to show additional data needed with the culvert section.
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Exercise 5

5. Storm Drainage Nodes

This exercise shows the user how to create surface drainage components for storm
drainage. The user will add drainage areas, inlets, and outlets as necessary for proper
roadway drainage design. Unless designing for the interstate, TDOT typically uses a 10-yr
storm to design (See Appendix J).

Typically, each segment of the roadway drainage system will have an outlet to a side ditch,
natural river or stream, or an adjacent storm drainage system. Possibilities of these outlets
should be considered when determining catch basin locations.

Initial locations for catch basins (inlets) should be based on the following criteria:
1.) At all low points (sag points) in the gutter grade or low points behind curbs,
shoulders or sidewalks

2.) At the location down grade from the highpoint of a vertical curve where the spread is
equal to the allowable spread

3.) At areas where off-site flow will flow across the top of curbs

4.) Upstream of median breaks, entrance/exit ramp gores, cross walks, street
intersections, and bridges

5.) At side streets upgrade from the intersection
6.) At least every 400 feet (required for maintenance)

Once these primary locations are determined, adjustments or additions can be made to
ensure that a safe travel way is maintained.

5.1 Design Drainage Node CB -1

a) Determine the location of the Proposed Inlet. The proposed roadway is 4 lanes with
no shoulders and a 6” non-mountable curb with curb and grate inlets.

CONST SLOPE 657 RIGHT-0OF -WAY SLOPE CONST.I

1
|ESMT ‘ ESMT. . ESMT. ESMT.
24" .
FINISHED GRADE _ 5.
2 015
F/F
——— .02 FSF 0.02 F/F—m—

— 0,02 F/F 0,02 FAF —am

EXISTING GROUND

I
‘?,e . g, W
(]
F/F

EXISTING GROUND

We will assume for this project that the curb and gutter begins at 0+00.00. We have
also determined that our maximum allowable spread is 8.0 feet (See TDOT
Drainage Manual Chapter 7 Section 7.03.3.7). Using sound engineering judgment
we will assume our first inlet to be at Station 4+00.00 Offset —26.00.
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https://www.tn.gov/content/dam/tn/tdot/roadway-design/documents/drainage_manual/DM-Chapter_07.pdf
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b) From the Drainage Main Menu Bar, select Component > Node > Add OR from the
Main Toolbar, select Add Drainage Node.

“ DRAINAGE - DrainageProject.gdf - [Mo Active Network]

=

| Project | Component | Network Reports  Utilities Tool Boxes

| Drainag...@

Area

1 i

L
ol

[ Mode v Add..
Link v Edit
Profile » P

Delete
Culvert [
= Rename
Routing »
Renumber
Land Uses
Miscellanecus Utilities y|  Mpdate Al
Update with Pay Items

&, o5
-../I-L
aDrainage Modes: Add Drainage Mode
T4,
&R

pr
gk
i L3

c) Type in CB-1 for the node ID. Leave the Description blank. Click OK. Over the next
several steps, we will progress through the Node Configuration until everything has

been set successfully.

Add a Mew Mode

MNode 1D: | CB-1
Description:

[ ok | [Cancel].

-

d) Properties > With the Node Id set to CB-1, set the properties as shown below:

Node Type: Grate
Profile: On Grade
Library Item: CB #12 4X3

(See Standard Drawing D-CB-12S for details.)

ﬂ Mode Configuration - Propertiesl el
Window Center

MNode 1D CB-1 - |_j o
Details
Options Description:
E;operties Node Type: |[Grate -|

cation : =
Spread Criteria . F‘mﬁle.. [On Grade ]
Bvtiane Library em: |[CB&#12 443 - |
Junction Loss By Pass to Node: Hiat
Discharge Options Maox By Pass: | 0.000
Computations ==

Mode Bottom: |None Available >

[] ©vemide Library Payitem:

5-2 Storm Drainage Nodes
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Exercise 5

NOTE: This project calls for a 6” nonmountable curb and gutter inlet. A type 12 catch
basin is used since it is the most common for this type of gutter. The 4X3 is chosen
because it requires the least amount of depth for the type 12’s. It is common
practice to choose the smallest catch basin at the beginning of the system. Refer to
the TDOT GEOPAK Drainage Nodes shown in Appendix A to see other sizes and
types of nodes.

e) Location > Describe the inlet's location in the design file as shown below:
Reference Chain: CL
Profile: DESIGNCL
Align: Tangent to Chain
Angle: 0.00
Station: 4+00.00
Offset: -26.00

# Node Configuration - Location | E |||
Window Center o

Node 1D CE-1 - !

ode ID 4 | | » Highlight Yt o K T ) | Aeply |
Details

Options 7] Chain: [CL v | [V] Profile: |[DESIGNCL = |
Properties Coordinates / Stationing

Location o - 7] & ]

Spread Criteria Align: [ Tangent to Chain | + Angle: | 0.000

Blevations Station: | 4+00.00 ¥ 2580808
dunction Loss 7] Offset: | -26.000 i Y: 3214.900
Digcharge Options _ _

Computations Mirmor Node Offzet from Gutterto Inlet: | 0.000
NOTES.:

Once the location options are set, hit enter on your keyboard or data in one of the
fields to add the catch basin. The angle of the catch basin is automatically set to
match the centerline.

If a line or some other MicroStation element is located at the desired station and
offset, the Station DP %" button can be used. If Station DP is active and the
location is set, DO NOT move out of the dialog because the station range will
change. Hit enter on your keyboard or data in one of the fields to add the catch
basin.
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Other Align Options:

Tangent to Chain: Allows independent station and offset while matching a
specified chain’s angle.

Tangent to Element: Allows independent station and offset while matching an

elements angle.

Tangent on Element: Allows independent station (within limits of the element)
while matching elements offset and angle. (Mirror Node is often
required when using this option)

At Point: Allows independent station, offset and angle.

f) Spread Criteria > Describe the roadway cross sectional characteristics directly in front
of the inlet. These values will be utilized to calculate inlet capacity and resulting by-pass
flow. Turn ON the display for the reference file: DVSR1SEshapes.dgn and choose the

following options:

Longitudinal Slope Source: Reference PGL

Spread Source: Shape & Lib. Item - 4Lane
Max Pond Depth: 0.50 feet
Max Pond Width: 8.00 feet

,H. Neode Configuration - Spread Criteria for On Grade

= ﬁﬁ

Node ID 4 [CB-1

Details

Options

| Properties

| Location

Spread Criteria
Elevations
Junction Loss
Discharge Options
Computations

Longitudinal Slope Source: | Beference PGL =] 2515
Spread Cross Section

[7] Window Certer u
¥ 5 Highight e e A

Spread Source [ Shape and Lib. tem +| [4Lane - |

% Slope Roughnes

8.500 0016 |2 Maximum

2.000 0.016 Pond Depth: | 0.500
2 000 006 T

0.000 0.000 Pond Width: | 3.000

o

B

Change Spread Source back to User Supplied to remove extra links created by
the combination of the Shape and Library Item. The 24’ link is defined in the library item
but is not required since we have superelevation shapes for the pavement area, one
shape for each 12’ lane. Delete the item with 24 for the width, and change the last
item width from 11.993 to 12 and slope percent from 2.001 to 2.

g) Spread Criteria > In the previous step, we set the spread section using a combination of
the project's superelevation shapes and a standard drainage library spread section to
illustrate that if a final TIN file has not yet been made, other methods could be used. The

recommended method is to use a final TIN file which should represent the roadway

accurately at any given inlet location.

Change the Spread Source to Reference TIN.
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Exercise 5

h) Elevation > Assign the inlet vertical elevation and vertical pipe alignment options. The
Reference Surface: Tin File should already be set.

Reference Surface: TIN File - final.tin
Elevation Source: Reference TIN

Node Elevation Option: Same as Source
Vertical Alignment: Min. Fixed Drop, 0.17
Minimum Depth: 2.40 feet (See first note at top of next page)

Maximum Depth: 20.00 feet

w oMy w ) Aeply

final tin

& MNode Configuration - Elevations
Window Center
MNode 1D CE-1 - [
ek [] Highiight
Detailz
Options Reference Surface: | TIM File -
Properties Blevation Source: | Reference TIN
Location
Spread Criteria Mode Bevation Option: | Same as Source
Blevations Wertical Alignment: | Min. Fixed Drop
Junction Loss e P 400)
Discharge Options E g
Computations Maximum Depth: | 20.000
[] Add Sump Depth: | 0.000
NOTES:

-

-

-

880.196
880.196
0.170

Pt

Q

Refer to the TDOT GEOPAK Drainage Nodes listing in Appendix A of this
manual or online for Minimum Depth, Maximum Depth and Min. Fixed Drop or
Drop Across Bottom of Structure values for a given catch basin type and pipe

size.

In Node Configuration, Minimum Depth refers to the Minimum Depth of Cover. It
does not refer to the minimum depth of the catch basin. Both numbers are
provided as shown below in a segment of the table taken from Appendix A.

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across Depth 15 18
Name Bottom Min. Min. Min. Min.
of Depth Depth Depth Depth
Type: Grate Structure of Cover of Cover

CB#10 32"X26" Lowered 6-30 Curb & Grate Inlet CB32X26S | 0.12 5.08 3.77 2.15
CB#10 4X3 6" NonMount. Curb & Grate Inlet CB4X3S 0.17 20.00 3.90 2.23
CB#10 4' DIA 6" NonMount Curb & Grate Inlet CB4DIAS 0.17 20.00 3.89 2.22
CB#10 4X4 6" NonMount. Curb & Grate Inlet CB4X4S 0.17 28.00 3.90 2.23
CB#12 32"X32" 6" NonMount. Curb & Grate Inlet CB32X32 0.12 4.58 3.77 2.15
CB#12 4X3 6" NonMount. Curb & Grate Inlet CB4X3 0.17 20.00 3.90 2.23
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NOTES:

In the TDOT GEOPAK Drainage Nodes table in Appendix A “Minimum Depth of
Cover = Minimum Depth - Pipe Size - Drop Across Bottom of Structure” for catch
basins with both inlet and outlet pipes. To determine Minimum Depth of Cover for catch
basins with an outlet only: add Drop Across Bottom of Structure to Minimum Depth

of Cover. The first catch basin in the system is considered an outlet only because there

are no other pipes (inlets) coming into it.
For the initial design, use the value given under the 18 in. pipe size. If larger pipes are

designed, reset the Minimum Depth of Cover to the value for the pipe designed on

and re-design the network. Steps for this procedure are given in chapter 9 on
Drainage Navigator /Querying.

Catch Basins — Inlet and Outlet:

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth
CB#12 4x3: 3.90' - 18712 - 017 = 2.22%

Catch Basins — Outlet Only:
Drop Across Bottom of Structure + Min. Depth of Cover = Minimum Depth
CB#12 4x3: 0.177 + 2.23 = 2.40

i) Junction Losses > Set to Use Defined Equations (This defaults to the project
preference settings that were set in Exercise 1):

rﬂ. Mode Configuration - Junction Loss l = | = |_iE-J1l
= wr
Node ID 4 [CB-1 - » = :?'g”hd";”;cemer W oa R A
Details
Options I @ Defined Equations
E;DF'E_ﬂiES *) Equations x Loss Reduction: 0.000
Sp':::d'j:':mma Absolte Loss: 0.000 |
Elevations Supplied K - Outlet Velocity: (1. G0
Junction Loss 1 Supplied K - Change in Velocity: | 0000
el B
|
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Exercise 5

J) Discharge Options > Specify the source of the discharge contributing to this inlet.
Toggle Use Computed Discharge:

,

Node ID 4 [CE-1

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Options
Computations

Window Cent ’
m b EHi;nhli;rn T % e A ey |

@ Use Computed Discharge
@ Supplied Discharge: [ 0.000
[] Disable Inlet Calculations

-
U. UL

Capacity: ]
~| [Nore Avaizble  ~ #

k) Computations > Verify the inlet’'s hydraulic computations:

NOTE: The Drainage Area for this node hasn't been added; therefore, the
computations for the node can’t be completed until a discharge is known.

ﬁ‘ Mode Configuration - Computations

==

|1

Node ID 4 [CB-1

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Dizcharge Options
Computations

Window Cent H
T) b o O e ) LAy ]

.Inlet CB-1 - Emor Pedforming Inlet Computations
Drainage Area CB-1 Mot Found

[) Add this Node to the project by pressing the Apply button.
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5.2 Delineate Drainage AreaCB -1

a) According to the TDOT Drainage Manual Chapter 4 Table 4-1 (see Appendix J)
Hydrologic Design Criteria, the drainage area for CB-1 should be calculated for a 10 year
frequency. Select Project>Preferences and change the Frequency Options to the 10
Year Storm. Click the OK button to accept the new preference settings.

- . e ' 2] i
File
Options |
Urnits Drainage Library (DLE): .. \Geopak Standards“TDOTEnglish.dib
Project Components Rational Frequency Options
Rainfall Parameters Computation Runoff Coefficient
{'_:E""'j Use Ooptmns Frequency: Peaking Factar:
requency Options jrmss—
Intensity Option “]YEEF ..................... HE 1.{H}Dﬂ
Junction Lozses )
Inlet Options 5CS Frequency Options
Node Options Cumulative Runoff Coefficient
Link Options Frequency: Peaking Factor:
Profs Optirs — T
Plan Symbaology i
Updates
Save Options

| OK | [ Cancel |

b) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes.

M Node Configuration - Computations (G LR
"] Window Center ’

LR = m— S W D B )

Daste
| Options | |Inlet CB-1 - Emor Peforming Inlet Computations

Pfoﬁeﬂm 1 Drainage Area CB-1 Not Found |

Location = -
Spread Criteria Alert

Blevations

Junction Loss Drainage area [CB-1] not in project. Do you wish to create

! : a new drainage area?

NOTE: If you have closed the Node Configuration Dialog you may create a new
Drainage Area by going to the Drainage Main Menu Bar, and selecting Component >
Area > Add OR from the Main Toolbar and selecting Add Drainage Area.
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Exercise 5

M DRAINAGE - DrainageProject.gdf - [No Active Network] - S

Project | Component | Metwork Reports  Utilities  Tool Boxes
| Area v Add..
MNode k| Edit
Link v D Drain... @
. Delete 4]
Profile B = : :
- Reinare ) b @]l 1 Add Drainage Area
Culvert b — g /| € 2 EditArea
Routing y | Update Al e &%) 3 Id Edit Drainage Area
T 4 Delete Drainage Area
Land Uszes Y../‘.g ; - i _EI A
= 5 Rename Drainage Area
Miscellaneous Utilities J CI“]. )
& &) 6 Update All Areas
k) 7 Drainage Area Report
= Open as ToolBox

The following Add a New Area dialog box will pop up. Click OK.

-
Add a Mew Area
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c) To delineate the area for CB-1, there are a couple of methods you can use. One method
is to follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 1. (You may use the following images as reference points. It is ok if your numbers
do not match exactly.) Another method is to use the areas that have already been
drawn for all the catch basins. The files containing these areas are located in the folder

“Drainage Areas” in the class directory. Attach reference file DA_CB-1. This is the

file that contains the area for CB-1

Delineate Drainage Area:

Begin Trace

d) Define Drainage Area:

Use Select Shape to identify the drainage area. Our Base C Value was set

previously in the culvert exercise.

o Drainage Area Definition

Area ID: 4 [CBA

Detailz

Options Description:

Definiti

Sul::;r:alu: Drainage Area:

Computation Baze C Value:
Time of Conc.:

S
@ Rational
SCS

Window Center

Highiight & A B & | ey |

To Node ID:  CB-1 St
Area Selection / Creation

ol e =]

Select
Shape

Create
OTM Shape

Fick Boundary
Elements

DF
Create Shape

This Base C Value should be set to the most common land use item within your project
area then only the remaining areas would need land use shapes developed for them.
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e) Calculate Time of Concentration:

Exercise 5

ﬂ Time of Concentration

Drainage Area ID: CB-1
TIN File ] finaltin Q

Define Path
[_Tece || v [ID-Segments |

'/ Sheet How
Method: |[FHA v Length: | 300.000
n Value: | 0400 Slope: | 2.918
v/ Shallow How

Length: | 100.000
Inter. K: | 0.491 Slope: | 2.655

v Conoerlmgd How
Method: (Continuity v] Length: | 410.569
Velocity: | 5.000

Accum. Distance: 810.569
Accum. Avg. Slope: 2.535

(Compute ] Aoy ]

'Oelais
| Distance

18.93
15.01
17.94
9.82
22.50
6.92
25.39
34

1218
1296
561

1952
1481
10.26

Distance:

18.930

o |- R
Slope  Avg. Slope Fow N
229 229  Sheet =
298 2.59 Sheet a
2.55 258 Sheet
280 261  Sheet
256 260 Sheet %
2.78 261 Sheet
290 268 Sheet Ve
281 268 Sheet
365 277 Sheet
3.85 2.87 Sheet
3.14 2.88 Sheet
3.07 2.90 Sheet
3.10 292 Sheet
314 293 Sheet ~
Slope: ——
2250 | [ AdustFow |
Max Sheet Flow Distancey
Max Shallow Flow Distance
[ _______ —

Note that the n value for the sheet flow and the Inter. K value for the shallow flow has
changed and will remain the same throughout this exercise unless noted.

Sheet Flow — When water flows at a depth of 0.1 feet (1.2 inches) or less
Shallow Flow — Sheet flow usually becomes shallow flow and flows at a depth above

0.1 feet (1.2 inches)

Concentrated Flow — Water flowing in a ditch, gutter, channel, or other drainage

structure

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with

NO further steps required.

ﬁ Drainage Area Definition EI' [=] '@
Window Center
Area 1D: CEB-1 b 0
210 4 | J'Y 5 tighight & DD &
Details
(Options Description: To Mode ID:  CB-1 ﬂ’?@'
Definition : :
— Drainage Area: | 1.030 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ gsh?ct ‘ DTCIEru'IEEthE
Time of Conc.: | 31.347 __ __
Hydro. Method Pick Boundary DP
@ Rational Elements Create Shape
) 5C5
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f) Delineate Subareas utilizing the Land Use DGN:

#\ Drainage Area Subareas o @ (w3
frealD: 4 B0 < » [7] Window Center RO
[] Highlight
Details
Options To Node ID:  CB-1 St
Definition Subarea C Value Description
Automati
Subareas 0.2238 0.900 Conc/Asphalt Pymt
Comptation 03243 0300 Forested Areas a
Display Onby

Hydro. Method 3

@ Rational

) 5CS

0324 0.300 Forested Areas

g) Compute Discharge and Apply:

#\ Drainage Area Computations o] @ |5
pealD: 4 [CB =] » [T] Window Center % AW &
[] Highlight

Details
COptions Area C Value Compute
Definiti .
Sboroas Total Subareas: 0.554 0.549 Discharge
Computation Remainder: 0.476 0.350

Hydro. Method Composite:  1.030 0.457

(@ Rational Computed Intensty:  3.357

@ 5Cs Computed Discharge: 1.580

h) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
- .
M Node Configuration - Computations =0 @
| Window Center ' [
Node ID CB-1 v E 4 ) |
elD 4 [CB ] ¥ e w % w4 [ fet |
_Details )
| Options | |Discharge = 1.5804
: | |Spread Width from Gutter = 5.4112 €———
:f"";f_“'es Total Ponded Width = 5.4112
ki Ponded Depth = 0.2382
;Spread Crteria Spread Left Intercept = 0.0000
| Blevations Spread Right Intercept = 5.4112
|Junction Loss Grate Length = 3.0210
| Discharge Options Grate Width = 1.8130
[ : | |Grate Capacity = 1.2753
[Computatiors | ByPass Fow = 03051
Efficiency = 0.8070

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance
issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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Exercise 5
5.3 Design Inlet CB — 2
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

CB- 2 will be at nearly the same location as CB-1 but will be on the right side of the
road. Many of the parameters will be defaulted to those used to place CB-1.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration

Dialog.
M Node Configuration - Computations o B =
Node ID 4 (CB- w) b - [l G gy (@) e 4
[7] Highlight
Details
Options Discharge = 1.5804
- Spread Width from Gutter = 5.4112
Propetties Total Ponded Width = 5.4112
Location Ponded Depth = 02382
Spread Crtera Spread Left Intercept = 0.0000
Blevations Spread Right Intercept = 5.4112
Junction Loss Grate Length = 3.0210
Discharge Options Grate Width = 1.8130
: Grate Capacity = 1.2753
Lompubalions | |ByPass Flow = 0.3051
Efficiency = 0.8070

b) Click OK to add CB-2. CB-2 will automatically take the place of CB-1 in the Node
Configuration dialog which is already open.

c) Properties > Verify the Node Properties are defaulted from the previous Node (CB-1)
such that no user-input is required for this similar curb inlet.

. =SS '
: : Window Center

Node ID 4 [CB-2 =y B ;

ode ID 4 ]'FDHighIight W R @'@
Detailz

Options Description:

Properties Node Type: [Grate v|

Location e =

Spread Criteria Profile; [On Grade |

Ehniins Library tem: |CE#12 4X3 - |

Junction Loss By Pass to Node: | T

Dlischange Options M Pass: | 0.000

Computations iy 0

MNode Bottom: [None Available - -
[] Owvemide Library Payitem: A
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d) Location > All Reference information is defaulted from the previous Node (CB-1) such
that only the station,+ Angle (OR Mirror Node but NOT both) and the Offset needs to
be changed. Change the

Station: 3+70

Angle: *180 (or toggle on Mirror Node)

Offset: 26.00

*(180 for Right side, O for the Left), (Mirror Node ON for the Right, OFF for the Left)

s ey )
# Node Configuration - Location o @ /=3
Node ID 4 [CB-2 x| b iém&mf@fﬂ&h@

Details

Options [¥] Chain: [CL v| [V] Profile: [DESIGNCL  ~ |

Properties Coordinates / Stationing

Location Aign: (TangenttoChan__v) #  +Angle{( 180.000

Spread Crtena ' ’ :

Blevations Station: ' 3+70.00 X 2941.569

gf‘gm '—°05; , 7] Offset: | 26.000 ¢ Y: 3169.465
sCharnge ons !

ICompLﬂrgtions] [] Miror Node Offset from Gutter to Inlet: ' 0.000

e) Click Apply to include this node in the Drainage Project.
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5.4 Delineate Drainage Area CB — 2

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-2 should automatically appear, click OK.

Exercise 5

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 2. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-2 and turn off DA_CB-1.

Delineate Drainage Area:

Baglnm Trace

c) Define Drainage Area:

&4 Drainage Area Definition

Area ID: 4 [CB-2 |

Detailz

Options Description:

Diefiniti

Sul::;r:zluns Drainage Area: | 1.741

Computation Baze C Value: | 0.350

Time of Conc.: | 5.000
Hyco. Method
@ Rational
5CS

=5 Nch =
Window Center & & E] &) |E
Highlight A
To MNode ID:  CB-2 s
Area Selection # Creation
Select Create
Shape DTM Shape
Pick Boundany DF
Blements Create Shape
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d) Calculate Time of Concentration:

M Time of Concentration E]_E!_
Details
Drainage Area ID:  CB-2 Distance Slope Avg.Slope Fow =+
TIN Fle | final tin (@} 24 .80 296 2.96 Sheet |=|
10.43 149 252 Sheet &)
Define Path 2285 2.69 259 Sheet
3 5 1% 3% o= @
6.1 0.98 239 Sheet %
amen B EE-
Method: (FHA v Length: | 300.000 : : : oet
% 10.21 1.59 1.89 Sheet 7
n Value: | 0.400 Slope: | 2.358 2402 295 1.95 Sheet
= 11.20 1.29 1.90 Sheet
[ -SImsow Eiow _ 1722 413 211 Sheet
Length: | 100.000 1507 449 229  Sheet
Inter. K: | 0.491 Slope: | 2.180 11.65 1.66 225 Sheet
20.32 322 234 Sheet ~ |
|V Concentrated Fow ] -
o = Distance: Slope:
Method: @@ : Length: | 367.535 Y
- 24,800 2 960 Adjust Flow
Velocty: | 5.000

Max Sheet Flow Distancg”
Accum. Dist. - 767535 Max Shallow Fow Dista
ance i oW row
Accum. Avg. Slope: 2.550

G 2 [Cowte) (o ]

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

Max. Sheet and Max. Shallow Flow Distance values should be the same.

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas | = || =] ||£i|
Window Center
Area ID: 4 [CB2 - Ol
210: 4 | I ¥ 5 Highigh & & W & [ ey |
Dietails
Options To Node ID:  CB-2 i
Definition Subarea C Value Description
Automati
Subareas 0.2136 0.900 Conc/Asphalt Pymt
Computation 0.1746 0.300 Forested Areas 1
Display Only
Hydro. Method 3
i@ Rational
" 5CS
0175 0.300 Forested Areas
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Exercise 5
f) Compute Discharge and Apply:

M Drainage Area Computations || B =]
ArealD: 4 [CB2 <] » [] Window Center & A W &
[] Highlight

Dietails
Options Area C Value —
Definiti i
. Total Subareas: 0388 0,630 I
Computation Remainder: 1.353 0.350

Hydro. Method Composite: 1741 0.412

@ Rational Computed Intensity:  3.270

() 5C5 Computed Discharge: 2348

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations e B (|3
[7] Window Center N
Node ID 4 [CB2 ]b::mgm@m w 8% w4 | Aeey |
Details
' Options Discharge = 2.3481
: Spread Width from Gutter = 6.8632 €————
E“";’t'es Total Ponded Width = 6.8632
ocation Ponded Depth = 0.2673
Spread Criteria Spread Left Intercept = 0.0000
Elevations Spread Right Intercept = 6.8632
Junction Loss Grate Length = 3.0210
Discharge Options Grate Width = 1.8130
Computati Grate Capacity = 1.7043
ptaions ! |ByPass Flow = 0.6439
Efficiency = 0.7258

Don'’t be alarmed if you results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.

GEOPAK Drainage V8i (SELECT Series 2) Storm Drainage Nodes 5-17



5.5 Design Inlet CB — 3
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog.

Click OK to set the name CB-3

Properties > Verify the Node Properties are defaulted from the previous Node such that
no user-input is required:

ﬁ MNeode Configuration - Properties | = %
| Window Center

Mode 1D CE-3 b D H
Details
 Options Description:
E;:nperties Node Type: |Grate g

cation i e
Spread Ciiteria Profile: [On Grade | .
i diciii Library kem: |CB#12 4X3 - |
Junction Loss By Pass to Node: it
Discharge Options Max By Pass: | 0.000
Computations

Mode Bottom: |None Available - =
[] Owvemide Library Payitem: Align

L

b) Location > All Reference information is defaulted from the previous Node (CB-2) such
that only the Angle, Station and the Offset needs to be changed. After a few iterations
it was determined that CB-3 should be placed at Station 6+20.00:

M MNode Configuration - Location

| —

57 |)

Node ID 4 [CE2

x|

Details

Options

Froperties
Location

Spread Criteria
Blevations
Junction Loss
Dizcharge Options
Computations

[] Window Center
[ Highlight

[¥] Chain: [CL

=)

Coordinates / Stationing

Align: [ Tangent to Chain

m

Station:

(] Mimor Mode

6+20.00
[] Offset: | -26.000

W ow % w4 [ ey |

[V Profile: |DESIGNCL

3

+ Angle:

Lo

Cffset from Guiterto Inlet:

0.000
3196.887

3173.550
0.000
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Exercise 5
c) Elevation > Reset Minimum Depth for a node with both inlet and outlet pipes.

Minimum Depth: 2.23 FT

NOTE: SEE Appendix H — Storm sewer sketch, inlet and outlet on the right.

;H Meode Configuration - Elevations E =] @
Window Certer M |

Node 1D CB-3 - I L

ode ID 4 | | » ] Highiight Yo M T &) | Aeoly
Details

COptions Reference Surface: | TIM File * || final tin Q,
Properties Elevation Source: |Reference TIN | 874631

Location

Spread Criteria Node Elevation Option: | Same as Source | 874631
?E”am”iu Vertical Alignment: [ Min. Fieed Drop =| | 0.170

unction Loss ac

Discharge Options Minimum Depth: | 2.210

Computations Maximum Depth: | 20.000

[] Add Sump Depth: | 0.000

d) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Inlet and Outlet:

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth

CB#12 4x3: 3.90° - 18712 - 17 = 2.23
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5.6 Delineate Drainage Area CB — 3

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-3 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 3. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-3 and turn off DA_CB-2.
Delineate Drainage Area:

c) Define Drainage Area:

&4 Drainage Area Definition = =] @
Window Center

Area |D: CB-3 - ;

alD: 4 | Y i A AW & [ e |
Details
Options Description: To Mode ID: CB-3 4_1%1‘
Definiti 3 3
Sul::;nlazn: Drainage Area: | 0,182 Area Selection / Creation
Computation Base C Value: | 0.350 Select Create

Time of Conc.: | 5.000 Shape OTM Shape
Hydro. Method Pick Boundary DP
@ Rational Elements Create Shape
SCS

d) Calculate Time of Concentration:

5-20 Storm Drainage Nodes GEOPAK Drainage V8i (SELECT Series 2)



Exercise 5

M Time of Concentration o @ [
Details
Drainage Area ID: CB-3 Distance Slope  Avg. Slope Flow Al
TIN File | | final tin Q 9.38 170 170  Sheet |_
2562 1.13 1.28 Sheet |=|| A
Define Path 3.40 113 127  Shallow |
2.18 136 128  Shallow v
B St How @ 185 132 Shedow
Method: (FHA _ w]  Length: | 35.000 ; - : —
- 096 224 134 Sholow |2
n Value: | 0.400 Slope: | 1.283 7.70 224 146 Shallow
; 3.02 2.24 1.50 Shallow
I Sl Fiow _ 000 5336 150  Shalow
Length: | 35.000 096 5007 230 Shallow
Inter. K: | 0.491 Slope: | 4.975 0.00 50.06 2.30 Shallow
0.01 32 230  Shallow ~ |
(v Concentrated FHow ' Distance: Slope: '
Method: inuity ¥| Length: | 205.750 - .
(Continuty_v] Length o e [Adust Fow |
Velocity: | 5.000 S
Max Sheet How Distanceg” | 35.000
Accum. Distance: 275.750 @ Max Shallow Fow Distances 35.000
Accum. Avg. Slope: 2.671
= (o ]

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

The maximum length for sheet flow and shallow flow has changed and will vary
depending upon the drainage area. For this area, set Max. Sheet Flow and Max.

Shallow Flow to 35.

e) Delineate Subareas utilizing the Land Use DGN:

M Drainage Area Subareas = B [
Window Center
Area |D: CB-3 - Cl
=1D: 4| ]'DHighngm & &% & [ ey |
Details
Options To Node ID:  CBE-3 i
Definition Subarea C Value Description
Automati
SUbE"'EE'S_ 01312 0.500 Conc./Asphalt Pyvmt
Computation 0.0183 0.300 Forested Areas a
Display Onby
Hydro. Method e
i@ Rational
) 5C5
0.018 0.300 Forested fAreas

f) Compute Discharge and Apply:
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# Drainage Area Computations
Window Center
Area 1D: CB-3 - [
alD: 4 | ) [~ Highlight & @ W

Dietails
Options Area C Value
Diefinttion
S.bareas Total Subareas: 0.150 0.827
Computation Remainder: 0.033 0.250

Hydro. Method Composite: 0,182 0741

i@ Rational Computed Intensity: 5.818

0 35 Computed Discharge: 0.785

Compute
Discharge

o e
&)

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations o f{=) @
7 | Window Center "
Node ID 4 [CB-3 v » o s w @ %y w4 [ Aeoly |
Options Discharge = 0.7852
i Spread Width from Gutter = 3.0179 €
oy Total Ponded Width = 3.0179
el . Ponded Depth = 0.1504
Spread Ciitena Spread Left Intercept = 0.0000
Blevations Spread Right Intercept = 3.0179
Junction Loss Grate Length = 3.0210
Discharge Options Grate Width = 1.8130
. | |Grate Capacity = 0.7491
[Computations | |ByPass Fow = 0,0361
Efficiency = 0.9540

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance

issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.

5.7 Design Inlet CB

—4

It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.
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Exercise 5
a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-4.

Properties > Verify the Node Properties are defaulted from the previous Node such that
no user-input is required:

M Node Configuration - Properties | = 2 |
[] Window Center
Mode ID CB-4 - g “
ode D 4 | Y e W 8% @) [ el |
Detailz
Options Description:
Properties Node Type: |Grate -|
Location ] =
Spread Criteria Profile: [On Grade | -
Beradions Library tem: |CB&12 4%3 - |
Junction Loss By Pass to Node: it
Discharge. Cptions Max By Pass: | 0,000
Computations
MNode Bottom: |Mone Awvailable - ==
[] Owenide Library Payitem: Pleri

-

b) Location > All Reference information is defaulted from the previous Node (CB-3) such
that only the + Angle, Station and the Offset needs to be changed. We will set this
catch basin at the same Station as CB-3.:

- T B
M Node Configuration - Location o|E] 8
- | Window Center M I ]
ID 4 [CB4 L .
Node ID 4 [CB B > w e 'w &) | Aoy
Details
| Options V] Chain: [CL v | [¥] Profile: [DESIGNCL  ~|
| Properties Coordinates / Stationing
| Lacafion Aign: [TangenttoChain __v] #  +Angle((180.000
| Spread Criteria T ; ' '
Elevations Station: | 6+20.00 X: 3187.114
Junction Loss 7] Offset: | 26.000 é Y- 3122477
Discharge Options R 3
lC?qu{tatu?n_s_ | Mimor Node Offset from Gutter to Inlet: | 0.000
LS A

c) Click the Apply button to include this node in the Drainage Project.

5.8 Delineate Drainage Area CB — 4

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-4 should automatically appear, click OK.
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b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 4. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-4 and turn off DA_CB-3.

Delineate Drainage Area:

NOTE: After a first iteration the spread for the entire contributing drainage area was
found to exceed the spread limit. After consideration it was determined an area drain
could collect the water before it spills over the back of the curb. The white shape shows
the drainage area to be captured by that area drain. (See next Exercise 5.9)

a) Define Drainage Area:

&L Drainage Area Definition || [=] @
Window Center
Area ID: CB-4 - ;
alD: 4 | | » Achiighe % & ¥ & | Aeoly
Dietail=
Options Description: To Mode ID: CB-4 -ﬁféj
gegnm':"" Drainage Area: | 0581 Area Selection / Creation
ubareas
Computation Base C Value: | 0.350 Select Create ‘
Time of Conc.: | 5.000 Shape OTM Shape
Hydro. Method Pick Boundary DP
@ Rational Elements Create Shape
SCS

b) Calculate Time of Concentration:

5-24 Storm Drainage Nodes GEOPAK Drainage V8i (SELECT Series 2)



Exercise 5

M Time of Concentration o @ (==
Dﬁais B .
Drainage Area ID: CB+4 Distance Slope  Avg. Slope Flow -
TIN File =] | final tin Q 352 1.52 152 Sheet |_
1.76 273 192 Sheet 7 || O
Define Path 0.25 2.73 1.96 Sheet
[ Tmce | 1 [ID-Segments | 001 627 136  Sheet
0.04 6.27 1.99 Sheet
. Shet o e 2 = >Ip
Method: [FHA Lengih: [ 10.000 - 2 2
= oth 010 1292 223 st  |¥
n Value: | 0.400 Slope: | 2.660 0.12 512 228 Sheet
= 0.09 13.15 246 Sheet
[v] Shallow Fow 013 271 246  Sheet
Length: | 10.000 3.16 019 169  Sheet
Inter. K: | 0.491 Slope: | 8.405 0.18 50.04 266  Sheet
0.00 2 266 Sheet ~
/| Concentrated Aow e Slope: T
Method: Length: 232777 : : -
ot (Geiinivisl. Tow 1520 1520 | [ AdustFow |
Velocity: | 5.000
Max Sheet Flow Distancey| 10.000
Accum. Distance: 251.633 Max Shallow Flow Distance N\, 10.000
Accum. Avg. Slope: 2.740 .
Apply
[Computs ] (" Zomh_| oot |

The calculated Time of Concentration is less than the minimum of 5 minutes, therefore
5 must be manually typed in the Drainage Area Definition dialog after hitting
apply in the Time of Concentration Window.

The maximum length for sheet flow and shallow flow has changed and will vary
depending upon the drainage area. For this area, set Max. Sheet Flow and Max.
Shallow Flow to 10.

c) Delineate Subareas utilizing the Land Use DGN:

ﬁ Drainage Area Subareas = = |&|
Window Center
AealD: 4 [CB4 - [l
21D: 4 | J'Y 5 vighight & @ W & [ ool ]
Details
Options To Node ID:  CB-4 <
Definition Subarea C Value Description
Automati
Subareas 0.1531 0.900 Conc/Asphalt Pyt
Computation 0.3753 0.200 Forested Areas i
Display Oy
Hydro. Method 5
i@ Rational
") 5C5
0375 0.300 Forested Areas

d) Compute Discharge and Apply:
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#L Drainage Area Computations = B |||
Window Center

Area 1D ChB-4 - Ol

alD: 4 | | » 7] Highigh & @l W&
Details
Options Frea C Value S
Definiti :
. Total Subareas: 0.528 0.474 Discharge
Computation Remainder: 0.053 0.350

Hydro. Method Composite:  0.581 0463

i@ Rational Computed Intensity: 6980

e Computed Discharge: 1.877

e) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
“ Node Configuration - Computations | e l &
"] Window Center '
Node | -4 v —_ I
ode ID 4 [CB | » ] Hghlgrt w % ‘w4 [ Aesy |
Detis
-Options Discharge = 1.8768
: ' Spread Width from Gutter = 6.0289 €
s Total Ponded Wicth = 6.0289
[ Ponded Depth = 0.2506
| Spread Crteria Spread Left Intercept = 0.0000
| Blevations Spread Right Intercept = 6.0289
{Junction Loss Grate Length = 3.0210
| Discharge Options glate g“;dlh . 1-311 3?181
; - rate Capacity = 1.
|Eompahons ByPass Flow = 0.4287
Hficiency = 0.7716

Don'’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.

5-26 Storm Drainage Nodes GEOPAK Drainage V8i (SELECT Series 2)



Exercise 5
5.9 Design Inlet CB -5

a) After afirst iteration, it has been determined that an area drain needs to be installed
behind the curb at Station 3+70.00, Offset 35.00’ RT in order to catch flow that would
otherwise enter the roadway and cause the roadway spread to exceed the allowable
limit.

One way to determine the appropriate catch basin to be used is to review TDOT
Drainage Manual Chapter 7 Table 7-3 Standard Inlet Types and Applications.

It has been determined that a CB#42 4X4 will be used. See Standard Drawing D-CB-
42SB for details.

b) Properties > Change Profile to Sag and change Library Item to CB#42 4XA4:

'K Node Configuration - Properties | = 2 |
[7] Window Center

Mode ID CB-5 - e L

ode D 4 | Y g w0 e @ [y
Details
Options Description:;
Eaperties Node Type: [Grate -|

cation . =

Spread Criteria Frofile: |Sag ] .

Bevations Library tem: |CB#42 4X4 - |

Junction Loss

Dizcharge Options

Computations .

Mode Bottom: [Mone Available - -
[7] Ovemide Library Payitem: e

LS &

c) Location > All Reference information is defaulted from the previous Node such that only
the +Angle, Station and the Offset needs to be changed:

i 5
M Node Configuration - Location l |
[7] Window Certer
Mode 1D CB-5 - L M
e ¢ [ Highiight W @ w A [ ey |
Dietails
Options | @Chain: CL =] []Profie: [DESIGNCL =
Froperties Coordinates / Stationing
Location . 5 = ;
Spread Criteria Align: [ Tangent to Chain | #  +Angle: |0.000
Elevations Station: | 3+70.00 X 2939.873
Junction Loss 7] Offset: | 35.000 ‘é}* Y 3160625
Digcharge Options =
Computations Cffset from Gutter to Inlet: | 0.000
(&

NOTE: Since CB-5 is an area drain, it does not matter if the angle is 0 or 180, even
though it is on the right side of the roadway.
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d) Spread Criteria > For an inlet in a sag, we must specify certain spread criteria for each

side of an inlet.

% Slope Left: 1.00 % (From DTM Tools>Analysis>Height/Slope)

% Slope Right: 1.50 % (From DTM Tools>Analysis>Height/Slope)

% Discharge Left: 98.00% (Estimated based on placement within drainage area)
% Discharge Right: 2.00% (Leftover area)

NOTE: Left and Right should be defined based on an inlet at angle = 0.

In other words:

Left of inlet is Viewed Left for all inlets at angles <90 and >270.

Right of inlet is Viewed Right for all inlets at angles <90 and >270.

Left of inlet is Viewed Right for all inlets at angles >90 and <270.

Right of inlet is Viewed Left for all inlets at angels >90 and <270.

ﬁ. Mode Configuration - Optional Spread Criteria for Sags | = X
[ Window Center
Node ID 4 [CBS - L H
Details _ _
Options % Slope Left: | 1.000 Right: | 1.000
: % Discharge Left: | 58.000 Right: | 2.000
E;?::irg:s Spread Cross Section:
Boead i Spread Source: | Reference Suface v .
Hlevations Width % Slope  Roughnes # Madmum
Junction Loss 3 207 -1 580 0016 [E Pond Depth: | 0.500
Discharge Options 0.063 £265 0016
Computations 0.005 -5.265 0016 - Pond Width: | 2.000

0.000 0.000 0.000
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Exercise 5

e) Elevations > Elevation Data must be changed to match a CB#42. From the TDOT
GEOPAK Drainage Nodes Document set the following:

Vertical Alignment: Min. Fixed Drop, 0.17
Minimum Depth: 2.32 feet (See note at top of page 5-6)
Maximum Depth: 28.00 feet

i R )
M Node Configuration - Elev_ E'EIQ

Node ID 4 [CB5 -] » E‘;T;ﬂhﬂl';:ncﬂmﬁ w e e @
Details

Options ! Reference Surface: Efinal.tin | Q
E:::E:S Blevation Source: |[Reference TIN | 281507
Spread Criteria Mode Elevation Cption: | Same as Source »| 881507
Blevations Vertical Alignment: [Min. Fixed Drop ] (0170
“['J”i:;';’r’;;"gssﬁms Minimum Depth: | 2.300

Computations Madmum Depth: | 28.000

[] Add Sump Depth: | 0.000

f) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Outlet Only:

Drop Across Bottom of Structure + Min. Depth of Cover = Minimum Depth
CB#42 4x4: 0.177 + 215 = 232
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5.10 Delineate Drainage Area CB -5

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-5 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 5. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-5 and turn off DA_CB-4.
Delineate Drainage Area:

c) Define Drainage Area:

#4 Drainage Area Definition = = @
Window Center
Area 1D: CB-5 b '
2lD: 4 | ' Y bighigrt & &8 &
Details
Oiptions Description: To Mode ID:  CB-5 ﬁj&r
Definiti - i
SUI:Er;:Elnns [ = e - Area Selection / Creation

1

Computation Base C Value: | 0.35 Create ‘

Time of Conc.. | 5.000 s _ DTM Shape

Hydro. Method Fick Boundary - pp
@ Rational Elements Create Shape

SCS
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Exercise 5
d) Calculate Time of Concentration:

M Time of Concentration o B |3
QEtails
Drainage Area ID: CB-5 Distance Slope Avg. Slope Fow -
TIN File + || final tin Q 14.05 284 2.84 Sheet
14.02 296 290 Sheet (2|l A
Define Path - 25.20 1.49 2.23 Sheet
Trace iy | ID - Segments 7.76 269 229  Sheet
—_— 16.60 1.50 2.12 Sheet %
7 Sheet Fow 3626 098 176  Sheet
. : 12.23 1.09 1.69 Sheet
Method: [FHA  ~| L : | 300.000
it Lo = 866 204 172 et |<
n Value: | 0.400 Slope: | 2.247 14.92 151 1.70 Sheet
10.36 316 1.79 Sheet
2 b Elcs | 1331 225 183  Sheet
Length: | 100.000 6.21 129 181  Sheet
Inter. K: | 0.491 Slope:  2.205 2286 413 207 Sheet
933 449 218  Sheet =~ |
|| Concentrated Fow I Slope:
Method: (Continuty ¥] Length: | 387.326 : : .
o | 5/ 14.050 2840
Velocity: | 5.000
Max Sheet Flow Distance | 300.000
Accum. Distance: 787.326 Max Shallow Flow Distance N 100.000
Accum. Avg. Slope: 2431
-Pwlr
(Compute | [ Aemty ]

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

The maximum length for sheet flow and shallow flow has changed and will vary
depending upon the drainage area. For this area, set Max. Sheet Flow to 300
and Max. Shallow Flow to 100.

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas = B (et
Window Center
Area 1D CB-5 A Ol
=D I ¥ 5 tighight A @ W & [ ool |
Dietails
Options To Node ID:  CB-5 at
Definition Subarea C Value Description
Automati
Subareas 1.0267 0.300 Forested Areas
Computation &l
Display Only
Hydro. Method 3¢
i@ Rational
= SCS
1.027 0.300 Forested Areas

GEOPAK Drainage V8i (SELECT Series 2) Storm Drainage Nodes 5-31



f) Compute Discharge and Apply:

ﬂ Drainage Area Computations e = ||
Window Center

Area |D: CE-5 - O

alD: 4 | ]'DHighnght ORCRNI TS
Details
Options Area Z Value — -
Diefiniti :
ey Total Subareas: 1.027 0.300 Discharge
Computation Remainder: 0.249 0.350

Hydro. Method Composite: 1275 0.310

i@ Rational Computed Intensity:  3.245

565 Computed Discharge: 1.282

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations o @ [ =23m]
[] Window Center N
Node ID 4 [CB5 | Y g W A% e A
Details
Options Discharge = 1.2820 -
; . Total Ponded Width = 30729 €
e Ponded Width Left = 3 8796
(S Ponded Width Right = 1.5144
| Spread Criteria Ponded Depth Left = 0.2126 3
|Blevations Ponded Depth Right = 0.0635 1
{Junction Loss Grate Area = 3.6000
| Discharge Options Area Reduction = 0.5000
\Computations Grate Penmeter = 7.6000
‘ Perimeter Reduction = 0.0000
Grate Capacity = 6.8407 g

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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Exercise 5
5.11 Design Inlet CB — 6

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-6

Properties > Change the Node Properties back to On Grade and to a CB#12 4X3:

i S R e ™
M Node Configuration - F'm_ Elﬂlg
Window Center

MNede 1D CE-& b C i
Details
Options ' Description: |
E;ﬂDEﬂiES Node Type: [Grate x| '

cation ) =
Spread Criteria Profile: |On Grade | -
Bevabions Library ttem: [CB#12 43 - |
Junction Loss By Pass to Node: | I
Discharge Options M Pass: | 0.000 1
Computations =5 e O :

[ | Node Bottom: |Nene Available hd

[] Ovemide Library Payitem:

b) Location > All Reference information is defaulted from the previous Node (CB-5) such
that only the + Angle, Station and the Offset needs to be changed. Discussion for the
reason this station was chosen is presented in Step 2 of 5.11.:

i N 0 O 8 ™
ﬁ MNode Configuration - Lm:a_@lﬁlg
Window Center

Mode ID CE-6 - O 4

ode D 4 | I Y S w0 e @ [y

Deetails

Options | [#] Chain: |CL v | [7] Profile: |DESIGNCL = |

Properties Coordinates / Stationing

Location e : = :

Spwesd Crieia Hign: | Tangent to Chain . ] #  +Angle: |0.000 |

Blevations Station: ﬂ-i-?rﬂﬂﬂ [ ¥ 3501.362

Junction Loss Offset: | -26.000 $ Y. 3115285

Dizcharge Options _ . ;

Finmgntl s [] Mimor Node Offset from Gutter to Inlet: | 0.000

NOTE: The Spread Criteria defaults back automatically when the node is changed
back to ON GRADE, therefore no changes are necessatry.
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c) Elevations > Be sure to change the elevation data back to that which is required for a
Type 12 catch basin.

M Mode Configuration - Elevations — pud
Window Center

Mode D CB-6 - [ i

ode 1D 4 4 [] Highiight )

Details

COptions Reference Surface: | TIM File | | final tin Q
Froperties Blevation Source: | Reference TIM | B3 R4R
Location

Spread Criteria Mode Elevation Option: | Same as Source | 863548
?E”aﬂnni‘: Vertical Alignment: | Min. Fixed Drop =| | 0.170

unction Loss o

Discharge Options Minimum Depth: | 2 230
Computations Maximum Depth: | 20.000

[ ] Add Sump Depth: | 0.000

d) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Inlet and Outlet:

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth

CB#12 4x3: 3.90° - 18712 - 17 = 223
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Exercise 5
5.12 Delineate Drainage Area CB — 6

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-6 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 6. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-6 and turn off DA_CB-5.

Delineate Drainage Area:

NOTE: Upon inspection of the entire drainage area, it has been determined that area
drains need to be installed to collect runoff before it enters the roadway. The white area
shapes show the area to be collected by these drains which will be input in subsequent
exercises.

c) Define Drainage Area:

&L Drainage Area Definition |£‘_|ﬂ_h]
! Window Center i
Area ID: 4 [CB6 A Highlicht % oA B & | Aesly
Deetails
| Options Description: To Mode ID:  CB-6 ﬁfﬁj‘
Definiti [ i i
sudzré: Bresinge feet | 0.257 Area Selection / Creation
Eompubation Base C Value: | 0.250 ‘ Select ‘ Create
Time of Conc.: | 5.000 s RTM e
Hydro. Method | Compute TC_| Pick Boundary - DP
@ Rational Elements Create Shape
SC5
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d) Calculate Time of Concentration:

M Time of Concentration E] = '
Details
Drainage Area ID: CB-6 Distance Slope Avg. Slope Flow all
[TiNFie_) | finaltin Q 1.15 321 321  Sheet |
3.8 321 321 Sheet ||| &
Define Path 258 A KW Sheet
[ === ] i [ 1D -Segments 2.22 321 321  Sheet &
=N 417 N 321  Sheet
7] Sheet Flow 063 321 321  Sheat X
Melhod @ Length: | 20.000 1.91 3 kg Sheet bz

289 321 321  Sheet
nVae (0012 ) | Sope: (3213 0% 321 321 Conc

— 191 321 321 Conc
°" How R 448 321 321 Conc
Length: | 0.000 2.25 3.21 321 Conc

inter. K: [0491 Slope: [0.000 414 321 321 Conc

066 321 321 Conc |

= Distance: Slope:
Method: Length: | 325.164 :
(Coninty v} Length 1150 | [3210

I Max Sheet Flow Distanoe
Accum. Distance: 345.164 Max Shallow Flow Distance\_ 0.000

Accum. Avg. Slope: 2.147
EDE=n etk

The calculated Time of Concentration is less than the minimum of 5 minutes, therefore
5 must be manually typed in the Drainage Area Definition dialog after hitting apply in
the Time of Concentration Window.

Since the flow appears to go directly from sheet to concentrated flow we unchecked
shallow flow. For this area, set Max Sheet Flow to 20. Also note that the n Value

changes to 0.012 (Asphalt).

e) Delineate Subareas utilizing the Land Use DGN:

P Drainage Area Subareas = = |3
Window Center
AealD: 4 [CB6 ~| » E = & ol WA
Details
Options To Node ID: CB-6 et
Definition Subarea C Value Description
Automati
SUbE"'EE'E_ 0.1877 0.900 Conc/Asphalt Pvmt
Computation 0.0136 0.300 Forested Areas a
Display Onby
Hydro. Method ¢
(@ Rational
® 5CS
0.014 0.300 Forested Areas
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Exercise 5
f) Compute Discharge and Apply:

M Drainage Area Computations = B |||
Window Center

Area |D: CB-6 - Ol
Details
Diptions Area C Value e
Definiti -
- Total Subareas: 0.201 0.859 Discharge
Computatior Remainder: 0.056 0.350

Hydro. Method Composite: 0.257 0.745

@ Rational Computed Intensity:  6.380

0 3C3 Computed Discharge: 1.343

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
ﬂ Node Configuration - Computations ] = |_I§I |ﬁf
"] Window Center '
N | > e g
odeID 4 [CB6 | » P Horiore W 8% w4
Detais
'Oplions Discharge = 1.3432
: ' Spread Width from Gutter = 55181
g Total Ponded Width = 55181 <
o Ponded Depth = 0.2404
|Spread Crteria Spread Left Intercept = 0.0000
|Elevations Spread Right Intercept = 5.5181
{Junction Loss Grate Length = 3.0210
?Discharge Options Grate Width = 1.8130
- Grate Capacity = 1.1155
| o tatioes ByPass Flow = 0.2277
Efficiency = 0.8305

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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5.13 Design Inlet CB — 7
It has been determined that a CB#43 8X4 will be used.
See Standard Drawing D-CB-43SB for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-7

Properties > Change the Node Properties to Sag and to a CB#43 8X4 (a type #43
catch basin was chosen due to the fact that this will collect a significant amount of water
not on the roadway):

. . RS e -
Window Center
Mode ID CB-7 - [ i
Details
Options | Description:
Properties Node Type: [Grate x|
Location ) =
Spread Criteria _ Profie: [ Sag ] -
Hiwrtions Library ttem: |CB#43 84 - |
Junction Loss
Digcharge Options
Computations

[ ] Node Bottom: E-Nnn.e Available v
[] Owvemide Library Payitem: 1

b) Location > All Reference information is defaulted from the previous Node (CB-6) such
that only the + Angle, Station and the Offset needs to be changed. Pay special
attention to the placement and rotation of this catch basin. It has been rotated to
intercept as much runoff as possible:

r - 1
P e ortpoor oon S [ e
Node ID 4 [CBZ -/ » Hmd"””.w“c“w*i‘afﬂ%"ﬁ@

Dol

Options | [ Chain: [7] Profie: [DESIGNCL v ]
Properties Coordinates / Stationing

cotie | o ot ) 4 - eg oD
Blevations Station: | 6+20.00 X 3201.398
dunclion Loss* [¥] Offset: | -50.000 f} Y: 3197.122
Discharge Options priz : e
Computations (] Mirror Node Offset from Gutter to Inlet: | 0.000
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Exercise 5

NOTE: The following image shows why this location was chosen for CB-7. Upon inspection of
the TIN File, utilizing the DTM Drainage Tools discussed in Chapter 3, a ponded area was
discovered at this location. CB-7 was set at the low point of the ponded area. To simplify the
design and minimize land disturbance, CB-3 and CB-4 were set at the same station. The
iterative steps required for this determination were not shown in this manual, but would

be required in an actual design project.

B Viewl, Default

[E=0| BT =0

Br-ax-AQQIRNHEY O DE|HLG

c) Spread Criteria > Enter the Spread Criteria as shown below.
% Slope Left: 5.00 % (From DTM Tools>Analysis>Height/Slope)
% Slope Right: 5.00 % (From DTM Tools>Analysis>Height/Slope)

% Discharge Left: 10.00% (Estimated based on placement within drainage area)
% Discharge Right: 90.00% (Leftover area)

NOTE: Left and Right are defined by a node at angle 0. To gain your bearing,
remember this node has been rotated 270 degrees or 90 degrees clockwise.

™

M Nede Configuration - Optional Spread Criteria for Sags A= <
Window Center : T
Mode ID 4 [CB-7 | ;
ode 1D 4 | | > e % ' A ey |
Details
-Optiu:uns % Slope Left: | 5.000 Right: | 3.500
s % Dizcharge Left: | 10.000 Right: | 50.000
{E:E:s Spread Cross Section:
|5oread Citeria Spread Source: | Reference Suface =
|Elevations | Width % Slope  Roughne: = Madmum
[Junction Loss | ;.0sz YL D016 [E Fond Depth: | 0.500
| Discharge Options 0.181 4.897 0.016
E!:'Z'“"F"-ftatlﬂnﬁ | 0103 4 857 0016 |~ Pond Width: | 2.000
0000 0.000 0.000

LS
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d) Elevations > Elevation Data must be changed to match a CB#43 8x4. From the TDOT
GEOPAK Drainage Nodes Document set the following:

Vertical Alignment: Min. Fixed Drop, 0.33
Minimum Depth: 2.49 feet (See note at top of page 5-7)
Maximum Depth: 20.00 feet

$#L MNode Configuration - Elevations — =
Window Center :
Mode 1D CB-7 - [ i :
e ¥ Highiight ey A L
Dietails
Options Reference Surface: | TIN File | | final tin aQ,
Froperties Elevation Source: | Reference TIN | 874111
Location
Spread Criteria Mode Elevation Option: | Same as Source x| 37411
?ev#innin Vertical Alignment: | Min. Fixed Drop = [0.330
Dﬁ':ci';”ge ontions Minimum Depth: | 2.490
Computations Maximum Depth: | 20.000
[] Add Sump Depth: | 0.000

e) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Outlet Only:

Drop Across Bottom of Structure + Min. Depth of Cover = Minimum Depth

CB#43 8x4: .33 + 2.16° = 249

NOTE: See Appendix A, pg. A-4
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Exercise 5
5.14 Delineate Drainage Area CB — 7

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-7 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 7. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-7 and turn off DA_CB-6.
Delineate Drainage Area:

Bayln Trace

NOTE: As discussed in Exercise 5.12 Delineate Drainage Area CB-6 this area will catch
a large amount of runoff prior to it entering the roadway.

c) Define Drainage Area:

&4 Drainage Area Definition | B ||
Window Center T
Area |D: CB-7 - '
alD: 4 | | P S @ AW & | ey |
Details
Options Description: To Mode IDv:  CB-7 ﬂféj
gegn'rticln Drainage Area: | 7.143 Area Selection / Creation
ubareas
Computation Base C Value: | 0.350 Select Create
Time of Conc.: | 5.000 Shape OTM Shape
Hydro. Method | Compute TC | Pick Boundary DP
@ Rational Blements Create Shape
SCS
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d) Calculate Time of Concentration:

M Time of Concentration E = :
Details :
Drainage Area ID: CB-7 Distance Slope Avg.Slope Fow =+
final tin Q 0.67 281 281  Sheet | |
2887 286 286  Sheet a
Define Path 2843 267 277  Sheet |E
1y [ ID-Segments 777 253 274  Sheet .
513 257 273 Sheet v
7 Shest Fow 3234 242 263 Sheet
Method: Length: | 300.000 7% SR 16 Sed BN
1783 168 244  Sheet
n‘ufalue'. Slope: | 1.959 0.25 253 2 44 Shest
0~ : 4326 178 229  Sheet
shallow How 476 158 227  Sheet
Length: | 100.000 3765 133 211  Sheet
inter. K: | 0.491 Slope: | 1537 1029 095 206  Sheet

6.50 1.91 206  Sheet ~ |
V| Concentrated How B

= Distance: Slope:
Method: | Continuit - | 437.279 " |
Length: | 437.27 e o Adust Fow. |
Velocity: | 5.000
Max Sheet Flow Distance: ¢300.000
Accum. Distance:  837.279 E] Max Shallow Flow Distance: \100.00(
Accum. Avg. Slope: 2.162

G %D  [Come] oot ] [ty ]

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

NOTE: The maximum length for sheet flow has changed and will vary depending upon
the drainage area. For this area, the Max Sheet Flow changes to 300 and the
Max Shallow Flow changes to 100. The n Value for Sheet Flow changes
back to 0.400

e) Delineate Subareas utilizing the Land Use DGN:

“ Drainage Area Subareas El =] @
Window Center
Area |D: CE-7 - [l
21D: 4 | J'¥ 5 ighigrt A AW & [ Ay ]
Details
Options To Node ID:  CB-7 St
Definition Subarea C Value Description
Automati
Subareas 5.7452 0.300 Forested Areas
Computation &1
& Display Onby
Hydro. Method 4
i@ Rational
™ 5CS
h.745 0.300 Forested Areas
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Exercise 5
f) Compute Discharge and Apply:

ﬂ Drainage Area Computations o
Window Center

Area ID: CB-7 - O

20 4 | | P e @ W w [y ]
Details
Options Area C Walue Compute
Definiti :
S Total Subareas: 5.745 0.300 Discharge
Computation Remainder: 1.398 0.350

Hydro. Method Composite:  7.143 0,310

i@ Rational Computed Intensity:  3.166

0 5Cs Computed Discharge: 7.006

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
ﬁ‘ Node Configuration - Computations o @
Node ID 4 [CB7 v) p L] WindowCenter o o 3% s &)
(| Highlight
_Qetails
| Options | | Total Ponded Width = 5.7866 i
: | |Ponded Width Left = 2.6732
:fm":“'es Ponded Width Right = 6.5055
LA Ponded Depth Left = 0.1290
| Spread Criteria Ponded Depth Right = 0.3167
|Elevations Grate Area = 7.2000 <
[Junction Loss Area Reduction = 0.5000 1
| Discharge Options Grate Perimeter = 15.2000
| Computations Penmeter Reduction = 0.0000
L ' |Grate Capacity = 136814 & —
Computed Head = 0.2815 [ -S—

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance
issue.

NOTE: Review the Computed Data. Items to review specifically are:

Total Ponded Width, Grate Capacity compared with Computed Discharge and
Computed Head
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5.15 Design Inlet CB — 8

It has been determined that a CB#42 4X4 will be used. See Standard Drawing D-CB-
42SB for details.

a) Select from the Main Menu Bar. Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-8

Properties > Change the Node Properties to Sag and to a CB#42 4X4:

& =S R —""lE : -
H Node Configuration-Properties | e
Window Center

Node D 4 [CBE = [l 0

oo ‘[ ]FDHighIight ﬁgﬂ)&-@'@

Dietails

Options | Description: |

E;uperties Node Type: [Grate -|

cation _ =

Spread Criteria Profile: |Sag J

Elevations Library tem: [CE#-E A¥4 v]

Junction Loss

Discharge Options

Computations

["] Node Bottom: [None Available -
[] Owemide Library Payitem: |

b) Location > All Reference information is defaulted from the previous Node (CB-7) such
that only the + Angle, Station and the Offset needs to be changed:

i — - B
Window Center

MNode 1D CB-& - O i
Details
Options | [ Chain: Profile: [DESIGNCL
Properties Coordinates / Stationing
Location Align: | Tangent to Chain | # + Angle: | 0.000
Spread Criteria ’ i =+ e
Hevations Station: | 9+30.00 X 3503054
dunction Loss Offset: | -35.000 $ Y: 3124124
Discharge Options } ; e
Compualions [] Miror Node (Offset from Gutterto Inlet: | 0.000
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Exercise 5
c) Spread Criteria > Enter the Spread Criteria as shown below.

% Slope Left: 3.50 % (From DTM Tools>Analysis>Height/Slope)
% Slope Right: 2.50 % (From DTM Tools>Analysis>Height/Slope)

% Discharge Left: 98.00% (Estimated based on placement within drainage area)
% Discharge Right: 2.00% (Leftover area)

NOTE: Left and Right are defined by a node at angle 0.

;H Mode Configuration - Optional Spread Criteria for Sags E [=] @
Window Certer
Mode 1D CE-8 - (o i
Details _ _
Options % Slope Left: | 1.000 Right: | 1.000
. % Discharge Left: | 2.000 Right: | 58.000
E;?:I:;ZI:S Spread Cross Section:
Bovead Citesia Spread Source: |Reference Suface | .
Hlevations Width % Slope  Foughne: = Mazdmum
Junction Loss 0.005 1975 TNEEE Pond Depth: | 0.500
Discharge Options 1127 1976 0016
Computations 0175 -3.0280 0ole T Pond Width: | 8.000
0.000 0.000 0.000

d) Elevations > Elevation Data must be changed to match a CB#42 4X4. From the TDOT
GEOPAK Drainage Nodes Document set the following:

# Node Configuration - Elevations — >
Window Center

Mode 1D CB-8 - [ 5

ode ID 4 [ [] Highlight & P w A Aeely
Details

Options Reference Surface: | TIM File | | final tin Q
Properties Elevation Source: | Reference TIN | 969138

Location

Spread Criteria Mode Hevation Option: | Same as Source | BR5.138
?evminnin Vertical Alignment: | Min. Fixed Crop | (0170

unction Loss -

Discharge Options Minimum Depth: | 2.320
Computations Maximum Depth: | 23.000

L___E Add Sump Depth: | 0.000

e) Click the Apply button to include this node in the Drainage Project.

CB#42 4x4:. 017 + 215 = 232
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5.16 Delineate Drainage Area CB — 8

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-8 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 8. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA_CB-8 and turn off DA_CB-7.

Delineate Drainage Area:

NTE: As discussed in Exercise 5.11 Create Drainage Are
runoff prior to it entering the roadway.

a CB-6 this area will catch

c) Define Drainage Area:

&4 Drainage Area Definition = = @
Window Center M 1
Area |D: CB-28 - :
aiD: 4 | Y S i @ @ W & [ eely |
Details
Cptions Description: To Mode ID:  CB-8 f;fgf
E'E:”m':"" Drainage Area: | 0,895 Area Selection / Creation
ubareas
Computation Base C Value: | 0.350 Select Create
Time of Conc.: | 5.000 Shape OTM Shape
Hydro. Methad Pick Boundary DP
@ PRational Elements Create Shape
SCS
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Exercise 5
d) Calculate Time of Concentration:

M Time of Concentration L_ELJ@ (3|
Details :
Drainage Area ID: CB-8 Distance Slope  Avg. Slope Flow -
TIN File +| | finaltin Q 29.62 33 N Sheet
19.65 3.14 3.24 Sheet = 8
Define Path 23.08 323 324 Sheet
Trace [0 2743 330 325  Sheet &
3096 6.73 408 Sheet %
I et Fow D% 081 347 Sed
Method: (FHA Length: | 300.000 : : A °
[H ath 667 352 347 Sheet 7
n Value: | 0.400 Slop-e: 3.167 26.61 3.40 3.46 Sheet
. 8.73 3.70 347 Sheet
e _ 2467 317 344  Sheet
Length: | 100.000 227 143 327  Sheet
Inter. K: | 0.491 Slope: | 3.016 3167 249 3.18 Sheet
483 233 317  Sheet ~
[v Concentrated How Distance: _ Slope:
Method: [Continuty w] Length: ' 62295 : : :
2 29620 | [3310
Velocity: | 5.000
Max Sheet Flow Distance:/ 300.000
Accum. Distance: 462255 Max Shallow Flow Distance: \100.000
£
Accum. Avg. Slope: 2.907
Tc= 28.956 [ Compute | | Apply | ”"""Y

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

The maximum length for sheet flow has changed and will vary depending upon the
drainage area. Keep Max Sheet Flow at 300 and Max Shallow Flow at 100.

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas | = = |ﬁ
Window Center
Area 1D: CE-8 - [l
210: ¢ | J'¥ 5 vighign A & W & [ ey ]
Dietailz
Options To Mode ID:  CB-8 Far
Definition Subarea C Value Description
Automati
Subareas 0.8928 0.300 Forested Areas
Computation ]
Display Only
Hydro. Method %
i@ Rational
= SCS
0.853 0.300 Forested Areas
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f) Compute Discharge and Apply:

ﬂ Drainage Area Computations

Area ID: 4 [CB8

-]

Details

Options
Definition
Subareas
Computation

Hydra. Method
i@ Rational
i 5C5

Tetal Subareas:
Remainder:
Composite:

Computed Intensity:

Computed Discharge:

o] ® )
i 5 %

Area C Value Compute
0.893 0.300 Dischange

0.003 0.350
0.895 0.300
3.500
0.941

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations o] @ [«
] Window Center H
N | - - . :
ode ID 4 [CB-8 Jb::me W o Xy w &) | Aoy
D._e'lails .
Options | Total Ponded Width = 4.1499 a
- Ponded Width Left = 1.4442 =
E:"’;_"'es Ponded Width Right = 45782
SRR Ponded Depth Left = 0.0369
Spread Criteria Ponded Depth Right = 0.1536
Elevations Grate Area = 3.6000 .
Junction Loss Area Reduction = 0.5000 1
Discharge Options Grate Perimeter = 7.6000
Computations | |Perimeter Reduction = 0.0000
— < |Grate Capacity = 6.8407 o
Computed Head = 0.1171 o3 x

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Review the Computed Data. Items to review specifically are:

Total Ponded Width, Grate Capacity compared with Computed Discharge and

Computed Head
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Exercise 5
5.17 Design Inlet CB — 9
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-9

Properties > Change the Node Properties to On Grade and to a CB#12 4Xa3:

™

,ﬂ, MNode Configuration - Properties = 28|
Node ID 4 [CB-3 ] » [l WindowCenter o o3¢ vy &)
[] Highlight
Details
Ciptions | Description:
Properties Mode Type: [Grate |
Location : =
Spread Criteria Profile: [On Grade | -
Bevilions Library tem: [CB#12 4%3 - |
Juniction Loss By Pass to Node: it
Dizcharge Options Mz By Pass: | 0.000
Computations =
Mode Bottom: |Mone Awvailable b
[] Owvenide Library Payitem: SE

L ~

b) Location > All Reference information is defaulted from the previous Node (CB-8) such
that only the + Angle, Station and the Offset needs to be changed. The reasoning for
the location of CB-9 will be given in the drainage area discussion:

( i h
# Node Configuration - Location (=T T
= [] Window Center "
| N .
Node ID 4 [CB-9 B P e w % w4 [ ooy |
Details _
| Options 7] Chain: [CL v | [V Profile: [DESIGNCL
Properties Coordinates / Stationing
Location : - -] 4 .
S Aign: (TangenttoChain =) #  +Angle:{(120.000)
Blevations Station: | 8+00.00 X 3363.906
Junction Loss 7] Offset: | 26.000 ; Y: 3088.645
Discharge Options : :
Computations || Mimor Node Offset from Gutterto Inlet: | 0.000

NOTE: The Spread Criteria defaults back automatically when the node is changed
back to ON GRADE, therefore no changes are necessary.
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c) Elevations > Elevation Data must be changed to match a CB#12 4X3. From the TDOT
GEOPAK Drainage Nodes Document set the following:

# Mode Configuration - Elevations — Pt
Window Center g
Maode D CB-9 - [ g :
ode ID 4 [ 4 [] Highlight woE e w4
Detailz
Options Reference Suface: | TIM File | | final tin Q,
Properties Blevation Source: | Reference TIM x| 870,780
Location
Spread Criteria Mode Bevation Option: | Same as Source | 870780
?E“alﬁﬂ"'iu Verical Alignmert: | Min. Fixed Drop «| (0170
Dﬁ'ﬂ”ﬂi‘;‘;ﬁ orrions Minimum Depth: | 2.230
Computations Maximum Depth: | 20.000
] Add Sump Depth: | 0.000

d) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Inlet and Outlet:

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth

CB#12 4x3: 3.90° - 18712 - 0.17 = 223
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Exercise 5
5.18 Delineate Drainage Area CB — 9

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-9 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 9. (You may use the following images as reference points. It is ok if your numbers

do not match exactly.) Attach reference file DA _CB-9 and turn off DA _CB-8.

Delineate Drainage Area:

NOTE: Many iterations and much investigation went into developing the placement of the
next few catch basins. The whole of the drainage area if one were to set CB-9 at the same
station as CB-6 & CB-8 is delineated by CB-9 Area and the white drainage area. These
were divided to keep the roadway spread within the required limits. The large portion of the
drainage area and the odd shape will be discussed in Exercise 5.19.
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c) Define Drainage Area:

ﬁ Drainage Area Definition | = X
Window Center

Area ID: 4 [CBD = 0

alD: 4 | ]'DHighIight & AW & [ Aoy
Details
Options Description: To Mode ID: CB-9 -ﬁf@r
Definition 3 3
Subaress Drainage Area: | 0.689 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ Select ‘ Create |

Time of Conc. | 5.000 21epe DTM Shape

R Pick Boundary DP

(@) Rational Elements Create Shape

) 5C5

d) Calculate Time of Concentration:

M Time of Concentration L?_] = [
IDetais _
e Distance Slope  Avg.Slope Fow  ~ |
final tin Q 1391 073 073  Sheet
23.59 059 0.64 Sheet |5/| A
Define Path 2977 137 096  Sheet
Trace iy 432 139 099  Sheet
10.42 1.64 1.07 Sheet %
e e
Method: v h: . S : - met
2 FHA Langt — 2697 1.65 1.28 Sheet &
n Value: | 0.400 Slope: | 1.779 161 164 128 Sheet
— 0.06 220 1.28 Sheet
[ S B, 2549 169 134  Sheet
Length: | 30.708 843 181 137  Sheet
Inter. K: | 0.491 Slope: | 5.593 17.26 217 144 Sheet
16.16 21 149 Sheet ~ |
[V Concentrated Flow : T Siope: =
Method: (Continuty ¥| Length: | 0.000 ' : _
13.910 0.730 Adjust Flow
o [ Adust Fiow |
Max Sheet Fow Distance:/ 300.000
Accum. Distance: 390.708 - Max Shallow Flow Distance:\_100.000
Accum. Avg. Slope: 2.664 [j )
[Compu ] (_2owly_] (o,

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

NOTE: The maximum length for sheet flow has changed and will vary depending upon
the drainage area. Keep Max Sheet Flow at 300 and Max Shallow Flow at
100.
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Exercise 5
e) Delineate Subareas utilizing the Land Use DGN:

M Drainage Area Subareas [ @ [
Window Center
Area ID: CB-5 - (=
210: 4 | J¥ 5 vighigh R T
Details
Options To Node ID:  CB-9 S
Definition Subarea C Value Description
Automati
Subareas 01123 0.900 Conc/Asphat Pymt
Computation 05396 0.300 Forested Areas &
Dizplay Onby
Hydra. Method %
i@ Rational
5 5CS
0 540 0.300 Forested Areas

f) Compute Discharge and Apply:

ﬂ Drainage Area Computations EI [=] @
fealD: 4 [CBS <] » [] Window Center & AW &
[ Highlight

Details
Cptions Area C Value Compute
Definiti -
Sborone Total Subaress: 0.652 0.403 Discharge
Computation Remainder: 0.037 0.350

Hydro. Method Composite: 0689 0400

@ Rational Computed Intensity:  3.210

) 5C3 Computed Discharge: 0.886

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations E] @ @
| Window Center N
| 4 = L] i
Node ID 4 [CB-S > E] Hiohight W w % w4 | Aol |
_Delai[s _
| Options | | Discharge = 0.8856
: Spread Width from Gutter = 4.0723 —
f"’pe_“-es Total Ponded Width = 4.0723
o Ponded Depth = 0.2114
|Spread Crteria Spread Left Intercept = 0.0000
Elevations Spread Right Intercept = 4.0723
|Junction Loss Grate Length = 3.0210
| Discharge Options Grate Width = 1.8130
: Grate Capacity = 0.8022
| at
(Computations | |ByPass Flow = 0.0834
Efficiency = 0.9058

Don'’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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5.19 Design Inlet CB —

10

It has been determined that a CB#43 8’ DIA. will be used.

See Standard Drawing D

-CB-43R for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-10

Properties > Change the Node Properties to Sag and to a CB#43 8’ DIA:

|"1

M Mode Configuration - Properties | = X
Node 1D 4 (CBAD 7] » D fiedonConter g g5 i 4
Dietails
Options Description:

Properties Node Type: |Grate x|

Location e =

Spread Criteria Profile: (Sag ] .
ik Library tem: [CB#43 8 DIA - |

Junction Loss

Digcharge Options

Computations

Mode Eottom: |Mone Available
[ Ovemide Library Payitem:

Align

L

-

NOTE: 8 Diameter is a round catch basin. The reasoning behind this selection is the
need for the grates to be at such an angle that a pipe cannot be attached at a skew
within the required limits. See TDOT Drainage Manual Chapter 7 Section 7.03.5.5
Pipe Connections to Structures.

b) Location > All Reference information is defaulted from the previous Node (CB-9) such
that only the + Angle, Station and the Offset needs to be changed. The reasoning for
the location of CB-10 will be given in the drainage area discussion. Especially note the

Angle and Offset:

I |

M Node Configuration - Location =] 28
. | WindowCenter .. v w2 [ deenr

Node | \CB- - '
ode ID 4 [CB-10 | P 5 gt W oo % w4 | Pl
Details :
| Options [¥] Chain: [CL v| [¥] Profile: [DESIGNCL v ]
| Properties Coordinates / Stationing
[1.ocation Aign: [TangenttoChain _v] #  +Angle{(120.000
| Spread Criteria i : :
| Blevations Station: | 8+00.00 : X: 3361.650
:Jgnduon Lnss. 7] Offset:  38.000 Y: 3076.859
Discharge Options L Epr—
|Computations ] Mimor Node Dffset from ter et
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Exercise 5
c) Spread Criteria > Enter the Spread Criteria as shown below.

% Slope Left: 5.00 % (From DTM Tools>Analysis>Height/Slope)
% Slope Right: 5.00 % (From DTM Tools>Analysis>Height/Slope)

% Discharge Left: 50.00% (Estimated based on placement within drainage area)
% Discharge Right: 50.00% (Leftover area)

NOTE: Left and Right are set equal since the flow will come to each equally.

# MNode Configuration - Optional Spread Criteria for Sags l = S
Window Center
Node ID-4| [cB-10 ~ O B I < Apply
I ) ] Highlight bz [l e -
Details
% : ight:

Tie % Slope Left: | 5.000 Right: | 5.000

Properties % Discharge I__efl: 50.000 Right: | 50.000
. Spread Cross Section:

Location
Spread Criteria Spread Source: IReference Surface 'J
Elevations Width % Slope  Roughne: « Maximum
Jgnctlun LDSS. 4095 -1.975 00168 |= Pond Depth: | 0.500
Discharge Options 1,906 -50.003 0.018
C tati - -

omptiations 1.000 -2000  0.0186 Pond Width: | 8.000

0.000 0.000 0.000

d) Elevations > Elevation Data must be changed to match a CB#43 8’ DIA. From the
TDOT GEOPAK Drainage Nodes Document set the following:

LA
Window Center

Node ID 4 CB-10 - Ll h

ode 1D 4 [] Highlight W )| eely
Dietails

Options Reference Surface: | TIMN File w | | final tin Q
Properties Blevation Source: |Reference TIN - 872383
Location
Spread Criteria Mode Blevation Option: | Same as Source - 872383
?evatinn; Vertical Alignment: | Min. Fixed Drop = 0330

unction Loss e
Discharge Cplions Minimum Depth: | 2.820
Computations Maximum Depth: | 40.000

[ ] Add Sump Depth: | 0.000

e) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Outlet Only:

Drop Across Bottom of Structure + Min. Depth of Cover = Minimum Depth

CB#43 8'DIA: 0.33’

NOTE: See Appendix A, pg. A-4

+ 249 = 2.82
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5.20 Delineate Drainage Area CB — 10

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-10 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 10. (You may use the following images as reference points. It is ok if your
numbers do not match exactly.) Attach reference file DA_CB-10 and turn off

DA_CB-9.

Delineate Drainage Area:

Begln Truée

NOTE: Drainage area CB-10 was created by first using downstream trace and discovering
that it converges into a relatively small area. Therefore when CB-10 was placed, upstream
trace was used from either side of the catch basin to determine the drainage area. CB-10
was rotated to match the contours in order to catch as much flow as possible.

=3 EER [

LR EEIEEIERE
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Exercise 5
c) Define Drainage Area:

M Drainage Area Definition = B [t
Window Center

frea D - - Ol

21D: 4 [CB10 | » 0 Hihiiht & Al WG
Details
Options Description: To Nede [D:  CB-10 -%I
Definition ; 3
i Drainage Area: | 2.733 Area Selection / Creation
Computation Base C Value: | 0.250 ‘ g?'i&d ‘ DTCI:rﬂeEthe

e s | 15051 ape ape

o Vtod P oy o7

@ Rational Blements Create Shape

i SCS

d) Calculate Time of Concentration:

M Time of Concentration o @ (=3
Details
Dreinage Area ID:  CB-10 Distance Slope Avg.Slope Flow  [4]|
TIN File ¥] final tin Q 20.56 2.80 280  Sheet (o
6.19 1.89 259 Sheet | || O
Define Path 26.63 149 204  Sheet
Trace (i | ID - Segments 1507 134 202  Sheet &
21.45 1.60 192  Sheet
 ShotFow pe = = = N
Method: (FHA__v]  Length: | 300.000 - - ; e
(HA_v]  Lengh 3773 164 187  Sheet &
n Value: | 0.400 Slope: | 1.966 0.84 163 1.87 Shest
0.39 188 187  Sheet
v Shallow Fow 454 175 185  Sheet
Length: | 100.000 27.49 158 182  Sheet
Inter. K: | 0.491 Slope: | 2.908 7.34 2.10 1.83 Sheet
25.31 1.9 184  Sheet |~l|
| Concentrated FHow e Slope:
Method: Length: | 779.769 : : :
Cortruty v) Lengh: |7 20560 | [2800
Velocity: | 5.000
Max Sheet Flow Distance:” 300.000
Accum. Distance: 1179.769 Max Shallow Flow Distance:\_100.000
Accum. Avg. Slope: 2.366 s
(Compue ] [ only ] (2o ]

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required.

NOTE: The maximum length for sheet flow has changed and will vary depending upon
the drainage area. Keep Max Sheet Flow at 300 and Max Shallow Flow at
100.
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e) Delineate Subareas utilizing the Land Use DGN:

# Drainage Area Subareas EI =] @
aes D 4GB0 < » [7] Window Cenrter £ D W &
[ Highlight
Details
Options To Node ID:  CB-10 St
Definition Subarea C Value Description
Automati
Subareas 22860 0.300 Forested Areas
Computation 1
Display Only

Hydro. Method 5

(@ Rational

) 5C5

2.286 0.300 Forested Areas

f) Compute Discharge and Apply:

“ Drainage Area Computations E\ =] @
. - [] Window Center

Area ID: 4 [CB-10 ¥ Hoicht # oA W&
Details
Options Area R Compute
Defirt °
. Total Subareas: 2.286 0.300 1Sl
Computation Remainder: 0.447 0.350

Hycro. Method Composite:  2.733 0.308

@ Rational Computed Intensity: 3.124

© SC5 Computed Discharge: 2632

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations = l'® @
[] Window Center -
| - % i
Node ID 4 (CB-10 5 P 5 g W oe % w4 | Aeel
Details
Options Total Ponded Width = 1.7253 €«
" Ponded Width Left = 3.5957
f""z"‘e"‘ Ponded Width Right = 35957
Do Ponded Depth Left = 0.2019
Spread Criteria Ponded Depth Right = 0.2019
Elevations Grate Area = 7.2000 =
|Junction Loss Area Reduction = 0.5000
Discharge Options Grate Perimeter = 15.2000
Computati Perimeter Reduction = 0.0000
-spdtons Grate Capacty = 13,6814 * .
Computed Head = 0.1465 — 7

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance
issue.

NOTE: Review the Computed Data. Items to review specifically are:

Total Ponded Width, Grate Capacity compared with Computed Discharge and
Computed Head
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Exercise 5
5.21 Design Inlet CB — 11
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-11

Properties > Change the Node Properties to On Grade and to a CB#12 4x3:

i S : 1™
Window Center
Mode 1D CB-11 b ] B
Details
Options [ Description: | |
Properies Mode Type: |Grate -|
Location : =
= .
ik Library ttem: [CB&12 443 - |
Junction Loss By Pass to Node: | i
Discharge Options M Pass: | 0.000 ;
Computations e By P = =
Mode Bottom: |Meone Available - | -
[] Ovemide Library Payitem: : 7 bl

b) Location > All Reference information is defaulted from the previous Node (CB-10) such
that only the + Angle, Station and the Offset needs to be changed:

r _— -
TETEENE
Rt
Details :
Options | @iChain:[cL ~] (7] Profie:
Properties Coordinates / Stationing
Spread Crteria Aign: (TangenttoCrain _~) #  +Angle:((180.000 )
Blevations Station: | 9+30.00 X 3491.589
3_‘:;'*"" bd’:ﬁ 7] Offset: | 26.000 ¢ Y: 3064212
ons
Curnpfn?;ons [™] Miror Node Offset from Gutter to Inlet: | 0.000

NOTE: The Spread Criteria defaults back automatically when the node is changed
back to ON GRADE, therefore no changes are necessary.
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c) Elevations > Elevation Data must be changed to match a CB#12 4X3. From the TDOT
GEOPAK Drainage Nodes Document set the following:

o
Window Center

Node ID 4 [CB-11 - [ :

ode D 4 ¥ [ Hiohight W%y w4 | Aeely
Details

Options Reference Surface: | TIM File | | final tin Q,
Properties Elevation Source: | Reference TIN * BERR1E
Location

Spread Criteria MNode Blevation Option: | Same as Source -| BRERIE
?eumiuniu Vertical Alignment: | Min. Fixed Drop = 0170

unction Loss . _

Discharge Options Minimum Depth: | 2 230

Computations Maximum Depth: | 20.000

[ ] Add Sump Depth: | 0.000

d) Click the Apply button to include this node in the Drainage Project.

Catch Basins — Inlet and Outlet:

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth

CB#12 4x3: 3.90° - 18712 - 0.17 = 223
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Exercise 5
5.22 Delineate Drainage Area CB — 11

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-11 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 11. (You may use the following images as reference points. It is ok if your

numbers do not match exactly.) Attach reference file DA CB-11 and turn off
DA _CB-10.

Delineate Drainage Area:

included to make sure all drainage area is captured. In reality, this sliver would likely be
captured by CB-10

c) Define Drainage Area:

rH, Drainage Area Definition E [=] @ﬁ
- . -
Area ID: 4 [CB-11 ~| » ﬂ‘:'g”hd"';“l_‘dcemer # ok B & | Aesly |
Details
Optiong Description: To Mode ID: CB-11 ﬁf&r
gi;:-t;: Drainage Area: | 0.191 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ Select ‘ Create ‘
Time of Conc.: | 37.201 whape DTM Shape
Hydro. Method ‘ Fick Boundary ‘ CP
& PFational Elements Create Shape
SCS
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d) Calculate Time of Concentration:

M Time of Concentration LE..I! E |we3w)
Details
Drainage Area ID: CB-11 Distance Slope  Avg. Slope Flow A
TIN File +| | final tin Q 32.96 254 254 Sheet |=
10.08 234 250 Sheet - £1
Define Path 22.33 279 260 Sheet
Trace | ID - Segments 1063 271 261  Sheet
21.79 347 2.80 Sheet x
I st B XA5 22 27  Shos
Method: |FHA ~ Length: | 300.000 : : A
gth 364 232 269 Sheset &
n Value: | 0.400 Slope: | 2.104 28 53 215 2 63 Sheet
1.33 203 263 Sheet
¥ Shallow Fow 3093 166 247  Sheet
Length: | 100.000 5.05 157 245  Sheet
Inter. K: | 0.491 Slope: | 1.593 27.22 1.98 239 Sheet
1.85 1.19 238 Sheet ~
|V Concentrated How eies. Slope:
Method: Length: | 320.915 : -
(Continuity v] Length o -
Velocity: | 5.000
Max Sheet Flow Distance: / 300.000
Accum. Distance: 720.915 Max Shallow Flow Distance: \ 100.000
Accum. Avg. Slope: 2444 :
Tc= 34.801 [ Compute | | Apply | [ Aonty |

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with

NO further steps required. Keep Max Sheet Flow at 300 and Max Shallow

Flow at 100.
e) Delineate Subareas utilizing the Land Use DGN:
M Drainage Area Subareas o B |
Window Center
Area D CEB-11 A O
. J'Y 5 tghight 9 AW & [y ]
Detailz
Options | To MNode ID:  CB-11 it
Definttion Suh C Val Dezcrinti
Cubareas uparea alle E.'SCHIJTIQFI | Automatic
. 0.0753 0.500 Conc/Asphalt Pvmt Delineatian
Computation 0.0967 0.300 Forested Areas ]
Display Oy
Hydro. Method %
@ Rational
@ SC5
0.096 0.300 Forested Areas
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f) Compute Discharge and Apply:

Exercise 5

ﬂ Drainage Area Computations

v

AreaD: 4 [CB-11

Details

Options

gj:;f;;l Tetal Subareas:

CompLtation Remainder:
Hydro. Method Composite;
(@ Rational Computed Intensity:
O SC5

Computed Discharge:

o=l & (=Sl
] Window Center
[] Highlight & @ W &
Area C Value Compute
0.175 0.570 Discharge
0.016 0.350
0.191 0.552
3.200
0.337

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.

M Node Configuration - Computations

Node ID 4 [CB-11 v »
Details
Options Discharge = 0.3369
- Spread Width from Gutter = 1.7590

E;';‘;:‘;‘:S Total Ponded Width = 1.7590

o Ponded Depth = 0.14595
Spread Crteria Spread Left Intercept = 0.0000
Elevations Spread Right Intercept = 1.7590
Junction Loss Grate Length = 3.0210
Dischange Options Grate Width = 1.8130
Computations Grate Capacity = 0.3369

ByPass Fow = 0.0000
Efficiency = 1.0000

=)@ =
W o Yy w 4) | Aeoly

("] Window Center
(7] Highlight

e

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance

issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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5.23 Design Inlet CB — 12
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-12

Properties > Verify the Node Properties are defaulted from the previous Node (CB-11)
such that no user-input is required for this similar curb inlet.

M Node Configuration - Properties | = 2|
[ Window Center
Node 1D CB-12 - = f
Dietails
Options Description:
Propertics Mode Type: |Grate A
Location -
Spread Criteria Profile: [On Grade | -
i it Library ftem: [CB&12 4%3 - |
Junction Loss By Pass to Node: it
Disu:hargg Options Max By Pass: | 0,000
Computations
MNode Bottom: |Nene Awvailable - -
[] Ovemide Library Payitem: Align

LS A

b) Location > All Reference information is defaulted from the previous Node (CB-11) such
that only the + Angle, Station and the Offset needs to be changed:

,ﬂ MNode Configuration - Location | = 2 |
[ Window Center
Mode 1D CB-12 - =) i
— b Dt gy g (o]
Detailz
Options | [¥] Chain: [CL + | [¥] Profile: [DESIGNCL - |
Properties Coordinates / Stationing
Location L : = ]
Spread Criteria Hign: |Tangent to Chain | # + Angle: | 0.000
Elevations Station: | 12+00.00 X 3766.316
Junction Loss [¥] Offset:| -26.000 $ Y. 3064627
Digcharge Options AR
Computations [ Mimor Node Offset from Gutter to Inlet: | 0.000

LS A

c) Click the Apply button to include this node in the Drainage Project.
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Exercise 5
5.24 Delineate Drainage Area CB — 12

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-12 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 12. (You may use the following images as reference points. It is ok if your
numbers do not match exactly.) Attach reference file DA_CB-12 and turn off
DA CB-11.

Delineate Drainage Area:

c) Define Drainage Area:

& Drainage Area Definition l = | |&]
Window Center ; [ ]
Area ID: 4 [CB-12 v | i A
alD: 4 | I Highlight & A W & Apply
Details
Ciptions Description: To Meode (D CB-12 ﬂ%j
Definiti - -
Sugzr;ins | Dinge e | 0,199 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ E?E'ﬁ ‘ | DTCI'TdegthE ‘
_ | Time of Conc.: | 5.000 8 i
Hydro. Method | Compute TC | Pick Boundary DP
@ Fational Elements Create Shape
5C5
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d) Calculate Time of Concentration:

M Time of Concentration [E]iﬁ@_ | s
Details
Drainage Area ID: CB-12 Distance Slope Avg.Slope Flow  »
TIN File =/ finaltin Q 462 263 263 Sheet |
1.82 2863 263 Sheet |=|| O
Define Path 374 263 263 Sheet
Trace m 143 263 263  Sheet
0.70 263 263 Sheet %
@] Sheet Flow 448 263 263 Sheet
Method: I‘EE Length: | 31.000 322 263 263 Sheet e ]
1.95 263 263 Sheet
"Va'ue- Slope: | 2.540 4.01 263 263 Sheet
= 042 867 273  Sheet
(Oshaltow Flow D — 162 867 307  Sheet
Length: | 0.000 0.72 171 304  Sheet
Inter. K: | 0.491 Slope: | 0.000 2.27 1.7 2.94 Sheet
2.73 1.7 2.84 Conc ~
[ Concentrated Row T Slope:
Method: @ :] Length: | 252 483 ' = .
. 4620 2630
Velocity: | 5.000
Max Sheet Flow Distance:/ 31.000
Accum. Distance: 283.483 Max Shallow Flow Distance: \0.000
Accum. Avg. Slope: 1.846
[Comois]) (o ] (oo ]

The calculated Time of Concentration is less than the minimum of 5 minutes, therefore
5 must be manually typed in the Drainage Area Definition dialog after hitting apply in
the Time of Concentration Window.

The maximum length for sheet flow has changed and will vary depending upon the
drainage area. Max. Sheet Flow is 31 and Shallow Flow should be toggled
off. The n value should be set to .012.

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas | = 2 |
Window Certer
Area ID: CB-12 r [
=R ) b Dedorceie g g 3% g (o]
Detail=
Options | To Node ID:  CB-12 it
Definition Subarea C Value Description
U il el o R e | M ati
Subareas 0.1617 0.900 Conc/Asphalt Pyt
Computation &1
[¥] Display Oniby
Hydro. Method 3¢
i@ Rational
@ 5C5 -
0.162 0500 Conc/Asphalt Pvmt
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Exercise 5

f) Compute Discharge and Apply:

ArealD: 4 [CB-12

Details

Options |
Definition

Subareas
Computation

Hydro. Method
i@ Rational

&) 5C5

= [] Window Center
LY [ Highlight & @B & -

Area C Value G
Total Subareas: 0.162 0.500 Discharge
Remainder: 0.037 0.350

Composite: 0.797

Computed Intensity:
Computed Discharge:

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.

p
M Node Configuration - Computations

lDI &3

]W

Node ID 4 [CB-12

D) b Dlimience sy g 4 (o)

Details

Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Options
Computations

Discharge = 1.1065

Spread Width from Gutter = 4.8368 €
Total Ponded Width = 4.8368

Ponded Depth = 0.2267

Spread Left Intercept = 0.0000
Spread Right Intercept = 4.8368
\Grate Length = 3.0210

Grate Width = 1.8130
Grate Capacity = 0.9578
ByPass Flow = 0.1487
Efficiency = 0.8656

L=

J

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance

issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.

GEOPAK Drainage V8i (SELECT Series 2)

Storm Drainage Nodes 5-67



5.25 Design Inlet CB — 13
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-13

Properties > Verify the Node Properties are defaulted from the previous Node (CB-12)
such that no user-input is required for this similar curb inlet.

;H Mede Configuration - Properties | = 2 |
[ Window Center 5

Mode 1D CB-13 hd =

ode D 4 | Y e w0 % &) e |
Details

Options _ Description:

Properties Node Type: [Grate -|

Location i =

Spread Citeria Profile: [On Grade | -

e s Library ltem: [CB&12 4X3 - |

Junction Loss By Pass to Mode: gt

Discharge Options Max By Pass: | 0,000

Computations )

MNode Bottom: |Mone Awailable A =
[] Owvemide Library Payitem: Align

b -

b) Location > All Reference information is defaulted from the previous Node (CB-12) such
that only the + Angle, Station and the Offset needs to be changed. This station is not
set equal to CB-12 due to changing super elevation shapes. After a few iterations this
station was chosen in order to keep the spread within the limits. :

r' I ™

M Node Configuration - Location l= | R

Node ID 4 [CB-13 v] p [ WindowCenter o &% ' &
— ; || Highlight
Details
| Options [¥] Chain: [CL v | [V] Profile: |DESIGNCL - |
Eompemes Coordinates / Stationing
cation B : -| 4 .

| Spread Crteria Align: [Taqg_mtto(}mm J # + Angle:( 180.000
Elevations Station: | 11+45.00 X: 3702.757
[Junction Loss [¥] Offset: | 26.000 $ Y: 3023.802
| Discharge Options i ;
Computations || Miror Node Offset from Gutter to Inlet: | 0.000

c) Click the Apply button to include this node in the Drainage Project.
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Exercise 5
5.26 Delineate Drainage Area CB — 13

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-13 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 13. (You may use the following images as reference points. It is ok if your
numbers do not match exactly.) Attach reference file DA_CB-13 and turn off
DA CB-12.

c) Define Drainage Area:

.H, Drainage Area Definition L= = % =
Window Center ;
Area D CB-13 - | y i
21D 4 | | b S g @ %) &) ey
Details
Oiptions Description: To MNode ID: CB-13 {’%f
Diefiniti : :
Sugzr;-:;ns | Drainage Area: [0.156 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ gs'ﬂm ‘ DTirﬂegthE ‘
_ | Time of Conc.: | 5.000 o Be
Hydro. Method Compute TC | Pick Boundary DP
@ Rational : L Elements Create Shape
SCS
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d) Calculate Time of Concentration:

M Time of Concentration = B |3
Details -
Drainage Area ID: CB-13 Distance Slope Avg.Slope Fow  ~
TIN File ] | final tin Q 1.37 263 263  Shest
4.03 2.63 263 Sheet ||| 8O
Define Path 1.15 263 263 Sheet
o 0% 25 5 S | @
1.62 2.63 2.63 Sheet %
7 Sheet Flow 607 263 263  Sheet
Method: [E Length: | 20.000 5.21 263 263 Sheet 7
1.18 263 263 Conc
“Va‘uei Slope: | 2.631 1.84 867 311 Conc
—— 0.20 867 316 Conc
°" How _ — 045 171 313 Conc
Length: | 8.00C 5.00 1.71 289  Conc
inter. K: [0.491 Slope: [0,000 5,00 171 271 Conc
5.00 1.71 258 Conc ~
'/ Concentrated How Distance: Slope:
Method: (Continuty w] Length: 208 668 ' - _
o 1370 2630
Velocity: | 5.000
Max Sheet Flow Distance " 20.000
Accum. Distance: 228.668 Max Shallow Flow Distance\_0.000
Accum. Avg. Slope: 1.719
Apply
[Compute ] Aomt_] (2o ]

The calculated Time of Concentration is less than the minimum of 5 minutes, therefore
5 must be manually typed in the Drainage Area Definition dialog after hitting apply in
the Time of Concentration Window.

NOTE: Since the majority of flow is in the gutter (Concentrated Flow), we toggle off
Shallow Flow and change Max Sheet Flow to 20. The n Value for Sheet
flow changes to 0.012.

e) Delineate Subareas utilizing the Land Use DGN:

M Drainage Area Subareas | = | | 28 |
Window Center
Area ID: CB-13 hd Cl
=LA J ¥ vighight & @B @ [
Details
Options | To Node ID:  CB-13 St
Definition Subarea C Value Description :
FiroeelEeci 1 o [ =l e ] M ati
Subareas 0.1306 0.900 Conc/fsphalt Pymt
Computation &1
[#] Display Oy
Hydro. Method 3
i@ Rational
® 5CS
013 | | 0.500 | | Conc/Asphalt Pyt
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f) Compute Discharge and Apply:

M Drainage Area Computations || B |
Window Center

Area ID; CB-13 - O

alD: 4 | ]FDHighIigI'rt @@@&]
Details
Options Area C Value —
Definiti ;
- Total Subareas:  0.130 0.900 Discharge
Computation Remainder: 0.025 0.350

Hydro. Method Composite: 0,155 0810

i@ Rational Computed Intensity:  &.980

0 565 Computed Discharge: 0.877

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.
M Node Configuration - Computations o] @ ([
: = "] Window Center
Node ID 4 [CB-13 ) > B ngrie w 8% w4 [ Aeoy |
Details
Options | Discharge = 0.8765
. Spread Width from Gutter = 7.2730 €———————
E"‘c‘z_”*es Total Ponded Width = 7.2730
i Ponded Depth = 0.2058
Spread Criteria Spread Left Intercept = 0.0000
Blevations Spread Right Intercept = 7.2730
Junction Loss Grate Length = 3.0210
Discharge Options Grate Width = 1.8130
; Grate Capacty = 0.7312
(Compubalions | |5 ores Flow= 0.1453
Efficiency = 0.8342

Don'’t be alarmed if your results are off by a few 100™s. It could just be a tolerance issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.
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5.27 Design Inlet CB — 14
It has been determined that another standard CB#12 4X3 will be used.
See Standard Drawing D-CB-12S for details.

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name CB-14

Properties > Verify the Node Properties are defaulted from the previous Node (CB-13)
such that no user-input is required for this similar curb inlet.

;H MNode Configuration - Properties | = X
[ Window Center
Mode D CE-14 - == 3
ode ID 4 | I ¥ [~] Highlight ey e B (el
Dietailz
Options [ Description:
Properties Mode Type: [Grate |
Location s =
Spread Criteria Profile: [On Grade ] -
Hiiribos Library ftem: [CB&12 4%3 |
Juniction Loss By Pass to Node: it
Discharge Options Mexc By Pass: | 0,000
Computations [
Mode Bottom: |None Awailable - -
[] Overide Library Payitem: Algn

LS A

b) Location > All Reference information is defaulted from the previous Node (CB-13) such
that only the + Angle, Station and the Offset needs to be changed. This station is
chosen since it is on an even station and near where we want our outlet:

M Node Configuration - Location |¢_ |
[] Window Center
Mode ID CB-14 = = "
ode D 4 | Y St ® 8% 4 (e ]
Deetails
Options [¥] Chain: [7] Profile: [DESIGNCL =
Properties Coordinates / Stationing
Location o = = .
Spread Criteria Hign: [Tangent to Chain | # + Angle: | 0.000
Elevations Station: | 14+00.00 *: 3960176
dunction Loss [¥] Offset: [ -26.000 $ Y. 3049171
Discharge Options R
Computations [ Mimor Mode Offset from Gutter to Inlet: | 0.000

LS A

c) Click the Apply button to include this node in the Drainage Project.

5-72 Storm Drainage Nodes GEOPAK Drainage V8i (SELECT Series 2)



Exercise 5
5.28 Delineate Drainage Area CB — 14

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name CB-14 should automatically appear, click OK.

b) Follow the steps in Exercise 3.2 to delineate and define the drainage area for Catch
Basin 14. (You may use the following images as reference points. It is ok if your
numbers do not match exactly.) Attach reference file DA_CB-14 and turn off

DA_CB-13.

Delineate Drainage Area:

c) Define Drainage Area:

# Drainage Area Definition L= B s |
Window Center FATEET
Area 1D CB-14 - | 5
21D | | Y S 8 AW & [ ey |
Details _
Ciptions ' Description: To Mode ID: CB-14 ﬁ%‘
Definiti : i
'Sut:znla-zns Peaiiage feea: | 0,286 Area Selection / Creation
| Computation Base C Value: | 0.350 ‘ e ‘ Wt ‘
Time of Cone.: | 5.000 it it
Hydro. Method [ Compute TC | Pick Boundary DP
@ Rstional Elements Create Shape
SC5
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d) Calculate Time of Concentration:

ﬂ Time of Concentration E'_ éﬁ
Details _
Drainage Area ID: CB-14 Distance Slope Awvg. Slope Flow -
TIN File =/ | final tin Q 242 2.06 2.06 Sheet |-
443 1.76 1.87 Sheet 3|
Define Path 1.91 1.98 1.89 Sheet
[0 ‘ ID - Segments 117 198 190  Sheet
455 157 1.80 Sheet %
[@ Sheet Fow 013 166 180  Sheet
0.09 1.27 1.79 Sheet
n Value: @ Slope: | 1.730 554 150 171 Sheet
— 195 117 166  Sheet
°" Fow e 366 143 163 Sheet
Length: | 0.000 3.16 1.09 157  Sheet
nter. K: | 0.491 Slope: | 0.000 2.30 1.38 1.56 Sheet
1.83 1.38 155  Sheet ~
|v Concentrated How Distance: Sore:
Method: Length: | 170.667 - - :
(Continuey ~) oth 2420 2.060
Velocity: | 5.000
Max Sheet Flow Distance: /120.000
Accum. Distance: 290667 Max Shallow Flow Distance: \0.000
Accum. Avg. Slope:  1.933 a
Apply
[Compute ] (oo _] et

The calculated Time of Concentration is less than the minimum of 5 minutes, therefore
5 must be manually typed in the Drainage Area Definition dialog after hitting apply in
the Time of Concentration Window

NOTE: The maximum length for sheet flow has changed and will vary depending upon
the drainage area. Change Max. Sheet Flow to 120 and leave Shallow Flow

toggled off.
e) Delineate Subareas utilizing the Land Use DGN:
ﬂ Drainage Area Subareas =| = ||ﬁ|
. 5 - [] Window Center
Area|D: 4 [CB-14 | » 0 Highight #oH WA
Dietails
Options To Node ID:  CB-14 St
Definition Subarea C Value Description
Subareas - Automatic
0.2709 0.500 Conc/Asphalt Pvmt E——
Computation S spnEt T ]
Display Orlly
Hydro. Method e
i@ Rational
® SCS
0.271 0.500 Conc/Asphalt Pyt
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f) Compute Discharge and Apply:

Exercise 5

ﬁ Drainage Area Computations
Window Certer

Area ID: 4 [CB-14 - [

SN ] [ Highiight
Details
Options Area
Definition
Subareas Total Subareas: 0.271
Computation Remainder: 0.027

Hydea. Method Composite: 0258

i@ Rational Computed Intensity:  &.980

0 3Es Computed Discharge: 1.767

e B[S
& & W &

C Value Compute
0.900 Discharge
0.350
0.851

g) Back in the Node Configuration dialog box click on Properties, then click again on
Computations. This allows the program to update and run calculations. Review the

Computations.

M Node Configuration - Computations

ropetes Total Ponded Width = 4.8154
cation Ponded Depth = (0.2685

Spread Critena Spread Left Intercept = 0.0000

Elevations Spread Right Intercept = 4.8154

Junction Loss Grate Length = 3.0210

Dischange Options Grate Width = 1.8130

Computations Grate Capacity = 1.4849

ByPass Flow = 0.2822
Hfficiency = 0.8403

"] Window Center
Node ID 4 [CB-14 ] 7 Hoight
_D-etails
Options Discharge = 1.7672

Spread Width from Gutter = 4.8154 €—

o] @ =
w @ % w4 [ Aoy |

Don’t be alarmed if your results are off by a few 100™s. It could just be a tolerance

issue.

NOTE: Upon review of the computations the Spread Width from Gutter is within our
limit of 8.0 feet, therefore the inlet is in good position.

This is the last catch basin in this network. The curb and gutter section continues and
any ByPass will be caught by the next network. If this were not the case, we would need
to take steps to capture or mitigate the ByPass Flow.
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5.29 Design Junction MH-1

a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name MH-1

Properties > Make the following changes:
Node Type: Junction
Library Item: MH#3 5’ DIA
(See Standard Drawing D-MH-3 for details.)

M Mode Configuration - Properties

| —

Window Center
[] Highlight

W% [ el |

Cn Grade -

Nods ID 4 [MH-1 - » L—I

Details

Options Description:

Properties Node Type: [Junction
Location Profile:

Spread Criteria o

Bt Library ftem: [MH#3 5' DIA
Junction Loss

Discharge Options

Computations

{ Y

| 'I

| !
' ;

Mode Bottom: |None Available -

[] Overmide Library Payitem:

Align

LS

-

NOTE:

A manhole is used at this location since; a junction is required, the

superelevation of the roadway is such that there is little to no flow, and Junction Boxes
are not allowed to be used under roadways.

b) Location > All Reference information is defaulted from the previous Node (CB-14) such

that only the + Angle, Station and the Offset needs to be changed. Be sure manholes
are located out of wheel paths:

,ﬂ Mede Configuration - Location | = 28 |
[ Window Center
Node ID 4 [MH-1 - = i
ode D 4 | Y i 8% 4 [ el |
Details
Options [#] Chain: |CL x| [#] Profile: |DESIGNCL -
Properties Coordinates / Stationing
Location G ; = :
Spread Criteria Align: | Tangent to Chain | # + Angle: | 0.000
Blevations Station: | 14+00.00 X 3961.075
Junction Loss _[7] Offset: | 18.000 i Y- 3005180
Dlischarge Options S
Comprtatioris —[] Mimor Node Offset from Gutter to Inlet: | 0.000
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Exercise 5

c) Elevations > Elevation Data must be changed to match a MH#3 5’ DIA. From the TDOT
GEOPAK Drainage Nodes Document set the following:

i
Window Center

Mode |ID MH-1 - [ U

ode ID 4 [ 2 [ Highlight Yu @ K w4 Peely
Details

Options Reference Surface: | TIM File | | final tin Q.
Froperties Blevation Source: | Reference Model * 851762
Location

Spread Criteria Mode Blevation Option: | Same as Source | 8R1762
?E”atinnio Vertical Aignment: | Min. Fixed Drop = | [0.210

unction Loss .

Discharge Options Minimum Depth: | 2.230

Computations Maximum Depth: | 40.000

[] Add Sump Depth: | 0.000

d) Click the Apply button to include this node in the Drainage Project.
Manhole:
Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth
MH#3 5’'DIA: 3.94’ 18712 - 0.21' = 2.23
NOTE: See Appendix A, pg. A-5

5.30 Design Outlet EW-1
a) Select from the Main Menu Bar: Component > Node > Add; or from the Main Toolbar:
Add Drainage Node; or click the Add Node button within the Node Configuration
Dialog. Click OK to set the name EW-1

Properties > Make the following changes:
Node Type: Outlet
Library Item: Endwall

Fix Tailwater at: Critical Depth
Other Tailwater options are: Uniform Depth, Soffit (Top of pipe),
or Elevation: User input (known elevation)

ol ||

M Mede Configuration - Properties

= W
Node ID 4 [EWA1 -] » n ::'g”hd"‘;tcemer W o e A
Details
Options Description:
Properties Node Type: [Outlet ]
Eu:u:atin.nﬁ. Profile; |On Grade b
spread Crteria
Elevations Librany tem: |Endwall *
Junction Loss (@ Fix Tailwater at: CrrtlcalD@ . ....... h ........ -
_[ﬁ)i_sjEI:Ta:g:aEEtiuns *) Tailwater Blevation: | 0.000
R Mode Bottom: |None Available - -
[] Cvemide Library Payitem: Mign

e — =)
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b) Location > All Reference information is defaulted from the previous Node (CB-14) such
that only the + Angle, Station and the Offset needs to be changed. Angle is critical as
to direction node will be displayed.

C=HEE

Node D 4 [EW-1 v] p [ WidowCenter o o 3% g &) (LAooy |
[”] Highlight

Details
Options [@Chain: fCL_ =] [V]Profie: [DESIGNCL  ~
Properties Coordinates / Stationing
Spread Citenia Aign: (TangenttoChain _ v] # +Pngie:
Blevations Station: | 14+00.00 X 3561.852
mni | °“L‘§:ﬁ -[¥] Offset: | 56.000 _ ¢ Y: 2967.188
Comauta:ons = -[] Mior Node Offset from Gutter to Inlet: | 0.000

c) Elevations > Change the Elevation data to the following:
Vertical Alignment: Match Invert
Minimum Depth: 0.000
Maximum Depth: 4.000

M Node Configuration - Elevations JESSEER
Window Center
Made D EWV-1 - Ol 4
ode D 4 | | Y S % e & [y
Details
Ciptions | Reference Surface: | TIM File - i-ﬁnal.t!q -| Q,
E;f![;te_ﬂi&ﬂ Blevation Source: |Reference TIN ~| 850412
cation
Spread Criteria Node Elevation Option: [ Same as Source | 850412
Elevations Vettical Alignment: [ Match Invert =] [0210 |
Junction Loss Mii Decth: | 0.000 | .
Discharge Options |r1?mum o !-ﬁ
Computations | Maximum Depth: I“_PPD_|

NOTE: This is a preliminary location used to determine outlet elevation, etc. This node
will need to be adjusted to account for the side slope, endwall, velocity, and the final
pipe size which is designed.
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B View 1, Default (= <=

E-aw-|AQ FEIEEIEEE

d) Click the Apply button to include this node in the Drainage Project.
5.31 Inlet Bypass
Set the Inlet bypass as required to bypass flow to the downstream inlets.

a) Select Component > Node > Edit or choose from the Tool Box and use the drop-down

menu to select CB-1. —r
i
4 DRAINAGE - DrainageProject.gdf - [No Active Network] | B
| Project | Component | Network Reports  Utilities  Tool Boxes | #| g 1 AddDrainage Node
= R i B 4z |2 EditNode
rea
| ad “W Y"?jﬁ,« 3 Id Edit Drainage Node
ode m ¥
E 7 : | = %J x@' 4  Delete Drainage Node
=n Edlt \A" @ 3 RenameDrainage Node
: 1D i
Prafile r EJI L% 6 Renumber Node
elete
Culvert A [ %5 1 UpdateAll Nodes
Routing BE== $st & Update Nodes with Pay rems
R b
Land HSES e % 9 Drainage Mode Report - Sump
2 .
Miscellaneous Utilities » Update All 55t 0 Drainage Node Report - On Grade
Update with Ea)r Items = Open as ToolBox

&l MNode Configuration - Discharge Options El_lél
i H Window Center
Node ID 4 EW-1 =} ¥ 5 Highight R

- Available Modes -
e
Options CB-2 lomputed Discharge
Properties  |CB-3 £ | jed Discharge:
Location CB-4 = —
Spread Criteri|CB-5 le Inlet Calculations Capacity: | 0.0
Blevations  |CB-6 [ Base Fow frea | |CB-1 v | &

Junction Loss CB-7
Discharge OpCB-8

Computations CB-9
EW-1 =
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b) Properties > Keyin the By Pass to Node as CB-3 or click the ID button and data point
on the node in the plan view.

The Bypass flow from this inlet will then contribute its resulting bypass flow to CB-3.
Click the Apply button to accept the changes.

f ]
;ln‘. Mode Configuration - Properties ‘ L= X
[] Window Center

Node ID 4 [CB-1 . £l "

ode 4 [ ] » [] Highlight " s % iz @
Details
Options Description:
E;operties Mode Type: [Grate -|

cation G =
Spread Criteria Profile: [On Grade | -
Blevations Library tem: [CB#12 4X3 | _
Junction Loss By Pass to Mode: | CB-3
s Teniy Uotore Max By Pass: | 0.000
Computations ;

MNode Bottom: |Mane Available - =
[7] ©vemide Library Payitem: Align

c) Select CB-3, Computations > Review the computations to make sure the spread is still
within the design limits.

M Node Configuration - Computations [o] &
- = ("] Window Center -
Node ID 4 [CB3 ~» B o [ @ % s 4 [ Aeey |
_Details _
Options Discharge = 1.0902

Spread Width from Gutter = 4.1236 €————

E:"f'es Total Ponded Width = 4.1236

e e Ponded Depth = 0.2125
Spread Crteria Spread Left Intercept = 0.0000
Bevations Spread Right Intercept = 4.1236
Junction Loss Grate Length = 3.0210
Discharge Options Grate Width = 1.8130
Computations | - Grate Capacity = 0.9645

ByPass Flow = 0.1258
Efficiency = 0.8846

d) Follow the same procedures to bypass the remaining flow to the inlets as described in
the table below:

Node ID | By Pass to Node Spread Width
Before Bypass After Bypass
CB-2 CB-4 6.0289 7.1331
CB-3 CB-6 5.5181 5.8409
CB-4 CB-9 4.0723 6.1784
CB-6 CB-12 4.8368 5.6188
CB-9 CB-11 1.7590 3.1144
CB-11 CB-13 7.2730 7.5241
CB-12 CB-14 4.8154 5.1393
CB-13 CB-14 5.1393 5.3333
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Exercise 6

6. Storm Drainage Links

This exercise shows the user how to utilize the tools necessary for connecting the
surface drainage (inlets) to the collection system (pipes). The user will design the storm
drainage pipes for this project.

6.1 Link Design

a) Visually determine the tentative location of the first storm drainage pipe. This link will
connect Nodes CB-1 and CB-3.

B View1, Default E=RE=R )

ERIEEE

b) Select from the Drainage Menu Bar: Component > Link > Add or from the main toolbar:
Add Drainage Link:

M DRAINAGE - DrainageProject.gdf - [No Active Network] [ Drainag.. ]
Project | Component | Metwork Reports  Utilities  Tool Boxes B @J
:b L]
Area 5 A)ﬁ’. /| /| L AddDrainage Link
Node * = E &/ 2 EditLink
Link b Add.. Y’$’ %" 3 1dEdit Drainage Link
Profil ' Edit %jx’ >}’ 4 Delete Drainage Link
rofile = .
- i) o - / 5 Rename Drainage Link
- - 1
i
E'-"V'j‘-"t k Delete —— &/ 5 UpdsteAllLinks
BDLItII"Ig L ﬂename % 1 Update Links with Pay Items
Land Uses Undate Al B/CF & Drainage Link Report - Configuration
= Update B
Miscellanecus Utilities 3 . % 9 Drainage Link Report - Computations
= Update with Pay ltems

=3 Openas ToolBox
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c) Inthe New Link window that appears, click OK to set the name SS-1

i 5

Add a Mew Link

Link 1D: | 55-1

0K ] | Cancel

. -

d) Definition > This dialog sets the pipe configuration including: From Node, To Node,
Shape, Material, Library Item, etc.

There are two ways to set the Nodes: from the dropdown list or graphically selecting the
Nodes. Graphically is recommended to ensure the correct pipe connection points are
utilized. See note concerning these on the next page.

To select graphically click the ID button for each and identify the correct Node. SS-
1 traverses From Node CB-1 to Node CB-3:

I\ o = e
e = = [”] Window Center [T hook !
Link ID: 4 [SS-1 I » 7] Highight Y /¥ o |ihephi
Details
Options Description: _
Definition | From Node: (CB-1 v) () To Node: [CB2 -1(®
\Conditions Length: 216.0000 "] Use MS Bement [

Constraints Configuration

(Computation | Shape: Material:
Type [V] Design Size  Size: None Select... |
© Pipe [ Design Bamels Number of Bamels: (1 v] Roughness:  0.012
© Dich || Ovenide Library Payitem:
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Exercise 6

NOTE: All drainage nodes include pipe connection points on the structures (for circular
structures there are NOT single points but an entire circle for connection). When a
drainage node is identified for connection it will use the nearest face to the identification
Data Point. Therefore it is important to Zoom in close enough to drainage nodes
and identify them at the correct connection point of the structure. Correct and
Incorrect examples are shown below.

INCORRECT CORRECT
__ ) g e ——

The symbolization for drop inlets display the full extent of the sub-structure as opposed
to the normal smaller symbol used for curb and gutter inlets. This is done so that the
designer can ensure adequate R.O.W. or easement is provided. For this reason you will
not see the pipe connection points for these structures since they coincide with the
structure wall as shown below.

e) Set the remaining Link Configurations as follows:

Shape: Circular

Material: Concrete

Design Size: Toggle ON

Design Barrels: Toggle OFF

Number of Barrels: 1

Roughness: Automatically set based on the selected Material

NOTES:
Multiple barrels could be designed, if required, by toggling Design Barrels ON or
setting Number of Barrels to the determined number.

If the link size is known, it may be input by toggling Design Size OFF and clicking on
the Select... button.
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& Link Configuration Definition o] @ |3
-
Link ID: 4 [S5-1 -] » E:;;;:;;ffamer v ¥ 7
Details
) Description:
S;:-;:n From Node: [CB-1 v | %5 To Node: [CB-3 - |
Conditions Length: 216.0000 [ Use MS Blemert [y
Constraints Configuration
Computation Shape: |Circular = | Materal: [Concrete -
Type Design Size Size: MNone Select...
@ Fipe [] Design Bamels Number of Bamels: [1 =] Roughness: | 0.012
© Ditch [] Owenide Library Payitem:

f) Conditions > The elevations shown are based on the Node Elevation minus the
min/max depth. These depths were specified in the Node Definition (See Exercise 5)
Dialog Box for Nodes CB-1 (From Node) and CB-3 (To Node) respectively. In this case,
no entries are necessary and GEOPAK Drainage will design all the profiles for this

project.

“ Link Configuration Conditions — X ‘
Link ID: 4 [S5-1 S % L"‘i'ig"h‘i‘;""mceme" v /LW 7 Aol
Details
- Profile Conditions
Opl.lo.r.ls From Node Slope To Node
Definition ) . —— -

Conditions Min Cover:  877.796 2429 872451
Constraints Soffit: 77796 [] 2474 O 872451 []
Computation Invert: 876296 [] 870951 [
Type Max Depth: 860.196 2.507 854.681
(@) Pipe
() Ditch
From Node: CB-1 To ode: CB-3

(* Min Corer I I —

1\
) | Allotted Pipe “Envelope” I
[ Max Diepth J ¢

NOTE: When manually defining Invert elevations for links, make sure the drop across a
structure is accounted for. In other words, if you were to define the Invert elevations for
Links SS-1 and SS-3 at CB-3, then make sure the From Node Invert elevation for Link
SS-3is at least the minimum drop lower than the To Node Invert elevation for Link SS-1.

6-4 Storm Drainage Links GEOPAK Drainage V8i (SELECT Series 2)



Exercise 6

g) Constraints > Establish the min/max design criteria for Links as follows:
Rise Min/Max: 1.5/ 4.0 (feet)
Slope Min/Max: 0.50 / 11.00 (%)
Velocity Min/Max: 3.00 / 12.00 (fps)

p e ————————————
ﬂ Link Configuration Constraints

==
Link ID: 4 551 >l » Eﬁ;”h‘fi‘;;&mer ¥ L
Details
: Design Constraints
DEEF;TS—l Minimurm Mazdimum
inition x| |
Conditions ke 15[“] ! 4&'}”
Constraints Slope: | 0.500 | [11.000
Computation Velocity: | 3.000 | |12.000
Type
i@ Pipe
|'::'- Ditch

h) Computations > Displays the computed hydraulic properties of the Link.

~ T R = =
: Window Center
Link 1D 55-1 - ] + "
=D 1 I ¥ bighight 7 LE L
Details
Q_PTE"'S—| Link is not cumrenthy part of a netwark
Definition Computations Unavailable - Perform Network Computations
Conditions
Constraints
Computation
Type
i@ Fipe
(™1 Ditch

NOTE: Link hydraulics are not available for review until a Network has been
established and designed or analyzed successfully (See Exercise 8). Check back
here for computations after the Network has been added and designed or analyzed.

i) Click the Apply button to include this Link in the drainage project.
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]) Add the remainder of the link conveyance system using Component > Link > Add from
the Drainage Menu Bar or by clicking the Add Link button as shown below.

rﬁ. Link Configuration Computations l = | |ﬁr

3 | Window Center A
Link; 1D 55-1 - * L,
k1D 4 | b | Highlight 4 7 7

Details

Options Link iz not cumertly part of a network
Definition Computations Unavailable - Peform Network Computations

Conditions
Constraints
Computation

Type

@ Pipe
Ditch

L

As Links are added, most dialog values default from the previous Link with the
exception of From Node and To Node. Add Links between all of the following Nodes:

Link SS-2 Traverses From Node CB-2 To Node CB-4

Link SS-3 Traverses From Node CB-3 To Node CB-6

Link SS-4 Traverses From Node CB-4 To Node CB-9

Link SS-5 Traverses From Node CB-5 To Node CB-2

Link SS-6 Traverses From Node CB-6 To Node CB-12

Link SS-7 Traverses From Node CB-7 To Node CB-3

Link SS-8 Traverses From Node CB-8 To Node CB-6

Link SS-9 Traverses From Node CB-9 To Node CB-11

Link SS-10 Traverses From Node CB-10 To Node CB-9
Link SS-11 Traverses From Node CB-11 To Node CB-13
**Link SS-12 Traverses From Node CB-12 To Node CB-14**
**| ink SS-13 Traverses From Node CB-13 To Node MH-1**
Link SS-14 Traverses From Node CB-14 To Node MH-1

Link SS-MH1 Traverses From Node MH-1 To Node EW-1
** See notes on next page **
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6.2 Curved Links

Exercise 6

a) Use MicroStation’s Place Arc Tool and use the settings ‘Method: Start, Mid,
End’ to draw a curved element (must be a continuous line string) between the
nodes and following the middle of the gutter to the extent possible.

NOTE: Make sure the ends of the MicroStation Element terminate at the correct

attachment point on the catch basin.

b) Inthe Link Configuration Definition dialog toggle ON Use MS Element.

c) Click the Select Element button then Data Point on the element created in Step a). Then

click Apply.
M Link Configuration Definition I. S i?_J
: Window Center
Link ID: 4 [55-12 - » Highiiht vV S ¥ 7
Details
Options Description:
Defirition From Node: [CB-12 | %W ToNode: [CB-14 - |
Condtions Length: 190.9924 7] Use MS Element [ 1]
Constraints Configuration
Computation Shape: |Circular  w| Materal: [Concrete | Select Element
Type | Design Size Size:  Mone
@ Fipe Design Bamels  Mumber of Bamels: |1 »| Roughness: | 0.012
Ditch

Cwvemide Library Payitem:

Default

Br-adu-ARQREHY O BEHLR

[E=5 el

Link SS-13 is created in the same manner, from CB-13 to MH1

NOTE: Be sure to toggle Use MS Element OFF for subsequent Links that are not
curved. When used, the Link position and length are defined by the MS Element.
Caution must be used in order to properly define the Link.
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6.3 Storm Drainage Network Design

a) Select the Add Drainage Network tool or select Network > Add from the main drainage

menu bar.
Bl DRAINAGE - DrainageProject.gdf - [Mo Active Network] | 28 |
‘ Project Component | Network | Reports  Utilities Tool Boxes |
Add...
Edit
= == }f: E 1 Add Drainage Network
eais Y’-f’% 2 Edit Drainage Network
“ it Drainage orl
Rename b !
= %] x ?g 3 Delete Drainage Network
Dezign -iﬁ': & nﬁbf: 4 Rename Drainage Network
-'lmal}-gr: - y}f: 5 Design Metwork
Active Metwork P 6 Analyze Network
@:: 7 Set Active Metwork
=

Open as ToolBox

b) Inthe Add a New Network dialog, enter the following information:

Network ID: WEST
Outlet Node: EW-1

M Add a New Net.. (B=m|n=h

Network ID: | WEST
Description:
Outlet Node: [EW-1 - |

NOTE: The Outlet Node may be selected via the dropdown or by clicking ID Outlet and
selecting the Node in the plan view.

c) Click OK in the Add a New Network dialog box.

rﬂ Metwork Configuration - [No Active Metwork] | = | | 28 .|-\
Network ID: 4 [WEST -] » ¥ % W o [ Aeet |
Dietails
Description: Outlet Node: [EW-1 | %
Validation Computations [ - ] [ Uriock Sizes ]
T}’; BE:; j}f; P}'j l Lock Elevations ] ll_lnluck Elevatiuns]
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Exercise 6

d) Click the Build Network button. This feature verifies the nodes and link connectivity.

M Network Configuration - [No Active Netwark] ElEET
Network ID: 4 [WEST | » ¥R W
Dietails

Description: | Outlet Node: [EW—'I V] i
Validation Computations [ - ] [ Unlock Sizes ]
T}j: -Ei f}i p}j: [ Lock Elevations ] [Unluck Ele'u'atiuns]
Build Metwork
Click OK.

s Metwork WEST Successfully Built
1 Total Mode in Metwork = 16
Total Links in Metwork = 15

¥ e .

e) Click the Highlight Network feature. This Feature highlights all components (areas,

inlets, pipes, etc.) connected to the active Network.

ﬂ MNetwerk Configuration - [Nc: Active Network] u_u

Network ID: 4 |WEST | p TR ¥ ¥ -
Details
Description: Outlet Node: [EW-1 |
Validation Computations [ T ] [ Temr— ]

TS | B G PE

[ Lock Elevations ] [Unlud{ Elevatiuns]

Highlight Metwork
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f) Verify that all network components are highlighted.

g) Click the Apply button. Network “WEST” has been added to the project.

h) Click the Design button. This command initiates the hydraulic design of the components
contained in the Network.

.~ oy

M Network Configuration - [No Active Network] l = | |—&
MNetwork ID: 4 {WEST v p» ¥ X% ¥ oF | Aeely |
Details

Description: Outlet Node: [EW-1 | &

Validati Computati 1 ]

i T | Lock Sizes || Unlock Sizes |

Dﬁ.; }j: ‘:;}i p}f; | Lock Elevations | | Unlock Blevations |
Design Metwork

6-10 Storm Drainage Links GEOPAK Drainage V8i (SELECT Series 2)



Exercise 6

Click OK.

i = = 2 |

. Metwork WEST Hydraulics Computed With Warnings
.1 J) Total Node in Network = 16
Total Links in Metwork = 15

i) Review errors to determine steps needed to correct and close the text editor. (See
Appendix C for common errors and fixes)

M Test Editor: C:\Projects\Drainage\drgmsg.bet — O >
File Edit Criteria

hed & = €%

Link 55-8 welocity less than minimim desired

ICapacity for Inlet CB-1l4 Exceeded Bypass Flow Unassigned
iLink 55-MH]1 welocity greater than maximum desired

| IIJne: 3 [Cul: 1
Network ID: 4 {WEST M B ¥ % W o [ Aesy |
Details

Description: . Outlet Mode: [EW—'I V] i
Walidation Computations [ e ] [ Uniock Sizes ]
TBF; “F; f}i pﬂﬁ: [ Lock Elevations ] [Un]nck Ele'u'atinns]

NOTES:
Pressing Design or Analyze should be the last step in Designing or Analyzing the

Network.

Design performs hydraulic design of the network and designs components of the
network as indicated by the ‘design toggles’. Analyze performs hydraulic analysis of the
network as is and ignores all ‘design toggles’.
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Lock and Unlock buttons allow the user to lock or unlock all components in a network
at the given Size or Elevation. Caution must be used when selecting Unlock as this
action will unlock ALL Sizes or Elevations, including ones that should not have been
unlocked.

After Design or Analyze has been utilized, computation values are shown in each link
configuration of the network which can be reviewed in the Link Configuration edit dialog.
Other methods of reviewing this data will be discussed in Exercise 10, Drainage

Navigator.
# Link Configuration Computations — x
. Window Center
Link 1D 55-1 - [l + ”
R [] Highlight Y SF s | ey
Dietailz
Options Flow is supercritical ”
Definition Discharge =  1.580
Conditions %‘apacitﬁ EDDH-?H
. ise= 1.
Ennst[:gtrt.s Foughness = 0.013
tutol L Slope = 2.474
Type Friction Slope = 2470
@ Fipe Crtical Slope = 0.493 W
() Ditch
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Exercise 7

7. Ditch Nodes and Links

This exercise shows the user how to utilize the tools for nodes and links for ditch
analysis. We will investigate the drainage flow along a fill slope with these settings and
in a later chapter define a special ditch to manage it.

7.1 Ditch Node Design DIT-1

Begin Ditch
a) Visually determine the tentative location of the beginning of the ditch. In this case a
ditch is created along the south side of the roadway by the new fill slopes.

b) Select from the Drainage Menu Bar: Component > Node > Add or from the main
toolbar: Add Drainage Node.

c) Inthe New Node window that appears, set the name DIT-1 and click OK.

Add a New Node

Mode ID: | DIT-1

Description:

QK ] | Cancel
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d) Properties > Set Node Type to Other and Library Item to Ditch Begin.

.I-( Node Configuration - Properties | = | |ﬂh‘
] ; Window Center
Node 10:_4| IDiT=1 vl b|  fnewCener uf sl %] | 4] [Laeey |
Details
Options Description:
Properties Mode Type: |Other x|
Location e | On Grade -
Spread Criteria Profile: |On Grade
Elevations Library ltem: |Ditch Beagin - |

Junction Loss
Discharge Options
Computations
Mode Bottom: |None Available i

Alig
Owverride Library Payitem: E 21

e) Location > All settings should have carried over from the last Node input. Review and
make the following changes:

Station: 8+50.00
Offset: 32.50
+Angle: 0.00

M Node Configuration - Location | = o S
Node 1D:_4) [DIT=1 v] | ) WindowCenter oo ol sel w| | [ Apply |

Highlight

Details

Options /| chain /] Profile:
Properties Coordinates / Stationing

Location

Align: |Tanger1ttoChain x| ﬁ + Angle: | 0.000

Spread Criteria

Elevations Station: | 8+50.00 X 3411793
Junction Loss ;

) . + | Offzet | 32.500 Y. 3072.864
Discharge Options
Computations Mirror Node Offzet from Gutter to Inlet: | 0.000

This will approximate the beginning of the ditch as shown below:
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Exercise 7

NOTE: The Spread Criteria configuration is not required for Other node types such as
are used by ditches.

f) Elevations > All settings should have carried over from the last Node input. Review and
make the following changes:

Vertical Alignment: Match Invert
Minimum Depth: 0.00
Maximum Depth: 0.00

M Node Configuration - Elevations l = | ‘ﬁ‘
Window Center
Node ID: 4] [DIT=1 ] EH' o el sl %] el 4l
Iighhig
Details
Options Reference Surface: |TIMN File - | | finaltin ﬂ
F’rope.rtie.s Elevation Source: [F{eferenoe TIN '] B870.257
Location
Spread Criteria Mode Elevation Option: [Same as Source '] 870.257
Eleva.tions Vertical Alignment: [Mat{:h Invert '] 0.210
Junction Loss o
Discharge Options Minimum Depth: | 0.000
Computations Maximum Depth: | 0.000
[] Add Sump Depth: | 0.000

g) Discharge Options > Leave Use Computed Discharge selected and click Apply to
save all settings.

M Node Configuration - Discharge Options l = | ‘i&‘

Window Cent

Node 1D: 4 [DIT-1 ] E e el O] | 4

Details

Options -.Q.' Use Computed Discharge

Properties (") Supplied Discharge: | 0.000

Location

Spread Criteria I:‘ Disable Inlet Calculations Capacity: | 0.0000

Elevations I:‘ Link Base Flow Area | [CB-1 - ﬂ

Junction Loss
Discharge Options
Computations

NOTE: For short ditches where only a single drainage area is utilized, the Link Base
Flow Area option should be toggled ON and set to add the discharge for that area. It is
then toggled off at the ditch outlet. If this is not toggled OFF at other nodes beyond the

beginning, the discharge will accumulate at each node and not accurately represent the
area’s discharge.
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7.2 Delineate Drainage Area DIT-1

Begin Ditch Drainage Area
a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name DIT-1 should automatically appear, click OK.
b) Follow the steps in Exercise 4.1 to delineate and define the drainage area for the begin
ditch location. (You may use the following images as reference points. It is ok if your
numbers do not match exactly.) Attach reference file DA_DIT-1. You may want
to turn off the level SURVEY — DRAINAGE — Area Shapes to see the ditch easier.

Delineate Drainage Area:

NOTE: The drainage area should be broken into sections for long ditches, however, for
short ditches; determine the area from the most downstream point (i.e. the stream
outlet).

c) Define Drainage Area:

&4 Drainage Area Definition =R @
Window Center

Area |D: DIT-1 - :

210: 4| ¥ bighight R
Details
Options Description: Ta Node 1D: - DIT-1 Jfg
Definition = :
- Drainage Area: | 0216 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ Sk ‘ e

Time of Cone.: | 5.000 = =
Hydro. Method Fick Boundary DP
@ Rational Elements Create Shape
SCS

7-4 Ditch Nodes and Links GEOPAK Drainage V8i (SELECT Series 2)



Exercise 7

d) Calculate Time of Concentration:

M Time of Concentration o @ ==
Details
Drainage Area ID: DIT-1 Distance Slope  Avg. Slope Flow -
TIN Fie ) | final tin Q 1905 254 254  Sheet |
1803 234 244 Sheet =|| O
Define Path 1457 279 254  Sheet
1390 347 273 Sheet %
5 St o o5 I o
Method: (FHA Length: | 300.000 : - ¥
[HA_v)  Lengh 1116 232 264  Sheet &
n Value: | 0.400 Slope: | 2.034 21.01 2135 260 Sheet
— 8.78 203 257  Sheet
L _ 2347 166 245  Sheet
Length: | 100.000 1256 157 239  Sheet
inter. K: | 0.491 Slope: | 1593 19.71 198 235  Sheet
8.97 119 231  Sheet ~

[v| Concentrated How Diace: Slope:
Method: [Continuty ¥] Length: | 225.554 ' pa:

19.050 2540
Velocity: | 5.000
Max Sheet Flow Distance: /°300.000
Accum. Distance: 625.554 B Max Shallow Flow Distance: \100.000
Accum. Avg. Slope: 2477

(Ganpue] (LFosh

Make settings as shown for Max Sheet Flow and Max Shallow Flow. We will use
these settings for all the ditch areas.

The calculated Time of Concentration is GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will automatically be filled in after hitting Apply with
NO further steps required

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas EI =] @
) 3 = [7] Window Center
Area ID: 4 [DIT-1 | » 0 Highlght %l tH
Details
Options To Node ID:  DIT-1 Gy
Definttion Subarea C Value Description
Putomati
Enhirns 02164 0300 Forested Areas
Computation |
Display Only
Hydra. Method ¢
i@ Rational
~ 5CS
0.216 0.300 Forested Areas
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f) Compute Discharge and Apply:

#4 Drainage Area Computations EI [=] @
Window Center

Area D: DIT-1 - ;

2D 4 | L= et IR .
Detail=
Options Area C Value Compute
Definiti -
i Total Subareas: 0.216 0.300 Discharge
Computation Remainder: 0.000 0.350

Hydro. Method Composite: 0.216 0.300

@ Rational Computed Intensity: 3.215

SCS Computed Discharge: 0209

7.3 Ditch Node Design DIT-2

a) Visually determine the location of any major ditch change; such as a change in
horizontal or vertical alignment or a change in cross section.

In this initial set up we are analyzing the flow along the fill slope and will set them as
shown.

)

L= S

b) Select from the Drainage Menu Bar: Component > Node > Add or from the main
toolbar: Add Drainage Node.

¢) Inthe New Node window that appears, set the name DIT-2 and click OK.
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Exercise 7

d) Properties > Set Node Type to Other and Library Item to Ditch Change.

M Node Configuration - Properties l = | th
Window Center

Node 1D 4] [DIT2 v »l E Highiight Jal el % Wl 4l
Details
Options Description:
Properties MNode Type: [DH1er ']
Location . : -
Spread Criteria Profile: | On Grade
Elevations Library ltem: [Ditch Change ~ ]
Junction Loss
Discharge Options
Computations

MNode Bottorn: |None Available hd

Al
|:| Cwerride Library Payitern: E EE

e) Location > All settings should have carried over from DIT-1. Review and make the
following changes (estimated change locations):

Station: 9+25.00
Offset: 36.00

ﬂ Node Configuration - Location l = | Hh]
Noder0: 4| rE2 7] b [ eowCene ) 5] 4] ) 4
Details
Options [¥] Chain: [¥] Profile:
Properties Coordinates / Stationing
Location

Align: [TangenttoChain '] ﬁ + Angle: | 0.000

Spread Criteria
Elevaticns Station: | 9+25.00 X 3484798
Junction Loss $

Offset. | 36.000 Y. 3055.330
Discharge Options
Computations l:' Mirror Node Offset from Gutter to Inlet: | 0.000

f) Click Apply.

GEOPAK Drainage V8i (SELECT Series 2) Ditch Nodes and Links 7-7



7.4 Delineate Drainage Area DIT-2

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name DIT-2 should automatically appear, click OK.

b) Follow the steps in Exercise 4.1 to delineate and define the drainage area for this ditch
change location. Attach reference file DA _DIT-2 and turn off DA_DIT-1.

Delineate Drainage Area:

c) Define Drainage Area:

2 Drainage Area Definition == =] @
Window Center

Area |D: DIT-2 - ;

210: 4| ¥ bighigh & DB &
Details
Options Description: To Mode ID: DIT-2 ﬁf‘éj‘
Definition : :
- Drainage Area: | 0614 Area Selection / Creation
Computation Base C Value: | 0.350 ‘ Ead ‘ T

Time of Conc.: | 5.000 __ __
Hydra. Method T Pick Boundary CP
@ FRational Blements Create Shape
SCS
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Exercise 7

d) Calculate Time of Concentration:

’K Time of Concentration | o | & | ‘

Drainage Area ID: DIT-2
TIN File || final tin Q,

Define Path
Trace 10 The calculated Time of Concentration is

, GREATER than the minimum of 5 minutes;

o (s herefore the Time of Concentration will

Method: [FHA__¥]  Length: | 300.000 therefore the Time of Concentration wi .

automatically be filled in after hitting Apply with

n Value: | 0.400 Slope: | 1.363 .
NO further steps required
[V Shallow Aow
Length: | 100.000
Inter. K: | 0.491 Slope: | 1.573

|V Concentrated How
Method: Continuity v] Length: | 296.435
Velocity: | 5.000

Accum. Distance: 696.435 i-->-|
Accum. Avg. Slope: 2.566 —J

(o) o)

e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas EI [=] @
Window Center
Area |D: DIT-2 - I
210: 4 | I ¥ tighign 9 @ W & [ ey ]
Details
Options To Node ID:  DIT-2 St
Definition Subarea C Value Description
Automati
Subareas 0.6132 0.300 Forested Areas
Computation &1
Display Only
Hydro. Method ¥
i@ Rational
@ SC5
0613 0.300 Forested Areas
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f) Compute Discharge and Apply:

#4 Drainage Area Computations = =] @
Window Center

Area D: DIT-2 -

2D 4 | L= et IR .
Details
Options Area C Value Compute
Definiti -
i Total Subareas: 0613 0.300 ‘ Discharge ‘
Computation Remainder: 0.001 0.350

Hydro. Method Composite: 0.614 0.300

@ Rational Computed Intensity:  3.150

SCS Computed Discharge: 0.588

7.5 Ditch Node Design DIT-3

Repeat previous steps on pages 7-7 & 7-8 creating ditch change Node DIT-3 at
Station: 10+90.00 and Offset: 34.00. All other information should remain unchanged.

7.6 Delineate Drainage Area DIT-3

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name DIT-3 should automatically appear, click OK.

b) Follow the steps in Exercise 4.1 to delineate and define the drainage area for this ditch
change location.

Delineate Drainage Area:

Begin Trace
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c) Define Drainage Area:

Exercise 7

ﬂ Drainage Area Definition

=]

AreaID: 4 [DIT3

Details
Options Description:
Definition
Suhareas Drainage Area: | 0.875
Computation Base C Value: | 0.350
Time of Conc.: | 5.000
@ Rational
@ 5C5

E=R(EcR*>x=
[T] Window Certer
[] Highlight &l &] &l
To Node ID: DIT-3 S
Area Selection / Creation
Select Create
Shape DTM Shape
Pick Boundary DF
Elements Create Shape

d) Calculate Time of Concentration:

M Time of Concentration | o | @ [23]
Drainage Area ID: DIT-3
final tin Q
Define Path
v
|V Sheet How
Method: [FHA =] Length: | 300.000
n Value: | 0.400 Slope:  3.363
|v Shallow How
Length: | 100.000
Inter. K: | 0.491 Slope: | 2.536
|V Concentrated How
Method: (Continuty w] Length:  107.199
Velocity: | 5.000
Accum. Distance: 507.199
Accum. Avg. Slope: 2.779
(Compts ] (7o ]

The calculated Time of Concentration is
GREATER than the minimum of 5 minutes;
therefore the Time of Concentration will
automatically be filled in after hitting Apply with
NO further steps required

GEOPAK Drainage V8i (SELECT Series 2)
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e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas E" (=] '@
pveaD: 4 [DIT3 -] » [] Window Certer & A B &
[ Highlight
Details
Options To Node ID:  DIT-3 St
Definition Subarea C Value Description
Automati
Subareas 0.8684 0.300 Forested Areas
Computation &1
Display Onby

Hydro. Method 4

i@ Rational

i SC5

(0.863 0.300 Forested Areas

f) Compute Discharge and Apply:

M Drainage Area Computations | B |3
ArealD: 4 [DIT3 -] » [] Window Center & @ W &
[] Highlight

Detail=
Optiong Area C Value Compie
Definiti i
S Total Subareas: 0.868 0.300 Discharge
Computation Remainder: 0.010 0.350

Hydro. Method Composite:  0.879 0.301

(@ Rational Computed Intensity:  3.536

) 5635 Computed Discharge: 05934
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Exercise 7

7.7 Ditch Node Design DIT-4

a) Visually determine the location of the ditch outlet.

b) Select from the Drainage Menu Bar: Component > Node > Add or from the main
toolbar: Add Drainage Node.

c) Inthe New Node window that appears, set the name DIT-4 and click OK.

d) Properties > Set Node Type to Outlet, Library Item to Ditch Outlet and Fix Tailwater
at Critical Depth

M Node Configuration - Properties | = | ‘-&I
Window Center
Node ID-_4] [DiT4 > Hiolioht el e % e 4
ighlig
Details
Options Diescription:
Froperties Nede Type: |Qutlet = |
Location ) P -
Spread Criteria Profile: | On Grade
Elevaticns Library ltem: |Dit|:h Outlet - |
Junction Loss Q@) Fix Tailwater at | Critical Depth > |

Discharge Options

Computations

Tailwater Elevation: | 0.000
Mode Bottomn: |Mone Available i

Alig
Cwerride Library Payitem: E Ea
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e) Location > All settings should have carried over from DIT-3. Review and make the
following changes:

Station: 13+15.00
Offset: 58.00

,'4 Mode Configuration - Location | = ‘-53—‘
NodeID:ﬂ [DIT-4 ¥ ﬂ L‘u;i;:“o;t[?enter E ﬁ ﬁ ﬁ ﬂ
Details
Options ¥ | Chain: | Profile: |W|
F’rope.rtie.s Coordinates / Stationing
;ET:::TIHHE Align: |TangenttoChain v| ﬁ + Angle: | 0.000
Elewa.tions Station: | 13+15.00 ﬂ X 3872012
Junction Loss /| Offset | 58.000 Y. 2967.172
Discharge Options
Computations Mirror Node Offset from Gutter to Inlet: | 0.000

f) All other options should be set from previous nodes, click Apply.

7.8 Delineate Drainage Area DIT-4

a) From the Node Configuration dialog select Edit Area. When asked if you want to create
a new drainage area click Yes. The name DIT-4 should automatically appear, click OK.

b) Follow the steps in Exercise 4.1 to delineate and define the drainage area for this ditch
outlet location.

Delineate Drainage Area:

Begin Trace
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Exercise 7

c) Define Drainage Area:

ﬂ Drainage Area Definition E =] @
Window Center
Area |D: DIT-4 - [l
=10: 4| J ¥ 5 vighigh & @B & [ ey ]
Details
Options Description: To Mode ID:  DIT-4 4_1%1'
Definition 3 3
- Drainage Area: | 0.779 Area Selection / Creation
Computation Base C Valus: | 0.350 ‘ gﬁ'&d ‘ DTErrﬂegthe
Time of Conc.: | 28.547 _ ___

Hydro. Method Pick Boundary DP

i@ Rational Elements Create Shape

i SCS

d) Calculate Time of Concentration:

M Time of Concentration | = | & [stds]

|

Drainage Area ID: DIT-4
final tin Q
Define Path

[0 The calculated Time of Concentration is

GREATER than the minimum of 5 minutes;

[V Sheet How therefore the Time of Concentration will
Method: (FHA v Length: | 300.000 automatically be filled in after hitting Apply with
n Value: | 0.400 Slope: | 3.628 NO further steps required
|V Shallow Aow
Length: | 100.000
Inter. K: | 0.491 Slope: | 4.372

|V Concentrated How
Method: (Continuity v| Length:  146.165
Velocity: | 5.000

Accum. Distance: 546.165
Accum. Avg. Slope:  4.840

G 750 [Conpute] ooy ]
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e) Delineate Subareas utilizing the Land Use DGN:

ﬂ Drainage Area Subareas E\ [=] @
ArealD: 4 [DIT4 <] » [] Window Certer RO
[7] Highlight
Details
Options To Mode ID:  DIT-4 St
Definttion Subarea C Value Description
Automati
Subareas 0.1032 0.400 Turf Meadows
Computation 06249 0.300 Forested Areas @
Display Onby

Hydra. Method 4

@ Rational

i 5CS

0.625 0.300 Forested Areas

f) Compute Discharge and Apply:

“ Drainage Area Computations E\ [=] @
Window Center
Area|D: 4 [DIT4 = O
=2 » 5 Hichiight 4@ & W & | ey

Details

Options Prea C Walue Compute
Diefiniti :
S boron et e i 0314 Discharge
Computation Remainder:  0.051 0.350

Hydro. Method Composite:  0.779 0317

@ Rational Computed Intensity: 3612

0 sCs Computed Discharge: 0.850

g) Since Node DIT-4 is an outlet type, it will not consider the drainage area developed for

it. In order to ensure the final ditch link, will be adequate for the capacity at the end we
will need to link the DIT-4 drainage area to Node DIT-3.

Go to Component> Node> Edit and select node DIT-3. Under Discharge Options
click on the option to Link Base Flow Area and set to include the DIT-4 drainage area.

# Node Configuration - Discharge Options E‘_‘é]
Window Center
Node 1D 4| D=3 ) » EH. o Sl el %] | 4l
ighlig
Details
Options @ Use Computed Discharge
Properties (") Supplied Discharge: 3.500
Location
Spread Criteria [ Disable Inlet Calculations ~ Capacity: | 0.0000
Elevations | Link Base Flow Area ~ | [oma ~ ] %l
Junction Loss

Discharge Options

Computations

7-16 Ditch Nodes and Links GEOPAK Drainage V8i (SELECT Series 2)



Exercise 7

7.9 Ditch Link DIT-1

We are checking the drainage flow along a fill slope so all links are set up as cross
section based. The surface is read for the ditch shape and capacity is calculated at
each cross section that is cut along the links.

Cross Section Based Link DIT-1

a) Select from the Drainage Menu Bar: Component > Link > Add or from the main toolbar:
Add Drainage Link

b) Set the Name to DIT-1 and click OK.

c) Setthe From Node as DIT-1 and the To Node as DIT-2 via the dropdown list or by
clicking the Node ID button and selecting the appropriate node.

d) In the Details portion of the dialog change Type to Ditch.
e) In the Configuration portion of the dialog set the following:

Ditch Type: Cross Section Based

Roughness: 0.027 (See TDOT Drainage Manual Chapter 5 Table
5A-1 for typical values)
Number of Cross Sections: 5 (Typically one cross section every
5 feet to a maximum of every 50 feet for long
ditches)
Width of Cross Sections: 100 (Ensure top of bank on both sides
is captured)

M Link Configuration Definition |L‘ﬁ
i v Window Center [
Link ID: _4] {DIT-1 > » 4 .
in _I f _I Highlight ll ﬂ ﬂ ﬂ Apply

Details
[ Options Description: :
Definition From Node: |DIT-1 ¥ | %8| ToNode: DIT-2 v) %
Conditions Length: 75.0816 Use MS Element fl)
Constraints Configuration )
| Computation Ditch Type: |Cross SectionBased ~| Roughness: 0.027

Type Number Of Cross Sections: | 5

Pipe Width Of Cross Sections: | 100.0000
@Dihch

f) Click Apply and review the cross section lines displayed in the plan view (shown on next
page) to determine if adjustments should be made.
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NOTES:

Since we are using the Cross Section Based ditch type to analyze existing conditions,
the Conditions and Constraints require no special settings. In the system modification
chapter, we will use those to control the proposed ditch that is to be designed.

Computation will not show any information until a drainage network is built from the
nodes and links in this ditch system.

This same set up using the Cross Section Based ditch type can be used to analyze
long proposed roadway ditches for capacity and function.
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Exercise 7

7.10 Ditch Link DIT-2
Cross Section Based Link DIT-2

a) Select from the Drainage Menu Bar: Component > Link > Add or from the main toolbar:
Add Drainage Link

b) Setthe Name to DIT-2 and click OK.

c) Setthe From Node as DIT-2 and the To Node as DIT-3 via the dropdown list or by
clicking the Node ID button and selecting the appropriate node.

d) In the Details portion of the dialog change Type to Ditch.
e) In the Configuration portion of the dialog set the following:

Ditch Type: Cross Section Based

Roughness: 0.027 (See TDOT Drainage Manual Chapter 5 Table 5A-1 for typical
values)
Number of Cross Sections: 10 (Typically one cross section every
5 feet to a maximum of every 50 feet for long ditches)
Width of Cross Sections: 100 (Ensure top of bank on both sides is captured)

#M Link Configuration Definition =1 Iﬁ

) f Window Center [ 1

Link1D: _4| [Dim=2 ~| » o Y 2 ¥ 2 | ey
ighlig \ J

Details

Options Description: ' : ' }

Definition From Node: [DIT-2 v ] %8| ToNode: [DIT-3 v ] gl

Cenditions Length: 1650121 Use MS Element 11

Constraints Configuration

Computation Ditch Type: |Cross Section Based | Roughness: 0027

Type Number Of Cross Sections: | 10
Pipe Width Of Cross Sections: | 100.0000
itch

f) Click Apply.
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7.11 Ditch Link DIT-3

Cross Section Based Link DIT-3

a) Select from the Drainage Menu Bar: Component > Link > Add or from the main toolbar:
Add Drainage Link

b) Setthe Name to DIT-3 and click OK.

c) Setthe From Node as DIT-3 and the To Node as DIT-4 via the dropdown list or by
clicking the Node ID button and selecting the appropriate node.

d) In the Details portion of the dialog change Type to Ditch.
e) In the Configuration portion of the dialog set the following:
Ditch Type: Cross Section Based

Roughness: 0.027 (See TDOT Drainage Manual Chapter 5 Table
5A-1 for typical values)
Number of Cross Sections: 10 (Typically one cross section every 5 feet to a
maximum of every 50 feet for long ditches)
Width of Cross Sections: 100 (Ensure top of bank on both sides is captured)

M Link Configuration Definition =]
. Window Cent
LinkiD: _4] (D=3 v » et Y A ¥ A
’ Highlight
Details
Opticns Description: ‘ \
Definition From Node: (DIT-3 v ] %8| ToNode: [DiT4 v | ]
Conditions Length: 2324200 Use MS Element 11
Constraints Configuration
Computation Ditch Type: |Cross Section Based * Roughness: | 0.027
Type Number Of Cross Sections: | 10
Pipe Width Of Cross Sections: | 100.0000
itch
f) Click Apply.
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Exercise 8

8. Ditch Networks

This exercise shows the user how to setup a network and perform network
computations.

The Network computations serve as the final calculation process in the design or
analysis of a storm drainage system. A GEOPAK drainage network is defined as a
series of interconnected nodes, links and areas which drain to a single outlet. GEOPAK
drainage accommodates multiple networks in a single drainage project.

8.1 Ditch Network Design

a) Select the Add Drainage Network tool, select Network > Add from the main drainage
menu bar or click the Add Network button in the Network Configuration Dialog.

rﬁ MNetwork Configuration - [Mo Active Metwork] s El_"ﬂ_hjﬁ
Networkc ID: 4 WEST ~[ » ¥ W ¥ | eely
Details M
Description: Outlet Node: [EW-1 x] &
Validation Computations | —— | | TR |
TE }f; ﬁn}i P}f; [ Lock Blevations | [Unluc:k Elevationsl

b) Inthe Add a New Network dialog, enter the following information:

Network ID: WEST DIT
Outlet Node: DIT-4

M Add a New Net.. [50SS5

Metwork [D: | WEST DIT
Description:

Outlet Node: [DIT-4 | &

28R [ cancel |

e —

NOTE: The Outlet Node may be selected via the dropdown or by clicking ID Outlet and
selecting the Node in the plan view.

c) Click OK in the Add a New Network dialog box.
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- TS
M Network Configuration - [No Active Network] [ = !-&l

Network ID: 4 {WEST DIT v » ¥ ¥ ¥ o [ et |
Details
Description: Outlet Node: [DIT-4 v| g
Validation Computations

[ Lock Sizes | Unlock Sizes |
S A . I )
MELR~—

Lock Blevations | [Unlock E-Ie\ratlons.;

L

d) Click the Build Network button. Click OK.
e) Click the Highlight Network feature.
f) Verify that all network components are highlighted.

.
'

NOTE: The drainage area DIT-4 will not be highlighted since it is built for an outlet node
type which does not consider drainage areas. In the previous chapter, we linked that
area to node DIT-3 so that it is covered in this ditch drainage analysis.

g) Click the Apply button. Network “WEST DIT” has been added to the project.
h) Click the Design button, then click OK.

i) Review errors to determine steps needed to correct and close the text editor. (See
Appendix C for common errors and fixes)
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Exercise 8

M Text Editor: ..\drainage\drgmsg.txt l = | (=] |&]
File Edit Criteria
hlldl ¥

hGL Blowout upstream of Link DIT-2 minimum freeboard not achieved

HGL Blowout upstream of Link DIT-3 minimum freeboard not achiewed
Min Depth Exceeded at Downstream of Link DIT-3

| o

| Line: 1 Col: 1

8.2 Ditch Link Review

Now that the ditch network has been built and designed, we can review the computation
results for the existing ditch links in the network.

a) Select the Edit Link tool, select Component> Link> Edit from the main drainage menu
bar or click the Edit Link button in the Network Configuration Dialog.

Set to link DIT-1 and select Computation.

M Link Configuration Computations l = | |ﬁ]
LinkiD: 4] [BIT=1 ] E Lo Eener A A 2
ighlig
Details
Options Discharge= 0226 -
Definition Average Channel Slope= 3043
Conditions Average Uniform Velocity=  1.270 =
Constraints Ngmber of Cross Sgdions =5
Computation Width of Cross Sections = 100.000
B # Distance WSEL EGL Velocity

Type 4 0.000 867.829 867830 0.219

S 3 18770 868309 B6B333 1242
1) Pipe

(@) Ditch

b) Scroll down through the computation results to the data following the Width of Cross
Sections.

This data represents conditions at each cross section drop along the link. Note that
these points start at the end of the link and come back up the link to the beginning.
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The first data group provides the cross section number (0-4 in this case with 5 cross
sections), distance from end, water surface elevation, energy grade line elevation and

velocity.
ﬁ Link Configuration Computations { = | |il7-l
Link ID: j [DIT-1 - ﬂ EL\:Z:IZ:?EHH ﬂ ﬂ ﬁ ﬁ
Details
Options Number of Cross Sections =5 T

Definition Width of Cross Sections = 100.000

Conditions # Distance WSEL EGL Velocity
Constraints 4 0.000 867.829 867.830 0.219 :‘
Computation 3 18.770 868.309 868.333 1.242 e
& 2 37.541 B68.927 868947 1.141
Type 1 56.311 B69.616 869.634 1.078
- 0 75.082 870.036 870.075 1.586 -
L) Pipe
(@) Ditch

c) Scroll down further to review the second data group.

The second data group provides the cross section number, number of slope break
points in cross section, critical depth elevation, and top of water surface width.

M Link Configuration Computations l = | |ﬁ‘
Window Cent
Link1D: 4| (DT ] %H.'"hf:t o AXH
ighlig
Detailz
Options 1 56311 869.616 869.634 1.078 -
Definition 0 75.082 870.036 870.075 1586
Conditions # Mo Point Crit Depth Top Wid
Constraints 4 29 B67.694 B.847
Computation 3 27 868.309 3.830 r
2 25868927 4755 =
Type 1 33 BEOG16 13.044 —
. 0 32 870,036 1.842 -
I Pipe
(@) Ditch
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Exercise 8

d) Switch to our other ditch links, DIT-2 & DIT-3, and review the computed data.

LinkiD: 4| [DiT2

Details
Options
Definibon
Conditicns
Constraints
Computation
Type
Pipe
@) Ditch

ﬂ Link Configuration Computations

Highlight

# Distance WSEL EGL Velocity
9 0.000 865481 855485 0514
8 18335 865.865 865908 167
7 36669 366,197 866248 1824
6 55004 866275 866.321 1736
5 73339 866.431 866497 2057
4 91673 866.717 866.789 2161
3 110,008 866941 B67.018 2.217

=k
= ﬂ Wlndowl:enterﬂ ﬂ ﬁ J

[Aac-l:j

&

ﬂ Link Configuration Computations

LinkiD: 4| [oim=3

Details
Options
Definition
Conditicns
Constraints
Computation
Type
Pipe
@) Ditch

— -

v) M e A A 2 A e ]

# Distance WSEL EGL Velocity
9 0.000 851.178 851.301 2815
8 25824 855274 855426 3.128
7 51,649 357.554 857629 27199
6 77473 859.161 859234 2163
5 103.293 260.862 2360524 1982
4 129122 861.738 861838 2535
3 154,847 862518 362606 2375

Using this information, we can determine if the existing conditions are adequate to
convey the water along the fill line and critical points where more capacity may be
required.

If using this methodology to analyze long proposed roadway ditches, you can determine
locations where special ditches may be required as the depth\volume becomes too
great for the regular ditch to handle.

8.3 Select Active Network

With the possibility of multiple networks in a single drainage project it may be necessary
to choose an Active Network to utilize certain GEOPAK Drainage Features.

a) Select the Set Active Network tool, select Network > Active Network from the main
drainage menu bar or click the Add Network button in the Network Configuration Dialog.

M DRAINAGE - DrainageProject.gdf - [Mo Active Netwark]

Drainag...@

‘ Project Compenent :Hetwork Reports  Utilities  Tool Boxes

| | B

Add...
Edit
Delete

Rename

Design

Analyze

Active Network

b
8.7

Fi £
i

o |
Y 4%
HB|E

.

| 1en

Add Drainage Metwork
Edit Drainage Network

Delete Drainage Metwork

[ U L L

Rename Drainage Network

Design Network

Analyze Network

| =

Set Active Network

7p
FEr
e
=

Open as ToolBox
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E=——)

Network ID: 4 JWEST ¥ W
Details |Set Active Network
Description: | | Outlet Node: [EW-1 ~|

Validation Computations [

Lock Sizes | | Unlock Sizes |
e & cp PP [ Lock Elevations | [Unlock Elevations |

b) Select the network West and click OK.

]

WEST
WESTDIT
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Exercise 9

9. Profiles

This exercise shows the user how to perform profile computations and properly display the
drainage profile.

Profiles can be constructed in a path running in either direction, upstream or downstream, in a
drainage network. The Profiles dialog is used to display customized profiles including
groundline, nodes, links, depth of cover, hydraulic grade line, etc.

9.1 Storm Drainage Profile Design

a) Select from the Menu Bar: Component > Profile > Add or from the main toolbar: Add
Drainage Profile

A DRAINAGE - DrainageProject.gdf - [No Active Network] [ Drainag.. [l
—— =
‘ Project | Component | Metwork Reports  Utilities  Tool Boxes ‘ ﬁ
Area p [TTEE—— Ij, QJ—%
MNode 3 o -_./,,
Link » %’ == 1 Add Drainage Prefile
2 Drainage Profile List
Profile v Add i % 2 9
i Z&__{] % 3 ID Drainage Link in Profile
Culbvert y| Edit List.. v : : :
= i % 4 Muodify Drainage Profile
Routin v P =
] D Link % 5 Delete Drainage Profile
Land Uses Delete % 6 Update All Drainage Profiles
e 2 Update Al % 1 Automatic Create Profile
Auto Create =3 Open as ToolBox

b) Complete the Profile Configuration dialog box information as follows for the left side of
the roadway in the WEST drainage network. Click Apply when finished.

Profile ID: WestLT From Node: CB-1 To Node: EW-1

M Add Profile
Profile 1D: | WestLT
Description:
From Mode: [CB-1 - |

To Node: [EW-1 > |

NOTE: To select the appropriate node; use the dropdown menu or use the ID node
button and select the node from the plan view. From Node and To Node must be in
the same network.
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c) Load the Profile Preferences file. Inside the Edit Drainage Profile dialog, click File >

Open.
#4 Edit Drainage Profile - WestLT o B |-
File
Open... View Number: E
save Display | Drainage Information | Grid & Labels || Link Profile |
Save As.. Point Projection
X | 0.000 [ Praject to Chain: Identify Profile Cell
Y: | 0.000 Chain :
Scale Grid Stationing and Bevations
Horzontal: | 10.000 Beqin Station: 0+00.00
Wertical: | 1.000 End Station: 10+75.88
Node Information I'U'Ia:.:. Ele'u'atfun: 250.000
From- [CE-'I v] At Min Elevation: | 230.000
To: [EW-1 - | Reference Suface
(Ste Model ] | - |
Reset Profile

[] Vertical Offset: | 0.000

Navigate to C:Users\Public\Geopak Standards\ and select
TDOTStormSewerProfiles-Design.ppf. Click Open.

F B |
ﬁ Open Profile Preferences - ChUsers\Public\Geopak Standm ﬁ
Look in: | Geopak Standards - a ? 5 T r'.'.’_j [#]
i Mame : Date modified Type
e J3PC 8/20/2013 10:24 AM  File folder
RecentPlaces 1) ConstCriteria 2/27/2013852 PM  File folder
! J Criteria 8/23/2013 7:25 aM File folder
|| TDOTStermSewerProfiles.ppf 11/24/200310:35 ...  PPFFile
Desktop i | TDOTStormSewerProfiles-Design. ppf 9/14/2006 10:25 AM  PPF File
= || TDOTStermSewerProfiles-Plan.ppf 7/25/2012 436 PM PPF File
=
Libraries
. i
==
Computer

@ L 1n | 3

Metwork

File name: TDOTStorm SewerProfiles-Design.ppf -

Files of type: [‘.ppf 'l [ Cancel ]

All settings have been set for the profile. To view the settings, click on the Display,
Drainage Information and Grid & Labels tabs. They should look as shown below.
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Exercise 9

[ File
Description: | | View Number: (1)
W-thmmﬂeﬂllabds"ukm|
Soffi Water Line Crossings
[===" [Jube: | 1294

R

12034

Crtical Depth

ption: | View Number: (1_+] Apply |
wumwamuwmﬂ
Hydraulic Grade Line
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[ M Edit Drainage Profile - WestLT - ~\TDOTStormSewerProfiles-Desi.. (il n=in i S
File '
Dt e 5 [ )
| Registration || Display | Drainage Information ((Grid & Labels )| Link Profile |
Labels 4 Grid Lines Node Labels
Bl Node Position:
= ket Label Offset: | 5.000 -
] Grid Boundary [7] Library kem Name *]2.34
M Horizontal Grid (] Lbrary kem Description
W] Vertical Grid ] Profie Name

[v] Station
Bevation
[7] Place Label: Prefic:

Suffix:

NOTE: During the design process these preferences can be modified to display needed
information. However, when projecting to a profile (see Exercise 9.2) the settings should
match those defined in profile preference file TDOTStormSewerProfiles-Plan.ppf.

d) Click the Registration tab and make the settings as below in the Registration Point,
Scale and Reference Surface portions (ignore the Projection portion for now). The
Registration Point will correspond to the lower left corner of the profile and can be
wherever an open space is available. Click Apply.

M Edit Drainage Profile - WestLT - ..\TDOTStormSewerProfiles-Desi... | = | = [
File
Description: View Number: (1_+] E
Display | Drainage Infomation | Gad & Labels | Link Profie |
Flagstlatlon Point Projection
X: [ 7500.000 = 7] Project to Chain: | Identfy Profile Cell
Y: | 2500.000 Chain
Scale Grid Stationing and Elevations
Horizontal: | 50.000 Begin Station: 0+00.00
Vertical: | 5.000 End Station: 10+75.88
e R Max. Blevation: | 830.000
From: [CB-1 v Min Elevation: | 830.000
To: [EW-1 v | Reference Surface
- TINFile =] |finaltin Q
Reset Profile
[7] Vertical Offset: | 0.000
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Exercise 9

e) Review the profile for anything that needs to be corrected.

f) Repeat steps a-d to create the following profiles:

Profile ID From Node - To Node Registration Point

WestRT CB-2 - EW-1 X =7500 Y = 1000
CB5 CB-5 - CB-2 X =9000 Y = 1000
CB7 CB-7 - CB-3 X =9000 Y = 2500
CB8 CB-8 - CB-6 X =9500 Y = 2500
CB10 CB-10 - CB-9 X =9500 Y =1000

NOTE: All Profiles should go forward with the alignment so they can be projected to the

roadway alignment profile at a later time.

See the following pages for images of the profiles.
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WestRT

® View 1, Default |re|-E S|
G- -AQ QRO BEHLE

CB5 CB7
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Exercise 9

CB8 CB10
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9.2 Projecting Profiles to a Chain

a) Click Component > Profile > Edit List from the GEOPAK Drainage Menu or by
Drainage Profile List from the Drainage Toolbar and select the Profile WestLT. Click

M DRAINAGE - DrainageProject.gdf - [No Active Netwark] A [
| Project | Component | Metwork  Reports  Utilities  Tool Boxes
Area v [
Node : 8,7,
Link >. . Egg 1 Add Drainage Profile
Profile b Add ¥ k| 2 Drainage Profile List
— P s 3 e - e :
Culvert - [ Select Profile to Edit 2 |%4 2 1D Drainage Linkin Profile
Routing y D \,,y% 4 Meodify Drainage Profile
ID Link .”:.J Desmﬂﬂon = ‘w" % 5 Delete Drainage Profile
La.nd Uses N Delete CE5 W 2
Miscellaneous Utilities ks % 6 Update All Drainage Profiles
| Update All A e ) )
AUt Create 3 % 7 Automatic Create Profile
| =3 Open as ToolBox

b) Load the Profile Preferences file. Inside the Edit Drainage Profile dialog, click File >

Open.
Navigate to C:Users\Public\Geopak Standards\ and select
TDOTStormSewerProfiles-Plan.ppf. Click Open.
“ Open Profile Preferences - C:\Users\Public\Geopak Standards\ ﬁ
Lookin: | GeopakStandards ~ @4 o '—:1
B Name ‘ Date modified Type
~ il o3pC 8/20/2013 9:57 AM File folder
RecentPlaces | constCriteria 2/27/2013 8:52 PM File folder
! | Criteria 12/17/2013 5:10 PM File folder
TDOTStormSewerProfiles.ppf 11/24/2003 10:35 AM PPF File
Desktop TDOTStormSewerProfiles-Design.ppf 9/14/2006 10:25 AM PPF File
K TDOTStormSewerProfiles-Plan.ppf 7/25/2012 4:36 PM PPF File
wml
Libraries
Computer
w
< | [T} 3
MNetwork
File name: TDOTStormSewerProfiles-Plan.ppf -
Files of type: * ppf V] I Cancel ]
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Exercise 9

c) Toggle ON Project to Chain in the Projection portion of the dialog. Click Identify Profile
Cell and select the Profile Cell for the Roadway Profile and Data Point to accept. Click

Apply.
M Edit Drainage Profile - WestLT [
File
Description:

View Number: |_1___v_! [_-ﬁ""DII'h' |

Reqistration | Display Dminage Information | Grid & Labels || Link Profil=
Registration Paint Projection
X [3322.017 . v/ Project to Chain: [{__. Identiy, Profils Cal_|
824 041 ) Chain: CL
Scale Grid Stationing and Elevations
Mode Information e, : _ - :
From: [CB-1 b - =
To: [EW-1 gt Reference Surface
———— (TINFile ] |final tin Q
= Wertical Offset:
d) View the Projected Drainage Profile along the Roadway Profile.
B View 1, Default == =
=] it - 49 QRIMEY M B H "I?,'l?l

NOTE: Caution must be used when Projecting Drainage Profiles since the profile will be
skewed to fit the station and elevation data of the roadway profile.
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9.3 Ditch Profile

a) Select from the Menu Bar: Component > Profile > Add or from the main toolbar: Add
Drainage Profile

b) Complete the Profile Configuration dialog box information as follows for the special
ditch drainage network. Click Apply when finished.

Profile ID: DIT1 From Node: DIT-1 To Node: DIT-4

c) Load the Profile Preferences file. Inside the Edit Drainage Profile dialog, click File >
Open. Navigate to C:Users\Public\Geopak Standards\ and select
TDOTStormSewerProfiles-Design.ppf. Click Open.

d) Click the Registration tab and make the settings as below in the Registration Point,
Scale and Reference Surface portions (make sure Project to Chain is toggled OFF).
Click Apply.

P4 Edit Drainage Profile - DIT-1 - .ATDOTStormSewerProfiles-Design... | = | & [s23s]
File

Description: View Mumber: |1 - Apply

| Registration | Display | Drainage Information | Grid & Labels || Link Profile |

Reqgistration Paoint Projection
X: [ 10000.000 Project to Chain: | Identify Profile Cell
Y: | -1000.000 Chain :
Scale (Grid Stationing and Elevations
Horzortal: | 50.000 Begin Station:  0+00.00
Vertical: | 5.000 End Station: 4+72.51
Node Information : [920.000
From:- |DIT—‘I v| Ut Min Elevation: | 840.000
To: [DIT4 v | Y Reference Surface
: TINFile =] |final tin Q,
| Reset Profile | _ B
Vertical Offset:

NOTE: For ditch profiles defined with Fixed Geometry, this dialog can be used to help
identify and correct errors produced in the drainage calculations and ensure the
drainage flows as it should. Our current ditch network set up is Cross Section Based on
the existing terrain so that functionality is not applicable.
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Exercise 9

NOTES:
For Cross Section Based links the invert generally follows the existing surface terrain.

The yellow hydraulic grade line indicates locations where the existing ditch cross
section geometry and water volume cause a rise or fall in the water surface elevation.
Rises indicate points where greater capacity may be required. This information along
with computation information provided with the links can be used to determine any
possible special ditch needs.

In Exercise 11, the system modification chapter, we will relocate these nodes and set
the links as fixed geometry to define a special ditch set up to handle the drainage in this
area.

GEOPAK Drainage V8i (SELECT Series 2) Profiles 9-11



9.4 Editing Links via Profiles

The Edit Profiles dialog allows you to edit a Link’s design. This being the case the Link
Configuration dialog must be closed in order to open the Edit Drainage Profile dialog.

a) Open profile WestRT by selecting Component > Profile > Edit List or by selecting
Drainage Profile List from the GEOPAK Drainage Main Toolbar.

b) Click the Link Profile tab. Highlight the SS-2 Link ID.

#A Edit Drainage Profile - WestRT - X
File
Description: View Number: |1 Apply

Registration Display Drainage Information  Grid & Labels

Drainage Profile Points

Link ID | Node Elevation Node Elevation Slope ~
552 CB-2 876.883 CB-4 870934 2418 =
554 CB4 870764 CB-S 867.050 2110 fh
559 CB-5 866.880 CB-11 864.788 1.660 v
Details
Node Node
Min. Cover: 878383 Min. Cover: 872434
[] Hold Invert: | 876.883 4 [] Hold Invert: | 870934 i+
Drainage Library ftem [] Hold Siope: | 2.418
18 Inch Dia. Circular -

[] Center View: 1 «

The SS-2 link’s control data is populated in the Details section at the bottom.

Link ID | Node Hevation Node Blevation
552 CB2 876883 CB4 870.934 2418
554  CB4 870.764 CB-9 867.050 2110
559 CBS 866.880 CB-11 864.788 1660 v
Details .
Node Node Modify Segment
Min. Cover: 878.383 Min. Cover: 87244
[] Hold Invesrt: | 876.883 4 [ Hold Invert: |870.534 &
el e [] Hold Slope: | 2.412
18 Inch Dia. Circular -

[] Center View: |1 =

From here you can set and hold the invert elevations, set the slope to hold or change
the pipe size.

Once any desired changes are made, click the Modify Segment icon on the right. An
alert will appear. Click Yes, review and dismiss the warnings.

c) Do not make any changes at this time. Click the red X to dismiss the dialog.
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Exercise 10

10. Drainage Navigator

This exercise shows the user how to navigate a network and perform queries.

10.1 Navigating/Query
a) Select from the Drainage Menu Bar Utilities > Navigator or from the drainage main
toolbar Drainage Navigator.

Drainag...@
M DRAINAGE - DrainageProject.gdf - [No Active Network] i
| Project Component  Network  Reports | Utilities | Tool Boxes IEL C%
. : g,/
Navigator e
Conflict Finder B=, P,
Labeler Y, ".»
=

Display 3D (__{*],%

]

DTM Drainage Tools :

— :‘Utilities: Drainage Navigator

b) Select the Drainage Nodes button on the Navigator:

M Mavigator E = @

View Tools

Wt DL e Y
D Descﬁ@ o

CE-1 [
CE-10 P
CE-11

CE-12

CB-13

CB-14

CB-2

Highlight [ Window Certer: Cluerny

A @ o

-
padd

t=

c) Toggle ON the Highlight and Window Center tools and click once on various
nodes in the network.
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B View1, Default (=

M Navigator

B [ovE/ meY

D Descripf -
CB1 e o £
CB-10
CB-1
CB-12

CB-13
CB-14
cB2
7| Highlight  [f] Window Center

G-@w-ARQANEHD I | DE|H LG

As you can see the Drainage Navigator makes it easy to go to specific components in
the network. A double click automatically opens the component's configuration dialog
for easy editing of any Drainage component.

d) Set the Active Component Type to Link and toggle the Query option:

e) Use the Query tool to determine which Links have exceeded the Min Rise. Make the
settings as shown and then click on Apply Query.

M Navigator I. e -35—]1

View Tools

Tt bW meY
.I[-J [ Déscriptinn |
[ MH-1 [ &
55-3 =

¥

556
557
DIT-3 | 5
§512

55-13 -

m

J| Highlight [7] Window Center  [¥] Query
Query Options
Query Type: [Constmints |

Condition: [=_ =]

Constraint: | Min Rise -

Note the results of your query here:
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Exercise 10

f) Follow the same procedures to determine the following:

Using Query type Values;
Which pipes have a velocity less than 3 fps?

(This will show you which links need to be modified to increase the velocity.)

Using Query type Values;
Which pipes have a velocity greater than 12 fps?

(This will show you which links need to be modified to decrease the velocity.)

Using Query type Constraints;
Which links have slopes less than Min Slope?

(This will show you which links need to have their slopes increased.)

Set the active component type to Inlet.

Using Query type Constraints;
Which inlets have exceeded their max ponded width?

(This will show you which inlets need to be relocated to decrease the ponded width.)
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10.2 Navigating/Global Editor

From the query in Step 5 of Exercise 10.1 you should have found that 2 pipes were
designed at a value greater than the minimum rise 1.5' (18"). These should have been
SS-14 and SS-MHL1.

Since for the initial design we set our minimum depth of cover based on the minimum
pipe size it will be necessary to check our catch basin depths to be sure they have not
violated minimum depth requirements and to make sure that the larger pipe size is valid

for the node which was used. To do this take the following steps:

Checking Minimum Depth Requirements vs. Designed Node Depths & Pipe Sizes:

a) ldentify which drainage nodes are involved by going to Reports > Storm Drains/Links >
Link Configuration in the GEOPAK Drainage menu bar. This report describes each link
including From Node (Upstream), To Node (Downstream) and Size/Diameter (Rise).

M DRAINAGE - DrainageProject.gdf - [WEST Active]

| Project Component Metwork | Reports | Utilities  Tool Boxes

Drainage Areas

Inlets

»

Storm Drains/Links

b | Link Cenfiguration

|

Builder...

Generate

Link Hydraulic Computations

=Jd
MANRS
N

Drainag...@

Add Drainage Link
Edit Link

Id Edit Drainage Link
Delete Drainage Link

Rename Drainage Link

Update All Links
Update Links with Pay Items

refil & Drainage Link Report - Configuration
n/CP 9 Drainage Link Report - Computations
=4 Open as ToolBox
L Storm Drain Configuration Sumrmary for Metwork WEST - Calculations Current — >
Upstream Downstream lpstream  Downstream
D 0 ID Dischange | Length Shape # Rize |Span |n Sope Invert Invert [
E5-NHT MH-1 EW-1 19717 35500 Cireul 1 Q.000>n/a 0013 11000 852317 843412
55-11 CB-13 MH-1 8.451 254 . Circul 1 1500 na 0013 1.266 8617.254% 858.032
{EQH:) CB-14 MH-1 11447 38.040 Cireul 1 @ n'a 0.013 0500 355025 855733
S517 CB-11 CB-13 3110 21... Circul 1 1800 na 0013 1512 864618 861.423
55-12 CB-12 CB-14 10711 190... Cireul 1 1500 nia 0013 1.871 860.002 856429
559 CB-9 CE-11 7.810 126... Circul 1 1.500 nsa 0.013 1.660 366.330 364.733
56 CB-& CB-12 10285 2ER... Cireul 1 1.500 nfa 0013 1684 864,648 860172
554 CB-4 CB-5 4453 176... Cireul 1 1500 na 0013 2110 870.764 867.050
S5-10 CB-10 CB-5 2632 7460 Circul 1 1500 n/a 0013 NM.000 267.870 867.050
55-3 CB-3 CB-6 B.509 306... Circul 1 1.500 n/a 0.013 1646 B65.853 B64.818 i
[ Window Center
o [Edt [ Highlight Apply

10-4 Drainage Navigator

GEOPAK Drainage V8i (SELECT Series 2)




Exercise 10

b) Open the Navigator tool under Utilities and expand it to the Global Editor by choosing

from the pull-down menu View > Global Editor. Once the Global Editor is open, click on
the Node button.

i 3y

M Global Editor L= L]

View | Tools
Mavigator D w

| Global Editor | /@j / % .’. Y
i Diescription » || Varable to Edit ———eil
CB-1 d=|[ |Mode-ID -
CB-10 ||| |Node - Description [
CB-1 MNode - Reference Chain |=
CB-12 Mode - Reference PGL |
CB13 Mode - Reference TIM
CB-14 Mode - Blevation
CB-2 = | |Mode - Reference Bevation -
[¥] Highlight  [/] Window Cernter Cuery | Apply Edit With Confim | | Apply Edit No Confimn |

c) SS-MHL1 is the first link shown in the Storm Drain Configuration Summary (Step 1). This
link was designed by GEOPAK drainage to have a rise of 2.0 feet (24 inches). Find an
select the Upstream Node (From Node) MH-1 for this Link in the Global Editor Diatog,
then find and select Node — Minimum Depth in the| Variable to Edi{ portion of the editor.
Set the New Value to the correct minimum depth for a 2.0’ (24”) diameter pipe found in
the TDOT GEOPAK Drainage Nodes document (Appendix A, pg. A-5).

#L Global Editor - *

View Tools

Py @ wn/ % '/. Y Cument Value: 2.230

Description | Varable to Edit
CB5 Node - Reference PGL | MNew Value: | BRI
CB& Mode - Reference TIN
CB-7 Mode - Elevation
CB-8 Mode - Reference Bevation
CB-9 iMode - Supplied Discharge
EW-1 mode - Minimum Depth
MH-1 W Mode - Maximum Depth b

Highlight Window Center Queny Apply Edit With Confirm Apply Edit No Corfimm

NOTE: If the type of structure for a given node is unknown or needs to be changed
(would happen if pipe size is too large for a given catch basin), simply double click the
Node ID in the Global Editor and the Node Configuration Dialog will be invoked.

Min. Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth
MH#3 5'DIA: 448 - 247/12 - 0.21' = 2.27

d) Click Apply Edit With Confirm to apply the New Value and Click Yes in the Alert box.

NOTE: Global Editor may be used to edit multiple Nodes/Links at once.
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e) Repeat the previous steps to correct the minimum depth settings for the other storm
drainage nodes for pipe link SS-14. (node CB-14)

Min Depth of Basin — Pipe Size — Drop Across Bottom of Structure = Minimum Depth

CB#12 4x3, 24'DIA Pipe: 444 - 24712 - 017 = 227

f) Re-design the network WEST and review your profile. The Nodes should now meet
minimum depth requirements.

M Network Configuration - [WEST] o] @[3
Network ID: 4 {WEST ']. ¥ % ¥ ¥ &ML]
Details

Description: Outlet Node: [EW-I 'J b

Validation Computations [ T [T P |
e

™ L | Lock Elevations | | Unlock Elevations |

10.3 Re-Run the Network

It is recommended that once a drainage network is set up all component constraints
should be reviewed to insure that all criteria for design has been met.

After re running the network WEST in Step 6 there are three errors:
SS-8 Velocity less than minimum desired
SS-MH-1 Velocity greater than maximum desired

Capacity for Inlet CB-14 Exceeded Bypass Flow Unassigned

a) Navigate to Reports > Storm Drains/Links > Link Hydraulic Computations.
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Exercise 10
For link SS-8, the slope is 8.512 and the actual velocity is 0.539. To correct this error
we can increase the slope of SS-8. The maximum slope is 11 percent. The upper end
of SS-8 at CB-8 is at minimum depth, so we will have to lower the outlet end which is
connected to CB-6. For link SS-MH-1, the slope is the maximum 11% and the actual
velocity is 16.561. Looking at the profile, we definitely have some room to both lower
the CB-6 outlet and to decrease the slope of SS-MH-1.

b) Go to Component — Link- Edit — SS-8 — Conditions. Fix the upper invert elevation at
865.368 and the slope at 11.000 by checking the boxes next to the elevations. Click

Apply after making changes.

#L Link Configuration Conditions — *
. Window Center
Link ID: 4 558 ~ b E Highiight v S w7
Details
ngti:wui:zn rrofle I:DI-":ht":“-IFSnzlrn Mode Slope To Mode
Conditions Min Cover:  366.363 5.513 866.318
Constraints Soffit: 866.868 [ ] 11.000 866.318 [
Computation Invert: 865 368 864818 [
Type Max Depth: 841.188 -73.859 848 548
(@) Pipe
() Ditch
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¢) Re- run Network WEST

Upon checking the hydraulic computations, the new velocity is 7.592, which is in our
acceptable range:

i
Upstream Downstream Upstream  Downstream Urifarm Actual
D 1D D HGL HGL Discharge | Capacity Slope | Loss | Vebey Depth | Veloct) Depth | &
55-11 CB-11 CcB13 B65.793 362.252 8.110 13893 1.502 0010 7.700 0964 7.700 0.364
55-12 CB-12 CB-14 B61.383 357.329 10.710 15586 1501 0049 8969 02960 8.956 0.960
553 CB9 CB-11 B63.681 365.607 7.810 14 557 1665 0652 7.940 0817 7.914 0.315
555 CB& CB12 BGE. 101 861.158 10.28% 14255 1630 0315 8365 0585 3348 0.986
LS4 B4 CBS B71.694 367.605 4 453 16415 2103 0025 7432 0556 7473 0556
SS-10 CB-10 CB& BES.135 367.368 2632 37476 10996 0.045 11608 0279 95602 0.318
553 CB3 CB& B72 365 365,705 8.509 14 495 1644 129 3145 0891 B143 0891
553 B2 CB& 366,131 364,841 0.541 37476 11.003 0018 8546 0.170 “7552 0.184
55-2 CB-2 CB4 B7E.03 371413 3612 17571 2419 0325 7425 0479 7425 0478
55-1 CB1 CB3 376.963 371.265 1.580 17774 2470 0102 5858 0314 5838 0314
h ] Windaw Cartar
ASCII File: < [ EiR ] Highiight Aeply

Upon rerunning the network, you can see the profile automatically updated, the upper invert of
SS-6 changing to 864.49 from 864.67 and the slope to 1.62% from 1.68%. :

d) Now to correct the high velocity in SS-MH-1, we need to reduce the slope. In Link
Configuration Conditions for SS-MH-1, the upper invert is 852.317 so let’s lower it to
849.5 and fix the lower at its current value of 848.412 which is the outlet endwall.
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Exercise 10

ﬂ Link Configuration Conditions El [=] @
i Window Certer
Link: 1D: S5-MH-1 - O % ;
nk ID: 4 | ) [ Highlight vy /S F 7
Dietails
. Profile Conditions
Options From Mode Slope To Mode
Definition ] ]
Conditions Min Cover: 859852 24947 850 412
Constraints Soffit: 8317 O 11.000 ] 850412 [0
Computation Invert: 852 317 |:E 848412 [0
Type Max Depth:  821.762 -64 869 846 412
i@ Pipe
i Ditch

Change to:
ﬂ Link Configuration Conditions E =] @
) Window Center
Lirik 1D: 55-MH-1 - O b /
A J ¥ 5 tichigh v 7,7 Aeply
Details
} Profile Conditions
Options From Mode Slope To Mode
Definition ] _
Conditions Min Cover: 859852 24 5947 850412
Canstraints Soffit: 8237 O 5367 [ 850412 [0
Computation Invert: 349500 343412
Type Max Depth:  821.762 -64 869 846 412
i@ Fipe
i) Ditch

e) Re-run Network WEST.

Check Hydraulic Computations, 10.943 is within our acceptable range

ﬁ Storm Drain Hydraulic Calculztion Summary for Metwork WEST - Calculations Current — »
Upstream Downstream  Upstresm  Downstream Lnfom Actual
D D D HGL HEL Discharge | Capacy Slope | Loss | Velbcty Depth | Velocm Depth | ~
TEWAT WA EWA . Beahd . BAGEE 13717 42606 3066 1462 1250 0057 L1011 |
5513 CE-13 MH-1 862 475 858 527 3.451 12783 1278 0046 7296 0935 772% 0935
SE14 CB-14 MH-1 AR7 TR2 ARG 280 11.446 17207 0505 0627 A5RO9 1.247 R7M 1214
SE11 CBE-11 CB-13 8E5.701 862292 2110 13.883 1.502 0010 7.700 0.854 7.700  0.864
GE12 ce-12 Cb-14 BE1.383 BE7.129 10,710 15586 1.901 0.049 B9E9 0950 £B956 0.960
555 CB-5 CB-11 368.681 365.607 7.8410 14557 1665 0652 7.940 0.817 79514 0815
356 CB-& CB-12 366.101 961.158 10.285 14,333 1,630 0315 8365 0335 &3 0936
554 Ch-4 CB-5 871 684 867 605 4453 16415 2103 0026 7482 0556 7478 (556
SE10 CB-10 CB-5 869.136 BE7.168 2632 37476 1059 0.045 11608 0.279 5602 0318
553 CB-3 CR-& 872 365 865.708 8905 14495 1644 (1295 R145 048%1 2143 0891 v
[] Window Center
ASCII File: Q| Edit [ Highlight Anply
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Also note that the profile at SS-MH-1 is automatically updated:

10-10 Drainage Navigator GEOPAK Drainage V8i (SELECT Series 2)



Exercise 11

11. System Modification

This exercise shows the user how to modify the storm drainage system design. Specifically we
will combine links SS-14 & SS-MH1 by eliminating MH-1, change SS-13 to end at CB-12
instead of at MH-1, reengineering the network connectivity. We will also change our ditch
network set up to define a special ditch to handle the drainage along the base of the fill slope
in that area.

11.1 Storm Drainage Network Modification

a) Delete Node MH-1 by using Drainage Navigator, selecting Component > Node >
Delete from the Drainage Menu Bar, or by selecting Delete Drainage Node from the
Drainage Toolbar.

Drainag.. @

Add Drainage Node
Edit Node
1d Edit Drainage Node

Delete Drainage Node

Rename Drainage Mode

W< = BHE

I % 2 uf v wietae - H

Renumber Node

Update All Nodes
Update Nodes with Pay ltems

Drainage Mode Report - Sump

= 1o (=l ) e [EEA R E o U L L

Drainage Mode Report - On Grade

Open as ToolBox

NOTE: Click Yes that you would like to delete the Node, OK to delete the Network
WEST and NO to Do you want to delete all the components of the
network as well?

b) Follow the same basic procedures to delete Link SS-MH1.

c) Edit Link SS-13, to start at the front face of CB-13 towards centerline and end at the front
face of Node CB-12 across the road.
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,N Link Configuration Definition =] | EE /
: Window Center ; T
Link |D: 55-13 - b !
kiD: 4 {88 ¥) b 5 LT Y LW g (el
Details
E5I|-:|ti0-n-s Description:
| Defiriion |From Node: [CB-13 | % ToNode: [CB12 =] *mw
;Cand'rtinns Length: 72.2571 Use MS Blement [
|Constrairts Configuration
| Computation Shape: [Circular | Materal: [Concrete - |
Type 7] Design Size Size: 24 Inch Dia. Circular | Select... |
@) Fipe | Design Bamels  Number of Barels: (1 =] Roughness: | 0.013
Ditch COwemide Library Payitem:

d) Go to edit CB-12 and CB-13 to change the Library Item to CB#12 4'DIA.

REMINDER: Use the ID button to the right of the node list to identify the front wall
connection points at nodes CB-13 and CB-12.

B View1, Default [ |-E [

B~ ARQRBHY O BEHLE

NOTE: In an actual design, the skew angles would now need to be checked to ensure
the pipe would fit in the catch basin wall.

e) Edit Link SS-14, to go to Node EW-1.

f) Since pipe at EW-1(link SS-14) is now a 24" pipe (from previous exercise) and the side
slope at that location is 2:1, move the location of the outlet from an offset of 56’ to
52’ to account for the length of the end wall and properly locate the outlet.

g) Reset EW-1's Max Depth to 2.0 (designed pipe size at outlet).
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Exercise 11

B View1, Default [ro -] Ea]

h) Add a New Network named WEST with the Outlet Node set to EW-1 (this is necessary
since the network WEST was deleted in Step 1). Highlight the Network to ensure all
components are connected, and then Design the Network.

B View1, Default = =
o | i Fi i pi: i 1 L
[ 0 s ’

G-~ ARQREHY O BEILE

i) Update Profile WestRT to End at CB-12 and redraw other profiles as required based on
these modifications.

Optional:
Depending on the drainage areas developed in the previous exercises you may still

have errors in your network. If your hydraulic gradeline exceeds the minimum
freeboard, try increasing pipe sizes to lower the water surface. If the velocity in Link
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SS-14 is over the maximum limit try hard coding SS-14's invert elevation at Node CB-14
to lower the slope of that Link.
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Exercise 11

11.2 Ditch Network Modification

Initially, we set up a ditch network along a fill line using the Cross Section Based ditch
type to analyze the drainage there. Now we will relocate our ditch nodes and set up our
links as fixed geometry to design a special ditch along that slope to handle the drainage.

Relocate Ditch Nodes and their Drainage Areas
a) Delete previous drainage areas for ditch nodes.
b) Go to Component > Node > Edit and select Node DIT-1.
Under Location, change the station to 9+25 and the offset to 35.23.

This is the beginning of the desired special ditch at the base of the fill slope. We will
define the ditch link later as a “V” ditch with 2:1 side slopes although it will be at the
existing ground elevation here at the beginning.

M Node Configuration - Location @_‘él
Window Center
Node ID:_4] [DIT-1 ~] b EH' okt al gl % el 4
ighlig
Details
Options [¥] chain: [/] Profile: [DESIGNCL
Properties Coordinates / Stationing
Location . -
Spread Criteria Align: [TangenttoChaln ] ﬁ + Angle: | 0.000

Elevations Station: | 9+25.00 X 3484043
Junction Loss ) é

Y. 3056.086
Discharge Options

Computations Offset from Gutter to Inlet: | 0.000

Click Apply.

c) Reference in the new DIT-1 file and use methods described previously to rebuild the

DIT-1 drainage area for the new location, establish a time of concentration, apply land
use areas and compute discharge.

ﬂ Drainage Area Definition [ =] @
. " ) || Window Center o o
Area ID: 4 [DIT1 > » ] Highight & ca W &) | Aeply
Detais i M Drainage Area Computations [il = @
Options Description: 1 Window Gert
Deefirdti . ¥ '] | indow ar e = [—}
Subla-:a: Drainage Area: | 0.845 Area Selectiaf  Area ID: 4 [DIT-1 4 [] Highlight & & B &
Computation Base C Value: | 0.350 Select | pataie
| Time of Conc.: | 35.178 Options Area C Value —
Fot s [Compte TC1 Plck Bound{ | (0" Total Subareas: 0.843 0300 Discharge
@ Rational Elements SEES -
Computation Remainder: 0,001 0.350
SCS
Hydro, Method Composite: 0.845 0.300
@ Rational Computed Intensity: 3.205
SCs Computed Discharge:  0.812

Click Apply to save the changes.
d) Goto Component > Node > Edit and select Node DIT-2.
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Under Location, change the station to 10+48 and the offset to 36.00.

This is the point where we will achieve the 1 foot depth in our special ditch. By

modifying the links at this location the ditch link will be a “V” ditch with 2:1 side slopes
and is offset from the fill slope tie by 2 feet.

ﬂ Node Configuration - Location = —-
Window Center
Node 04| D=2 x| » % Highlight | _al % el 4l
Details
Options Chain Profile: [DESIGNCL ¥
Properties Coordinates / Stationing
Locatien o - #
Spread Criteria Align: [Tangent to Chain ] J +Angle: | 0.000
Elevations Station: | 10+48.00 X: 3605.606
Junction Loss $
Offset: | 36.000 Y: 303221
Discharge Options
Computations I:I Mirror Node Offset from Gutter to Inlet: | 0.000
Click Apply.

e) Use methods described previously to rebuild the DIT-2 drainage area for the new
location, establish a time of concentration, apply land use areas and compute discharge.

Remember ...ditch node drainage areas should include the area for the current node as
well as any others previously defined that contribute to the ditch drainage network.

ﬂ Drainage Area Definition = =
Area D: 4 [DIT2 = vl IR I
Details )
ions Description: = ——
[?:tzm'rtim I | M Drainage Area Computations |
P Drainage Area: | 0.847 e = -
) ) | Window er -
Computation Base C Value: D._-35'E| ::; Area ID: 4 |DIT-2 | » ] Highiight @ @ @ &)
l Time of Conc.: | 27.233 Details
I
Hydro. Method il q"fﬁ, Pick Bourd N |
(s A T oA A'E C V |
@ Rational Element [?g:;:n : aue gﬂ'm“ﬂmﬁ
5CS Subareas Total Subareas: 0.840 0.300 age
Computation Remainder: 0.008 0.350
Hydro. Method Composte: 0847 0.300
@ Rational Computed Intensty: 3.650
LS Computed Discharge: 0929

Click Apply to save the changes.
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f) Goto Component > Node > Edit and select Node DIT-3.
Under Location, change the station to 11+85 and the offset to 43.00.

This is the beginning of the final ditch slope and to mitigate the steeper slope and
resulting increase in velocity we will change the ditch link section to a 2 foot wide
trapezoidal shape, 1 foot deep with 2:1 side slopes and is offset from the fill slope tie by

Exercise 11

3 feet.
ﬂ Node Configuration - Location | = e S
Nodero._4] 573 7] »] [ viedowoener ) of %l 4
Details
Options Chain Profile:
Properties Coordinates / Stationing
Location L : - .
Spread Criteria Align: [TangenttﬂCham ] ﬂ +Angle: | 0.000
Elevations Station: | 11+85.00 X: 3738.849
Junction Loss ) $ _
Discharge Options Offset: | 43.000 Y: 2999587
Computations I:I Mirror Node Offset from Gutter to Inlet: | 0.000
L
Click Apply.

g) Use methods described previously to rebuild the DIT-3 drainage area for the new
location, establish a time of concentration, apply land use areas and compute discharge.

M Drainage Area Definition o= =
Rl =m— o (o]
ArealD: 4 [DIT-3 4 7] Highight A & W & | Aeely
Details :
Options Description: Tn Mode 1D OIT-3 e
mm Drainage Area: | 0,333 Area Select| #4 Drainage Area Computations = | @
Computation Base C Value: | 0.350 Select ArealD: 4 [DIT-3 | p Window Center . ol Apply
| | Time of Conc.: | 26.579 L__fﬁﬁf Highlight HAD & L———J
Hydro. Method I omout Pick Bounl Detais y
@ Rational Elemen g::ns Area C Value C—
SCs smag:; Total Subareas:  0.319 0.300 Discharge
Computation Remainder: 0014 0.350
Hydro. Method Composite: 0.333 0.302
@ Rational Computed Intensity: 3.706
5CS Computed Discharge: 0.373

Click Apply to save the changes.

GEOPAK Drainage V8i (SELECT Series 2)

System Modification

11-7



h) Go to Component > Node > Edit and select Node DIT-4.
Under Location, change the station to 13+28 and the offset to 72.00.

This is the outlet for the special ditch and is shifted away from the fill slope tie to lead
into the current existing drainage path.

S

,'4 Node Configuration - Location

Window Cent g
Node ID: 4| [DiT4 gl H.'"hl.o"';t = | el | e 4l
ighlig
Details
Options 7| Chain: J| Profil: [DESIGNCL ¥
Properties Coordinates / Stationing
Location P —
i Align: | Tangent ta Chain x| ﬁ +Angle: | 0.000
Spread Criteria
Elevations Station: | 13+28.00 X 3885.021
Junction Loss 7| Offset | 72.000 J: Y. 2052392
Discharge Opticns

Computations Mirror Node Offset from Gutter to Inlet: | 0.000

Click Apply.

i) Use methods described previously to rebuild the DIT-4 drainage area for the new
location, establish a time of concentration, apply land use areas and compute discharge.

# Drainage Area Definition || @ @
r y S W
MAealD: 4 |DIT4 = Window Center R ooy
Highlight
Details
Options Description: To Node ID: DIT-4 Gy
Ié)efinltion Drainage Area: | 0.997 Area Selecti{ M Drainage Area Computations e @ @
ubareas : !
Computation Base C Value:  0.350 Select r Y Window Center ( 1
Area ID: T4 = 2 4
Time of Conc.: Shape| ArealD: 4 D Highlight 5 A @ & ~RDD'Y )
Hydro. Method Pick Boun| Details
@ Rational Blement| | Options Area C Value Compute
Definiti
scs SU‘;:r;Z: Total Subareas: 0.948 0.324 Discharge
Eomptiation Remainder: 0.048 0.350
Hydro. Method Compostte:  0.997 0.326
@ Rational Computed Intensity: 3.568
sCs Computed Discharge: 1.158

Click Apply to save the changes.
Final layout of revised ditch nodes and drainage areas.
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Exercise 11

J) Since Node DIT-4 is an outlet type, it will not consider the drainage area developed for it.
In order to ensure the final ditch link, DIT-3, will be adequate for the capacity at the end
we will need to link the DIT-4 drainage area to it.

Go to Component> Node> Edit and select node DIT-3. Under Discharge
Options click on the option to Link Base Flow Area and set to include the
DIT-4 drainage area.

# Node Configuration - Discharge Options El_‘é]

Window Center
Node ID:_4| [DIT-3 gl EH' ikt | ] % el 4l
ighlig
Details
Options @ Use Computed Discharge
Properties (") Supplied Discharge: | 3.500
Location
Spread Criteria l:‘ Dizable Inlet Calculations Capacity: | 0.0000
Elevations [ Link Base Flow Area * | [DiT4 v | 4]
Junction Loss
Discharge Options
Computations

11.3 Ditch Link Modification

Redefine Ditch Links with Fixed Geometry & Invert Elevations
a) Goto Component > Link > Edit and select Link DIT-1.
Under Definition, make the following changes:
Ditch Type: Fixed Geometry
Ditch Width: 0 (Toggle OFF Design Width) - for V-ditch
Ditch Depth: 1 (Toggle OFF Design Depth)
Side Slope Ratio Left (H:1): 2.00
Side Slope Ratio Right (H:1): 2.00
These settings define a “V” ditch at a 1’ depth with 2:1 side slopes.

M Link Configuration Definition E‘_Iéj
. J F J DWindowCenter - =
LinkiD: _4] {DIT-1 Y 5o b VA I
Ighlig
Details
Options Diescription:
Diefinition From Mode: |DIT-1 hd E To Node: |DIT-2 i E
Conditions Length: 123.0024 [] use MS Element ﬂ
Constraints Configuration
Computation Ditch Type: [Fixed Geometry "] Roughness: | 0.027
Type Ditch Width: | 0.0000 D Design Width
© Pipe Ditch Depth: | 1.0000 [ Design Depth
(@) Ditch Side Slope Ratio Left (H:1): | 2.0000 Right (H:1): | 2.0000
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NOTE: You can use the Design Width or Design Depth options individually but it is
not recommended to use both at the same time. The software will always use the
Minimum Rise value under Constraints for the depth and only adjusts the width if

needed from that point.

b) Under Conditions, make the following changes:

From Node Invert: 867.599 (existing ground elevation)
To Node Invert: 865.058 (1 foot below existing ground elevation)

H Link Configuration Conditions

= LX)

LinkiD: _4| DI ~] b
Details
; Profile Conditions
Opt
p.|o.r1.5 From Mode Slope
Definition .
Conditions Min Cover:  867.599 1.253
Constraints Soffit: 99999999.9 0.030
Computation Invert 367598 W
Type Max Depth: 867599 1.253
Pipe
@) Ditch

To Node
866.058
99999999 .9
865.058
866.058

Window Center
Highlight ﬂ ﬂ ﬁ ﬂ

v

c) Under Constraints, make the following change:
Minimum Rise: 1.000 (to allow for defined 1 foot depth)

These settings provide the transition
from existing ground to the 1’ depth.

NOTE: The large numbers you may
see specified for Soffit elevations can
be ignored. These values are a result
of the previous application of the
Cross Section Based ditch type where
these values are not applicable. When
the ditch network is redesigned, the
Soffit elevations will be recalculated.

.ﬁ( Link Configuration Constraints

= X

WindDwC&nterﬂ ﬂ ﬁ ﬁ

LinkID: _4] {DIT-1 ~[ »
in J | | J Highlight
Details
Options Design Constr_ai.nts .
Minimum Maximum
Definition .
Conditions Rise: | 1.000 4.000
Constraints Slope: | 0.400 11.000
Computation Velogity: | 3.000 12000
Type
Pipe
(@) Ditch

d) Click Apply to save the changes to link DIT-1.
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e) Inthe Link Configuration Definition dialog go to Link DIT-2.

Under Definition, make the following changes:

Ditch Type: Eixed Geometry

Ditch Width: 0 (Toggle OFF Design Width) — for V-ditch
Ditch Depth: 1 (Toggle OFF Design Depth)
Side Slope Ratio Left (H:1): 2.00

Side Slope Ratio Right (H:1): 2.00
These settings define a “V” ditch at a 1’ depth with 2:1 side slopes.

Exercise 11

ﬂ Link Configuration Definition

= X

Type
[ : | Pipe
(@) Ditch

Ditch Width: | 0.0000
Ditch Depth: | 1.0000
Side Slope Ratio Left (H:1): | 2.0000

[] Design width
l:‘ Des=ign Depth

Right (H:1): | 2.0000

i i Window Cent
LinkiD: 4 [DIT2 il %H.'”h,.m;t A A X
ighlig
Details
Options Diescription:
Definition From Mode: |DIT-2 b E To Node: |DIT-3 A E
Conditions Length: 137.1787 [] use MS Element ﬂ
Constraints Configuration
Computation Ditch Type: [FixedGeometry '] Roughness: | 0.027

f) Under Conditions, make the following changes:

From Node Invert: 865.058 (1 foot below existing ground elevation)

To Node Invert: 860.678 (1 foot below existing ground elevation)

ﬂ Link Configuration Conditions

= -

ﬂ I:‘ Window Center

[ Highlight

From Node
866.053
99999999.9] |
865.058 |
866.058

Link ID: ﬂ DIT-2 -
Details
Options Profile Conditions
Definition )
Conditions Min Cover:
Constraints Soffit
Computation Ivert:
Type Max Depth:
[{ : | Pipe
(@) Ditch

Slope
3183
0.015

3.193

To Mode
861.678

A48 4

[]  oosogosss| |

860.673
861.673

=

These settings maintain the 1’ depth below the existing ground.
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g) Under Constraints, make the following change:
Minimum Rise: 1.000 (to allow for defined 1 foot depth)

. Link Configuration Constraints | = -
i : Window Center
LinkID: _4] {DIT-2 v|[ b O ¥ A ¥ 2 m
1 | o] Desmomer ) 4 31 4 (o)
Details
Options Design Constr_a i_nts _
Minimum Maximum
Definition )
Conditions Rise: | 1.000 4.000
Constraints Slope: | 0.400 11.000
Computation Velocity: | 3.000 12.000
Type
: Pipe
(@) Ditch

Click Apply to save the changes to link DIT-2.
h) In the Link Configuration Definition dialog go to Link DIT-3.
Under Definition, make the following changes:
Ditch Type: Eixed Geometry
Ditch Width: 2 (Toggle OFF Design Width)
Ditch Depth: 1 (Toggle OFF Design Depth)
Side Slope Ratio Left (H:1): 2.00
Side Slope Ratio Right (H:1): 2.00

M Link Configuration Definition E‘_‘ﬂ—hj
Window Center
Link 1D: _4] |DIT-3 > b O b4 V4 -4 P m
o 4| 3] [ ) ) ) A (o]
Details
Options Description:
Definition From Node: [DIT-3 ~] 25| ToNode: [DIT4 v
Conditions Length: 153.6017 [] use Ms Element ﬂ
Constraints Configuration
Computation Ditch Type: Roughness: | 0.027
Type Ditch Width: | 2.0000 [] Design Width
(©) Fipe Ditch Depth: | 1.0000 [] Design Depth
(@) Ditch Side Slope Ratio Left (H:1): | 2.0000 Right (H:1): | 2.0000

These settings define a 2’ wide trapezoidal (flat bottom) ditch at a 1’ depth with 2:1
side slopes.

Note: See Appendix E for Roughness Values for Open Channel Hydraulics.
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Exercise 11

i) Under Conditions, make the following changes:
From Node Invert: 860.678 (1 foot below existing ground elevation)
To Node Invert: 850.037 (existing ground elevation)

M Link Configuration Conditions E‘_‘i:—hj
Window Cent
inkiD: 4| (o3 v] »| EH.'"hf:t i P4 2 I
ighlig
Details
. Profile Conditions
Opt
p.ID.I'TS From Node Slope To Node
Definition .
Conditions Min Cover:  861.678 7579 o 850.037
Constraints Soffit 999909098 0062 || ooooggoas| |
Computation Invert 860678 850037
Type Max Depth:  861.678 7579 850.037
C:I Pipe
(@) Ditch

These settings provide the transition from the 1’ depth back to the existing ground
elevation at the end of the ditch.

}) Under Constraints, make the following change:

Minimum Rise: 1.000 (to allow for defined 1 foot depth)

M Link Configuration Constraints [ = &I
Window Cent:
LinkiD: 4| [DiT-3 v EH.'"hf:t =yl A ¥ A
) : ighlig
Details
Options Design Constr_ai_nts )
L Minimum Maximum
Definition .
Conditions Rise: | 1.000 4.000
Constraints Slope: | 0.400 11.000
Computation Velocity: | 3.000 12.000
Type
() Pipe
(@) Ditch

k) Click Apply to save the changes to link DIT-3.

NOTE: You can select the entire ditch of one profile, copy beside itself, select all and

Edit > Group so that you will still have the ditch profile from before modifications and you
can compare.
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11.4 Redesign Ditch Network & Review
a) Go to Network > Active Network and select WEST DIT.

b) Go to Network > Design to run the network.

c) Review any errors that are generated by the redesign of the network and close the text
editor. (See Appendix C for common errors and fixes)

M Text Editor: ..\drainage\drgmsg.bxt { = | =) H&I
File Edit Criteria

Ole|al & @ o~
hGL Blowout upstream of Link DIT-1 minimum freeboard not achieved
Min Depth Exceeded at Upstream of Link DIT-1

Min Depth Exceeded at Upstream of Link DIT-2
Min Depth Exceeded at Downstream of Link DIT-3

| Line: 1 Col: 1

d) Review computation results.

Go to Component > Link > Edit and review the link computations for links DIT-1,

DIT-2 & DIT-3.
M Link Configuration Computations { = ‘ |ﬁ‘
Window Cent
Link1D: 4| [DiT-1 ] E N P [
1ghlig
Details
Options HGL Blowout at upstream end -
Definition Upstream Soffit= 868599 =
Conditions Exceeds Maximum Allowed by Envelope = 867.58% =
Constraints Evooscs Masimm Allowed by Emel 866 058
. xoeeds Maximum Allowe nvelope = .
Compiclion Downstream Invert= 865.058
Type Lower than Allowed by Envelope = 866.058
= Flow is supercritical N
I) Pipe
(@) Ditch
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Exercise 11

Go to Reports> Storm Drains\Links> Link Hydraulic Computations.

,'4 Storm Drain Hydraulic Calculation Summary for Network WEST DIT - Calculations Current | = | . S
Lpstream Downstream  Upstream Downstream Uniform Actual
1D D D HGL HGL Discharge |Capacity Slope | Loss | Velocity Depth | Velocity Depth
DHT-3 DIT-3 DIT-4 861.234 850.395 5.888 42.042 6926 0020 6.053 0358 6053 0358
oHT-2 DIT-2 DIT-3 865.807 861.303 3.289 11.502 3203 0043 42711 0625 4211 0625
oIT-1 DIT-1 DIT-2 868.269 865.586 1.688 5252 2066 0134 3.023 0528 3023 0528
E Window Center
ASCII File: E Edit Highlight Apply

e) Zoom in on the ditch profile graphics.

The profile has been automatically updated and reflects our new proposed ditch
definitions.
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Exercise 12

12. Reports

This exercise shows the user the report options by creating standard and customized reports.

12.1 Customized Reports

a) Select Reports > Generate from the Drainage Menu Bar or Drainage Generate Report
from the Drainage Toolbar:

Drainag.. \é‘
: : : i
M DRAINAGE - DrainageProject.gdf - [WEST Active] e | -
i, 4l
‘ Project Component Network | Reports | Utilities Tool Boxes | ‘ﬁg’ fy'b
Drainage Areas é» I
Inlets 4 ;‘YI_» f
a . e 1 Drainage Area Report
Storm Drains/Links > f"dj
w?’ %ﬁf 2 Drainage Node Report - Sump
ELI”CIET... —%ﬁf 3 Drainage Node Report - On Grade
Qerrerate n/CF 4 Drainage Link Report - Configuration
n/cp 5 Drainage Link Report - Computations
%’i 6 Drainage Report Builder
@ 7 Drainage Generate Report
=2 Openas ToolBox

b) Use the browse button to select report format file TDOTnodesFULL.drf (from
C:\Users\Public\Geopak Standards\). Click in the Output File Name area and type in
nodes.csv as the file name. Click Generate to create the report file.

( # Generate Report A . S

Drainage Report Format File: | tandards’\ TDO TnodesFULL AR | G

Output File Name: | nodes.csv Q

c) Use Excel to open and review nodes.csv report file.
d) Access report format TDOTIlinksFULL.drf and generate links.csv report file.

e) Use Excel to open and review links.csv report file.
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12.2 Excel Tab Builder

a) Open Excel and click File > New

b) Click My templates > TDOT English Tab Quantities > Storm Drainage Structure Tab

Builder

If the “My templates” button does not provide you with the Storm Drainage Structure Tab

Builder excel file, then navigate to C:\Users\Public\Office Standards\TDOT English
Tab Quantities and open the file there. Do a “Save As” and save it into your Project
folder before making any changes.

d)

click open. The tab block is created.

Click Build Catch Basins and Manholes Block.

Navigate to the project folder, select the file nodes.csv created in Exercise 12.1 and

CATCH BASINS
TYPE 12 | TYPE 12 | TYPE 42 | TYPE 43
SHEET| LOCATION STATION | OFFSET|DRAINAGE|GRATE/TOP|STRUCTURE INSIDE DEPTH [STANDARO C.B. c.B. C.B. C.B. REMARKS
NO. (FT.) CODE ELEV. TYPE |DIMENSION (FT.) |PRAWINGY 611-12.01| 611-12.02 | 611-42.01 | 611-43.02
0 -4 4'-8 -4 4 -8

| CL 11+45.00 26 CB-13 865.16 #12 4X3 4.59 1
CL 12+00.00 -26 CB-12 863.9 #12 4X3 59 1
CL 14+00.00 -26 CB-14 860.14 #12 4X3 6.64 1
CL 3+70.00 -26 CB-1 880.97 #12 4X3 3.88 1
CL 3+70.00 26 CB-2 880.95 #12 4X3 4.05 1
CL 3+70.00 35 CB-5 881.51 #42 4X4 38 1
CL 6+20.00 -26 CB-3 87468 #12 4X3 524 1
CL 6+20.00 26 CB-4 874.66 #12 4X3 3.88 1
CL 6+20.00 -50 CB-7 87411 #43 8X4 4.42 1
CL 8+00.00 26 CB-9 870.78 #12 4X3 421 1
CL 8+00.00 38 CB-10 872.38 #43 8 DIA 4.49 1
CL 9+30.00 -26 CB-6 868.55 #12 4X3 4.42 1
CL 9+30.00 -35 CB-8 869.19 #42 4X4 38 1
CL 9+30.00 26 CB-11 868.52 #12 4X3 4.38 1

TOTALS 2 8 2 2

e) Repeat Step 1 through Step 4 using the links.csv file and the Storm Drainage Pipe

Tab Builder
STORM DRAINAGE PIPES
EROM T0 RCP CLASS IlI
SHEET % 607-03.02 607-05.02 607-06.02 607-07.02
NO. CODE OUTLET] CODE INLET | GRADE 18" 24" 30" 36"
ELEV. ELEV. (L.F.) (L.F.) (L.F.) (L.F.)

CB-1 877.09 | CB-3 87093 250 246
CB-2 87690 | CB4 870.95 242 246
CB-3 869 44 CB-6 864 .30 1.68 306
CB-4 870.78 CB-9 867.07 2.1 176
CB-5 | 877.71 CB-2 877.07 9.82 6
CB-6 | 864.13 | CB-12 | 859.65 1.68 266
CB-7 86969 | CB-3 869 .61 0.40 19
CB-8 865.39 CB-6 864 .80 9.13 6
CB-9 866.57 | CB-11 | 864.31 1.79 126
CB-10 | 867.89 | CB-9 | 867.07 11.00 7
CB-11 | 864.14 | CB-13 | 860.74 1.61 21
CB-12 | 858.00 | CB-14 | 854.00 210 191
CB-13 | 86057 | CB-12 | 859.65 1.27 72
CB-14 | 853.50 | EW-1 850.42 418 T4

TOTALS 688 1000 191 74

12-2 Reports
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12.3 Standard Reports

Exercise 12

Geopak Drainage also provides several standard reports which are useful during storm
drainage network design. The current Active Network will determine which drainage
features are listed.

a) Select Reports > Drainage Areas from the Drainage Menu Bar.

K Drainage Area Summary

= S|

Identification Runoff C Drainage Area | Time of Conc. | Time Used Intensity Discharge o
CB-1 0.794 0.263 5.00 5.000 6.980 1.457

CB-2 0.590 0.452 5.00 5.000 6.980 1.864 |
CB-3 0.470 0.539 562 5624 6.805 1.725 3
CB-4 0.470 0.547 5.00 5.000 6.980 1.793

CB-5 0.300 1.023 5.00 5.000 6.980 2146

CB-6& 0.750 0.257 5.00 5.000 6.980 1.343

CB-7 0.300 5778 6.43 6.428 6.580 11.408

CB-8 0.300 1.103 5.00 5.000 6.980 231

CB-9 0.393 0.708 579 5795 6.757 1.904

23+20 0475 20628 2580 25795 3774 36.978 =

Network: E |:| Window Center
ASCIl File: ﬂ Edit D Highlight

b) Select Reports > Inlets> On Grade Inlets from the Drainage Menu Bar.

P On Grade Inlet Computation Summary l = —
Ponded
D Type |Discharge |Width |Depth |Slope |Length Width |Depr. |Capacity |By Pas: To Node
CB-1 Grate 1.457 5123 0232 2515 3021 1813 nla 1.200 0.257 CB-3
CB-2 Grate 1.864 6.004 0250 2515 3021 1813 nla 1.441 0423 CB+4
CB-3 Grate 1.981 6.227 0255 2515 3021 1813 nla 1.507 0474 CB-6
CB-4 Grate 2.216 6.644 0263 2515 3021 1813 nla 1.634 0.581 CB-9
CB-6 Grate 1.818 6.624 0262 1.710 3021 1813 nla 1.408 0409 CB-12
CB-8 Grate 2.486 7.842 0287 1.710 3021 1813 nla 1.779 0.706 CB-11
CB-11 Grate 1.303 5411 0238 1.710 3021 1813 n/a 1.089 0.214 CB-13
CB-12 Grate 1.517 5956 0249 1.710 3021 1.813 n/a 1.226 0.291 CB-14
CB-13 Grate 1.096 8974 0217 1.710 3.021 1813 nla 0.871 0.225 CB-14
CB-14 Grate 2.207 5385 0288 1.710 3.021 1.813 nla 1.771 0436 Unassigned
Network: | All Networks - E |:| Window Center
ASCII File: al Edit [ Highlight Apply
Sag Inlets
K Sag Inlet Computation Summary l = X
Discharge Ponded Width Slope Ponded
1D Type |Discharge Left Right |Left Right | Left Right | Length| Width | Depr. Area |Perim. | Capacity | Depth
CB-5 Grate 2.146 2103 0.043 4466 2.117 1.000 1.000 nla nfa nfa 3.600 7.600 6.8341 0.203
CB-7 Grate 11.409 1141 10268 3.208 7809 5000 3500 n/a n/a nla 7200 15200 13.681 0.390
CB-3 Grate 2.311 0.046 2265 2069 6770 1.000 1.000 n/a n/a nfa 3.600 7600 6.841 0.213
CB-10 Grate 4.582 2291 2291 5508 5508 5000 5000 n/a n/a nfa 7.200 15.200 13.681 0.212
Network: E l:‘ Window Center
ASCIl File: & [ Ed || Highlight
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c) Select Reports > Storm Drains/Links> Link Configuration from the Drainage Menu

Bar.
K Storm Drain Configuration Summary for Network WEST - Calculations Current = X
Upstream Downstream Upstream Downstream
D ID ID Discharge |Length Shape |# Rise |Span |n Slope Invert Invert o
55-14 CB-14 EW-1 31.612 73.540 Circ.. 1 3.000 nfa 0.013 4.182 853.500 850425
55-12 CB-12 CB-14 30494 190 Circ. 1 2500 nfa 0013 2098 858.000 854.000
55-6 CB-6 CB-12 17.408 265.. Circ. 1 2.000 nfa 0.013 1634 864.128 859.652 L
55-13 CB-13 CB-12 12.726 72257 Circ.. 1 2.000 nfa 0.013 1.270 860.569 859.652 T
55-3 CB-3 CB-6 14.399 306... Circ. 1 2000 nfa 0.013 1681 860443 864298
55-8 CB-3 CB-6 2311 6.460 Circ.. 1 1.500 n/a 0.013 9.127 865.388 864.795
55-11 CB-11 CB-13 12.156 211.. Circ. 1 2.000 nfa 0.013 1.611 864.138 860.739
55-1 CB-1 CB-3 1.457 246... Circ. 1 1.500 nfa 0.013 2503 477.090 870.931
55-7 CB-7 CB-3 11.409 19.460 Circ.. 1 2.000 nfa 0.013 0400 860.691 860.613
$5-9 CB-9 CB-11 11.735 126... Circ. 1 2.000 nfa 0.013 1.795 866.570 864.308 i
E D Window Center
ASCII File: ﬂ Edit D Highlight pply

Link Hydraulic Calculations

“ Storm Drain Hydraulic Calculation Summary for Network WEST - Calculations Current = &
Upstream Downstream  Upstream Downstream Uniform Actual
ID 1D 1D HGL HGL Discharge |Capacity Slope |Loss |Velocity Depth | Velocity Depth | «
S55-14 CB-14 EW-1 856.237 851.489 31.612 146.718 4.181 0851 15703 0.982 14.069 1.065
$5-12 CB-12 CB-14 861.997 855.280 30.494 63.904 2097 2031 12181 1.270 12.052 1.280
55-6 CB-6 CB-12 866.140 860.760 17.408 31.583 1.689 0440 9.752 1.107 9.736 1.109 | _
55-13 CB-13 CB-12 862.211 861.997 12.726 27.419 1.277 0141 8129 0897 4.051 2000 |~
S5-3 CB-3 CB-6 872281 865.288 14.399 31554 1.677 1404 9285 0890 9285 0990
S55-8 CB-8 CB-6 866.351 865.120 231 34.138 9.125 0.069 10461 0.274 B8.311 0.322
$5-11 CB-11 CB-13 865.466 861.648 12.156 30.5889 1.604 0.010 8746 0909 8746 0909
55-1 CB-1 CB-3 877.737 871.232 1.457 17.878 2504 0.094 5787 0300 5787 0.300
557 CB-7 CB-3 372.550 872.281 11.409 15.391 0400 0205 5059 1349 3632 2.000
S5-9 CB-9 CB-11 869.185 865.178 11.735 32.600 1.797 1313 9036 0864 8958 0869 ~
E l:‘ Window Center
ASCIl File: al [ Edt [ Highlight
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Exercise 13

13. Storm Drainage Labeling

This exercise shows the user how to use standard labels by labeling the plan and profile views.

The Labeler automates the composition and placement of many types of labels into the dgn
file. This interactive tool permits the creation of very simple to very complex labels.

13.1 Plan View Labeling

a) Open the Drainage Labeler by selecting Utilities > Labeler from the pull down menu or
Drainage Labeler from the Drainage Toolbar.

Drainag...@
i
M DRAINAGE - DrainageProject.gdf - [WEST Active] S ] A
ﬁﬁ éi
| Project Component Metwork Reports | Utilities | Tool Boxes | Egih}£
. Mavigator \-f;-f:
Conflict Finder L
L Qﬂ,ﬁ
Labeler ik 4 1 Drainage Navigator
Display 3D ™, 2 Conflict Finder
DTM Drainage Tools b i i
/ 4 Display 2D Elements

%T 5 DTM Drainage Tools

=1 Open as ToolBox

b) Click on the Style tab, double click Plan Code under the Storm Drainage category and
double click it to make it the active style.

- ™
M Drainage Labeler - Style: ..\tdotdef_drainage.lsf -> Plan Code - Active = o
Style Files Options Scale Tools
| Text || Params. | Shape | Leader | Rotate ":B'i'l' s _ 1
: ———geg=l=i=mri=t=——1=
tem Selector Style Preview £12
[ GrateOut-3 IN = |
@& Inlet Bev %
[ Outlet Blev
4 sows | [ fewm
[ Profile Code [ Clear J [ Delimit
[ Profile Pipe ' == =
_ | Place Label
New Style Update Style... |
New Category Scale : 50.00 é | Node and Shape Only vJ
L™

c) Zoom in to CB-1 in plan view.
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d) Click on the Text tab, then click the Nodes icon and toggle ON Window Center.

e) Click on CB-1 from the node list. Label data is automatically set for that node and view
centers at node location.

,
#4 Drainage Labeler - Style: ...\tdotdef drainage.lsf -> Plan Code - Active =] S
Style Files Options Scale Tools

Params. | Shape | Leader | Rotate | Styles ca-1:
I o iy Computed Insers User Inseds i
Bl W 9 glz

® WG|/

Hement ID| Computed Text

- Nede - 1D "

= Nede - Description = [ é;-:ua-:e ) Rl
Node - Type : : )
Node - Library ltem Name Clear | | Delimt |
Node - Library kem Description 3 =i s
[Node - Reference Chain __F'lac_:e Labe?l_

- |Node - Reference PGL Y
Highlight J| Window Center  Not Awvailable

Automatic Label

f) Select from the pulldown menu: Scale > Change Scale and change to 50.
g) Click the Place Label button on the right of dialog to initiate placement of the label.

h) Move the cursor to position the label and data point to place the label in the vicinity of
CB-1. If the label text is not horizontal to the view or alignment, you may need to go to
the Rotate tab to set the angle prior to placement.

i) Move the cursor around and data point once again to locate the leader line point of
beginning (i.e. where you want the leader to connect to the label).

B View1, Default ===

B-Ou- AVQRES I BE|HEE

J) Click the Style tab and set the active style to GrateOut-0IN with a double click.

k) Click the Text tab and select CB-1. Click Place Label and data point next to the Code
Label to position the text.

NOTE: For catch basins with one or more inlets, elevation labels will require an extra
step to insert the inlet elevation(s).

13-2 Storm Drainage Labeling GEOPAK Drainage V8i (SELECT Series 2)



Exercise 13

I) Place labels for CB-3 which includes 2 inlet pipes.

1. Click the Style tab and set the active style to GrateOut-2IN with a double click.

2. Click the Text tab and select CB-3. Click Place Label and data point next to the
Code Label to position the text.

3. Click the Style tab and set the active style to Inlet Elev with a double click.

4. Click the Text tab and select SS-1. Click Place Label and data point below the GT.
EL. Text placed in step b.

5. Select SS-7. Click Place Label and data point below the IN. EL. Text placed in
step d.

H View1, Default [ |

FEEE

=

m) Place the remaining plan view Node labels.

13.2 Profile View Labeling

Normally the plan view displays most of the data for a catch basin, however, in some
circumstance labels on the profile may be required.

a) Click on the Styles tab and double click on the style Profile Code to activate it.

b) Click on the Rotate tab and click on Current Angle (If needed set to 0)

M Drainage Labeler - Style: ...\tdotdef drainage.lsf -> Profile Code - Active = 28

| StyleFiles Options 5cale Tools

Text | Params. | Shape || Leader Styles ca—;- ;
-—-d-e-1-i-m-i-t——-1-:

Sample Output S
Tl

Text Angle

(2] Cuent Angle: | 0.000

& Bement Angle 3 e
— 5 ' Ret
L.E Alignment Angle: | 0.0 6.4 = pace S um x4
Clear | Delimit |
Set Angle By - e =

[ DP | [Bement| [ AA Place Label
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c) Click on the Text tab and toggle OFF the Window Center Box. This option works with
plan view only.

d) Zoom in on the alignment profile view in the vicinity of CB-1.

e) Click on CB-1 in the node list and then click Place Label.

f) Locate in profile view and place the label.

g) Repeat until all codes are placed for all nodes in the profile view.
Leader Line Optional Steps:

Step 8. Use MicroStation's Match Element Attributes and click on any code
placement.

Step 9. Use MicroStation’s Place Line to place leader lines from code placement to
node.

B Viewl, Default

= E=h >

B-On-ARQRNEHY I BE|HLE

NOTE:

Pipes are automatically annotated correctly for the plans when the preference file
TDOTStormSewerProfiles-Plan.ppf is used for profile display control. When using
label style Profile pipe to label proposed pipes on the profile ...

1) Select the link under the Text tab
2) Go to the Rotate tab and set to Element Angle

3) Click Element button in the Set Angle By portion of the dialog and identify the
bottom of pipe on the profile to set label angle.

4) Data point to place label.
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Exercise 14

14. Design & Computation Manager with
Drainage Links

This exercise shows the user how to use the D&C Manager to control symbology, compute
guantities, which can be used in preliminary estimates, and set pay items for drainage links by

setting the symbology of all pipes and generating pipe quantities for this project.

14.1 Set Link Symbology

a) Select Components > Links > Update With Pay Items from the main menu bar or
Update Links with Pay Items from the Drainage Toolbox.

M DRAINAGE - DrainageProject.gdf - [WEST Active] (e ] Do
Project | Component | Metwork  Reports  Utilities  Tool Boxes & 5
Area 4 @ |/ 1 AddDrainage Link
Node » Em % 2 Edilink
| Lmk » Edd Y“&b ? 3 Id Edit Drainage Link
. -;’ ' 4 Delete Drainage Link
- Edit e - g
EI'DfI|E b H:] ..\‘c'r, 5 / 5 Rename Drainage Link
|
Culvert 3 EJeIete &7 6 Update All Links
Eouting » Eename % 7 Update Links with Pay ltems
Land U - g/cF & Drainage Link Report - Configuration
an =1 0
e ] i < deat& All g/cP 9 Drainage Link Report - Computations
ISCEllaNeauUs HItles -
— | UpdEtE with EE}" Iters | =4 Open as ToolBox

b) Utilize the MicroStation command Fit View to view the entire Drainage Network.

|_;_| &

Fit View

c) Note that the Link symbology has changed to reflect that of the D&C Manager. All links

Jgt~ A ] S ‘{@q ? BIE|HSE

use appropriate custom line styles and are labeled with ST's and pipe size.

= Viewl, Default

| E=H=
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14.2 Label Short Pipe Links

Often we have cases where the pipes are too short for their symbology to show as is
the case with the pipes from various drop inlets just off the roadway in this project. We
have a tool available to handle these with a separate label which is available through
D&C Manager.

a) Open the Design and Computation Manager and select item Drafting Standards>
Prop. Drainage> Label ST Pipe.

A Design and Computation Manager | = | =] ‘i&]
File Edit Settings Favorites Help

& 1d| B2 ¢ ==| | 0|

[T71 Exist. Drainage =
= Prop. Drainage

(=71 Structures in Plan

[ Structures on Profiles

[C71 Crass-drains & Median-drains

(] Storm Sewer Pipes

[ Special Ditches

Plan Cells drainage plan view cells E
Profile Cells drainage profile/culv xsection cells
Rip-Rap Area pattern proposed Rip-Rap area
Flow Direction draw flow direction
Label ST Pipe place proposed storm drainage pipe label
Trench Drain proposed trench drain
18" PrBR drain  proposed 18" Pipe for bridge end drain
£ Guardrail %

b) The Place Prop. Storm Drainage Pipe Label dialog opens and you are prompted to
identify the pipe. Data point on link SS-7, the pipe between CB-7 and CB-3, and the
appropriate text is filled in on the dialog.

By default the label will come up as text only at the angle of the pipe. If there is room,
you can place the label as such along the pipe.

For pipes too short for that, click on the option to Place Label as Flag and click the
Place Label button.

-

Place Prop. Storm Drainage Pipe Label @

" .
Label Text | 18" 5T Scale | 50 J

Iv Place Label as Flag

Identify Fipe
fvPip Flag Terminator Type

Flace Label |N'3""E| j Cancel
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Exercise 14

c) Data point on or near the pipe for the beginning of the leader and once again to position
the label which is shown dynamically.

Place Prop. Storm Drainage Pipe Label

Label Text | 187ST Scale | 50 J
[V Place Label as Flag
Identify Pipe
Flag Terminator Type
Place Label | [Mare =] Cancel

CT. EL.
IN. EL.
M. EL.
ouT. EL.

d) Use the Identify Pipe button to read and label the other short pipe links on the project.

You may wish to use one of the terminator options for pipes in tight places with other
text and line work.

GT. FL.
IN. EL.
[M. EL.
OUT. EL.

Place Prop. Storm Drainage Pipe Label

= F
Label Text 18" 5T Scale | 30 J
Iv Place Label as Flag

Identify Fipe .
Flag Terminator Type
Place Label | |5"""5” Arrow ﬂ Cancel
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14.3 Compute Link Quantities

a) Open the Design and Computation Manager and set the Mode to Compute by clicking
the 'calculator’ icon button.

b) Under Pay Items, highlight the Prop. Drainage category, then click the Add to
Collection button on the Design & Computation Manager toolbar.

( B
M Design and Computation Manager == BN X
File Edit Settings Favorites Help

5 id @ FE% He

£3 Functional
3 Utilties - Plan
(= Pay ttems
£ Curb 70201
£ Curb & Gutter 702-03
(7= Drainage ltems
21 Crossdrains & Median Drains
7 Sidedrains
23 Storm Sewer Fipes
07-41.__ permanent slope drain (all sizes)
g 60745, slotted drain (3l sizes)
10-07.03 18" Pipe Drain (Bridge Drain)
11-05.01 trench drains
11-07.01 class a concrete (pipe endwalls)
611-07.02 steel bar reinforcement (pipe endwalls) i

|Add Highlighted to the Collection

m_

‘E’ Drainage tems

&

c) Within the Plan Quantity Computation box ensure Extents: is set to Active Design File.
Click the Compute Quantities button for initiation of the report. Your results may vary.

e N
M Plan Quantity Computation @E‘_E—hj

Job: | DA Q.  Bderts: |Active Design File | [Inside v][@

Baseline Reference

[Chain =] [cL v | I{ [7] Begin Station: | 0+00.00 | +»
[¥] Range: |100.00 [¥] End Station: | 29+64.02 | i
[¥] Hilight During Computation: | -| l Compute Quartities ]

NOTE: To limit the extent of calculation set Extents: to Station Range, and set the limits
desired in the Baseline Reference portion of the dialog.

d) Select your Export Format. Select CSV By Item for use with standard estimate files.
Type in drainage.csv for the filename and click on Export.

M Computation Results l = ﬁl
ltem Description Cluantity Unit Export
607-03.02 18" storm sewer pipe Class 3 690.00 LF
607-05.02 24" storm sewer pipe Class 3 1002.00 LF
607-06.02 30" storm sewer pipe Class 3 191.00 LF
607-07.02 36" storm sewer pipe Class 3 74.00 LF

Export Fermat; [csvByltem ¥ drainage.csv ﬂ Export ™
Run: Phaze: | DesignEstimate hd
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Exercise 14

In the Estimated Roadway Quantities Excel file use the Import CSV File for Items

command button to import the data compiled with D&C Manager.

NOTE: This function reads only the item number and quantity from the csv file. Item

description and unit are pulled from the official item number listing.

FARE] |= Estimated Roadway Quantitiesl - Microsoft Excel |Elgléj
m Home Insert Page Layout Formulas Data Review View Developer Acrobat & @ o @F@ R
=& - = = = : ) | S=Insertr I -
Arial 10 A A = == ®- =" Wrap Text Text re) L | -
A .. K 33 5o wa
Paste B I U 3 8. A =|= = | &= = SiMerge&Center-| $ - % s | %y 9 Conditional Formatas Cell | .. . Sort & Find &
- - - . & Merg o Formatting © Table = Styles v | = Format 2" Fifter * select ~
Clipboard & Font " Alignment Number Styles Cells Editing
B6 M Je 4
A B [¢ D E 1 K L]
i -
=
2 ESTIMATED ROADWAY QUANTITIES .
These programs can also be accessed under View =
3 NOTE: This estimated roadway quantities file is d
4 ITEM NO. DESCRIPTION UNIT |QuANTITY Project Data worksheet. The worksheets with the,
2
B For more detailed information on use of the Item Pr.
7 607-03.02 18" CONCRETE PIPE CULVERT (CLASS ) LF. 690 http:/iwww tdot state.tn.us/Chief Engineer/assistant
8 607-05.02 24" CONCRETE PIPE CULVERT (CLASS I} LF. 1002
9 607-06.02 | 30" CONCRETE PIPE CULVERT (CLASS Ill) LF. 191 Selectltems Numbers From List ‘ £
10 607-07.02 | 36" CONCRETE PIPE CULVERT (CLASS Ill) LF. 74 1
11 3
12 Fill In Description and Unit ‘ [
13
14 Downlead Items.dat from Web Page ‘ E
15
16
1; Import CSV File for Items | E
19
20 Sort Item Numbers ‘ [
21
22
23 Format Notes Area | i
24
25 3
26 Format Item Numbers | E
27
28
29 1 Column Format
30 [~
|
4 4 » W[ Project Data | Col #1-Est. Rdwy. Quantities -~ Col #2 Est. Rdwy. Quantiies .~ Box Bridge Quantties % 4 [} »
Ready | & | 1= 0% (— Iy] (+)

14.4 Alternate Pay Items for Links
a) Open Edit Link and select Link SS-14.

b) In Definition, under the Configuration portion, toggle ON Override Library Payitem.

ﬂ Link Configuration Definition

e

LinkiD: 4| [s514

= | ﬂ |_' Window Center

2 A ¥ 2 | ey

| Highlight
Details
Options Description:
Deiniion From Node: [CB-14 ] 3| ToNode: b
Conditions Length: 735400 [] use MS Element _II
Constraints Configuration
Computation Shape: |Circular  ~ | Material: |Concrete  ~

Type

l_ Design Size Size: 36 Inch Dia. Circular
O Pipe |_ Design Bamrele Mumber of Barrelz: |1 ¥ | Roughness: | 0.013
() Ditch

IJ_, gOverride Library F'ayitem:i

=l
| Select Payitem .
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c) Click on the calculator button to select an
alternate pay item. Go to Pay Iltems >
Storm Sewer Pipes > 607-07.03 36” storm

sewer pipe Class 4.

Double click on the 36" Class 4 Concrete
pipe item to switch it from the defaulted

Class 3 item number.

NOTE: All circular concrete pipes are set

up with Class 3 concrete pipe item

numbers. When setting up a system of
median drains for depressed grass medians
then all pipes will need to be set to use
alternate pipe item numbers as listed under
D & C manager category Pay Items >
Drainage Items > Crossdrains & Median

Drains.

r 7 |
#, Select Design & Computation Payitem... l =TC X

File

g id

Edit  Settings

Favorites  Help

|OK

H Close |

23 Ltilities - Plan
[ Pay tems
3 Curb 702-01

[ Drainage tems
21 Sidedrains

607-02.02 15"
607-03.02 18"
607-05.02 24"
607-06.02 30"
607-07.02 36"
07-08.02 42"
507-09.02 48"
607-10.02 54"
&4 607-11.03 60"
607-12.03 68"
607-13.03 72"
B07-14.03 78"
607-02.03 15"
607-02.03 18"
607-05.03 24"
B07-06.03 30"
607-07.03 36"
607-08.03 42"

Follow Exercise 14.1 to update the link graphics.

3 Curb & Gutter 702-02
1 Crossdrains & Median Drains

[~ Storm Sewer Pipes

storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 3
storm sewer pipe Class 4
storm sewer pipe Class 4
storm sewer pipe Class 4
storm sewer pipe Class 4
storm sewer pipe Class 4
storm sewer pipe Class 4

d) Click Apply in the Link Configuration Definition dialog to accept the change.

Follow Exercise 14.3 to re-compute the quantities and see the difference.

~

L

ﬂ Computation Results

Run:

Export Format: |[CSV Byltem  ~ | drainage.csv

Phase:

Ql [Create  ~] Export ¥
*) (o)

DesignEstimate

Item Description Quantity Unit Export
607-03.02 18" storm sewer pipe Class 3 690.00 LF
607-05.02 24" storm sewer pipe Class 3 1002.00 LF
607-06.02 30" storm sewer pipe Class 3 191.00 LF
607-07.03 36" storm sewer pipe Class 4 74.00 LF

NOTE: See Appendix G for Pipe Selection Criteria based on system and fill height.
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T.D.O.T. Geopak Drainage Nodes

1) Names for nodes indicate inside length & width dimensions of square structures or inside diameter of circular structures.

2) All values are from T.D.O.T. Standard Roadway Drawings based on concrete pipe.

3) For use with "Min Fixed Drop" option... Minimum Depth of Cover = Minimum Depth of Node - (Pipe Size + Drop Across Bottom of Structure)
with both inlet & outlet pipes of the same size. When node has outlet pipe only or the outlet pipe is larger than the inlet pipe, increase the

minimum depth of cover by the drop across bottom of structure value.

4) If no values are entered under a pipe size this indicates that pipe size is not valid with that node.
5) Any pipe size which includes a "W" with the minimum depth of cover value indicates the pipe size can only be used in the wide side of the structure.

Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
I-Type: Grate Structure Cover Cover Cover Cover Cover Cover

CB#10 32"X26" _ JLowered 6-30 Curh & Grate Inlet  JCB32X26S 0.12] 5.08 3.77 215] 431y 219

CB#10 4X3 6" NonMount. Curb & Grate Inlet CB4X3S 0.17] 20.00 3.90 2.23] 445 228] 499w 232] 5500w 233

CB#10 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIAS 0.17] 20.00 3.89 222 443 2.26

CB#10 4X4 6" NonMount. Curb & Grate Inlet CB4X4S 0.17] 28.00 3.90 2.23] 445 2.28] 499 2.32] 553 2.36

CB#12 32"X32"  |6" NonMount. Curb & Grate Inlet CB32X32 0.12] 458 3.77 2.15] 431 2.19

CB#12 4X3 6" NonMount. Curb & Grate Inlet CB4X3 0.17] 20.00 3.90 223 444 227 498w 231] 55w 235

CB#12 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIA 0.17] 20.00 3.89 222 443 2.26

CB#12 4X4 6" NonMount. Curb & Grate Inlet CB4X4 0.17] 28.00 3.90 2.23] 445 2.28] 499 2.32] 553 2.36

CB#12 5' DIA 6" NonMount. Curb & Grate Inlet CB5DIA 0.21] 40.00 3.94 2.23] 448 227 5.02 2.31] 556 2.35] 6.11 2.40

CB#12 52"X52" |6" NonMount. Curb & Grate Inlet CB62X62 0.22] 28.00 4.12 2401 4.66 2.44) 520 248] 5.74 252 6.29 257

CB#12 6' DIA 6" NonMount. Curb & Grate Inlet CB6DIA 0.25] 40.00 3.98 2.23] 453 2.28] 5.07 2.32] 561 2.36] 6.15 2.40

CB#12 7' DIA 6" NonMount. Curb & Grate Inlet CB7DIA 0.29] 40.00 4.36 2571  4.90 2.61] 545 2.66] 5.99 2.700 653 2.74

CB#12 7X7 6" NonMount. Curb & Grate Inlet CB7X7 0.29] 28.00 4.20 241] 474 2.45] 5.28 249] 582 253 6.37 2.58

CB#12 8' DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.00 4.41 258] 4.95 2.62] 549 2.66] 6.03 2.70) 657 2.74

CB#12 9' DIA 6" NonMount. Curb & Grate Inlet CBYDIA 0.38] 40.00 4.45 2571  4.99 2.61] 554 2.66] 6.08 270 6.62 2.74

CB#12 9X9 6" NonMount. Curb & Grate Inlet CB9X9 0.38] 28.00 4.29 241] 483 2.45) 537 249] 591 253] 6.45 2.57

CB#12 10' DIA  |6" NonMount. Curb & Grate Inlet CB10DIA 0.42] 40.00 4.50 2.58] 5.04 2.62] 558 2.66] 6.12 2.70] 6.66 2.74

CB#13 4X3 6" NonMount. Curb & Grate Inlet CB4X3 0.17] 12.00 3.90 223 444 227 498w 231] 55w 235

CB#13 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIA 0.17] 20.00 3.89 222 443 2.26

CB#135' DIA 6" NonMount. Curb & Grate Inlet CB5DIA 0.21] 40.00 3.94 223 448 2.27] 5.02 231 556 235] 6.11 2.40
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Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.

of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of

Type: Grate Structure Cover Cover Cover Cover Cover Cover

CB#13 6' DIA 6" NonMount. Curb & Grate Inlet CB6DIA 0.25] 40.00 3.98 2.23] 453 2.28] 507 2.32] 561 2.36] 6.15 2.40

CB#13 7' DIA 6" NonMount. Curb & Grate Inlet CB7DIA 0.29] 40.00 4.36 2571  4.90 2.61] 545 2.66] 5.99 2.700 653 2.74

CB#13 8'DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.00 4.41 2.58] 459 2.62] 549 2.66] 6.03 2700 657 2.74

CB#13 9' DIA 6" NonMount. Curb & Grate Inlet CBIDIA 0.38] 40.00 4.45 257  4.99 2.61] 554 2.66] 6.08 2.70) 6.62 2.74

CB#1310'DIA  }6" NonMount. Curb & Grate Inlet CB10DIA 0.42] 40.00 4.50 2.58] 5.04 2.62] 558 2.66] 6.12 2.700 6.66 2.74

CB#14 8X3 6" NonMount. Curb & Grate Inlet CB8X3 0.33] 10.00 4.06 2.23] 461 228] 5150w 232] 5690w 236] 6.23]w 240

CB#14 8' DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.00 4.41 2.58] 4.95 2.62] 549 2.66] 6.03 2.700 6.57 2.74

CB#14 9X9 6" NonMount. Curb & Grate Inlet CBIX9 0.38] 28.00 4.45 2571  4.99 2.61] 554 2.66] 6.08 2.70 6.62 2.74

CB#16 8X4 6" NonMount. Curb & Grate Inlet CB8X4 0.33] 20.00 4.07 2.24] 461 2.28] 5.15 2.32] 5.70 237 6.24qw 241

CB#17 8X5'2" 6" NonMount. Curb & Grate Inlet CB8X62 0.33] 20.00 4.24 241] 478 2.45) 532 2.49] 5.86 2.53] 6.40 2.57

CB#25 32"X32"  |6" Mountable Curb & Grate Inlet CB32X32 0.12] 458 3.77 2.15] 431 2.19

CB#25 4X3 6" Mountable Curb & Grate Inlet CB4X3 0.17] 12.00 3.90 223] 444 227) 498w 231] 55w 235

CB#25 4' DIA 6" Mountable Curb & Grate Inlet CB4DIA 0.17] 20.00 3.89 2.22] 443 2.26

CB#25 4X4 6" Mountable Curb & Grate Inlet CB4X4 0.17] 28.00 3.90 2.23] 445 2.28) 499 2.32] 553 2.36

CB#25 5' DIA 6" Mountable Curb & Grate Inlet CB5DIA 0.21] 40.00 3.94 2.23] 448 2.27] 5.02 2.31] 556 235) 6.11 2.40

CB#2552"X5'2" |6" Mountable Curb & Grate Inlet CB62X62 0.22] 28.00 4.12 240] 4.66 2.44] 520 248] 574 252 6.29 2.57

CB#25 6' DIA 6" Mountable Curb & Grate Inlet CB6DIA 0.25] 40.00 3.98 2.23] 453 2.28] 507 2.32] 561 2.36] 6.15 2.40

CB#25 7' DIA 6" Mountable Curb & Grate Inlet CB7DIA 0.29] 40.00 4.36 257] 5.90 361] 545 2.66] 5.99 2.700 653 2.74

CB#25 7X7 6" Mountable Curb & Grate Inlet CB7X7 0.29] 28.00 4.28 249] 482 2.53] 537 2.58] 591 2.62] 6.45 2.66

CB#25 8' DIA 6" Mountable Curb & Grate Inlet CB8DIA 0.33] 40.00 4.41 2.58] 4.98 2.62] 549 2.66] 6.03 2.700 657 2.74

CB#25 9X9 6" Mountable Curb & Grate Inlet CBIX9 0.38] 28.00 4.29 241] 483 2.45) 537 249] 591 2.53] 6.45 2.57

CB#26 8X3 6" Mountable Curb & Grate Inlet CB8X3 0.33] 10.00 4.06 2.23] 461 228] 5150w 232] 569w 236] 6.23]w 240

CB#27 8X4 6" Mountable Curb & Grate Inlet CB8X4 0.33] 20.00 4.07 2.24] 461 2.28] 5.15 2.32] 5.70 237  6.24qw 241

CB#28 32"X32" _ J4" Mountable Curb & Grate Inlet CB32X32 0.12] 458 3.77 2.15] 431 2.19

CB#28 4X3 4" Mountable Curb & Grate Inlet CB4X3 0.17] 12.00 3.90 223 444 227 498w 231] 55Qw 235

CB#28 4' DIA 4" Mountable Curb & Grate Inlet CB4DIA 0.17] 20.00 3.89 222) 443 2.26
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Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
Type: Grate Structure Cover Cover Cover Cover Cover Cover
CB#28 5' DIA 4" Mountable Curb & Grate Inlet CB5DIA 0.21] 40.00 3.94 2.23] 448 2.27] 5.02 2.31] 556 235] 6.11 2.40
CB#28 6' DIA 4" Mountable Curb & Grate Inlet CB6DIA 0.25] 40.00 3.98 223 453 2.28] 5.07 2.32] 561 2.36] 6.15 2.40
CB#28 7' DIA 4" Mountable Curb & Grate Inlet CB7DIA 0.29] 40.00 4.36 257  4.90 2.61] 545 2.66] 5.99 2.70] 6.53 2.74
CB#28 8' DIA 4" Mountable Curb & Grate Inlet CB8DIA 0.33] 40.00 4.41 2.58] 4.95 2.62] 549 2.66] 6.03 2.70] 657 2.74
CB#29 8X3 4" Mountable Curb & Grate Inlet CB8X3 0.33] 10.00 4.06 223) 461 228] 5150w 232] 569w 2.36] 6.23JwW 240
CB#31 7' DIA IMed. Barrier Curb & Grate Inlet CB7DIAC 0.29] 40.00 4.36 257  4.90 2.61] 545 2.66] 5.99 2.70] 6.53 2.74
CB#31 7X7 JVed. Barrier Curb & Grate Inlet CB7X7C 0.29] 28.00 4.37 2.58] 491 2.62] 545 2.66] 5.99 2.70] 6.53 2.74
CB#31 9X9 JVed. Barrier Curb & Grate Inlet CB9X9C 0.38] 28.00 4.45 257 499 2.61] 554 2.66] 6.08 2.70] 6.62 2.74
CB#32 32'X80"  Med. Barrier Curb & Grate Inlet CB32X80C 0.12] 6.00 3.77 2.15] 431 2.19
CB#38 32'X32"  |Median Ditch Grate CB32X32M 0.12] 4.58 2.94 1.32] 3.48 1.36
CB#38 4X4 JVedian Ditch Grate CB4X4M 0.17] 28.00 3.82 2.15] 4.36 2.19] 4.90 2.23] 545 2.28
CB#38 5' DIA Jvedian Ditch Grate CB5DIAM 0.21] 40.00 3.94 223) 448 2.27] 5.02 231] 556 2.35] 6.11 2.40
CB#38 52'X5?2" |Median Ditch Grate CB62X62M 0.22] 28.00 4.04 2.32) 458 2.36] 5.12 2.40) 5.66 244] 620 2.48
CB#38 6' DIA JMedian Ditch Grate CB6DIAM 0.25] 40.00 3.98 2.23] 453 2.28] 5.07 2.32] 561 2.36] 6.15 2.40
CB#38 7' DIA JMedian Ditch Grate CB7DIAM 0.29] 40.00 4.36 257  4.90 2.61] 545 2.66] 5.99 2.70] 6.53 2.74
CB#38 8' DIA JMedian Ditch Grate CB8DIAM 0.33] 40.00 4.41 2.58] 4.95 2.62] 549 2.66] 6.03 2.70] 657 2.74
CB#39 4X4 JMedian Ditch Grate CB4X4M 0.17] 28.00 2.99 1.32] 3.53 1.36] 4.07 140 4.61 1.44
CB#39 52"X5?2" |Median Ditch Grate CB62X62M 0.22] 28.00 4.08 2360 462 240] 5.16 2.44) 570 248] 6.24 2.52
CB#39 7' DIA JMedian Ditch Grate CB7DIAM 0.29] 40.00 4.32 2.53] 4.86 2.57] 5.40 2.61] 5.95 2.66] 6.49 2.70
CB#39 7X7 JVedian Ditch Grate CB7X7M 0.29] 28.00 4.16 2371 470 241] 524 2.45] 578 249] 6.32 2.53
CB#39 8' DIA JVedian Ditch Grate CB8DIAM 0.33] 40.00 4.45 2.62] 4.99 2.66] 5.53 2.70) 6.07 2.74] 6.62 2.79
CB#39 9X9 JVedian Ditch Grate CBIX9IM 0.38] 28.00 4.24) 2360  4.79 241] 533 2.45) 587 249] 641 2.53
CB#40 8X4 JVedian Ditch Grate CB8X4M 0.33] 20.00 3.15 132 3.70 137] 4.24 141)  4.78 1450 532w 149
CB#40 9X9 JVedian Ditch Grate CBIX9IM 0.38] 28.00 441 253)  4.95 257] 549 2.61] 6.04 2.66] 6.58 2.70
CB#41 32"X32"  |Med. Barrier Curb & Grate Inlet CB32X32B 0.12] 4.58 3.77 215) 431 2.19
CB#41 4X3 IMed. Barrier Curb & Grate Inlet CB4X3B 0.17] 20.00 3.90 223 444 227 498)w  231] 55w 235
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Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
Type: Grate Structure Cover Cover Cover Cover Cover Cover
CB#41 4X4 IMed. Barrier Curb & Grate Inlet CB4X4B 0.17] 28.00 3.90 2.23] 445 2.28]  4.99 2.32] 553 2.36
CB#415' DIA JMed. Barrier Curb & Grate Inlet CB5DIAB 0.21] 40.00 3.94 2.23] 448 2.27] 5.02 2.31] 556 2.35) 6.11 2.40
CB#415'2'X572"  [Med. Barrier Curb & Grate Inlet CB62X62B 0.22] 28.00 4.12 240] 4.66 2.44] 520 248] 574 252 6.29 2.57
CB#41 6' DIA JMed. Barrier Curb & Grate Inlet CB6DIAB 0.25] 40.00 3.98 2.23] 453 2.28] 507 2.32] 561 2.36] 6.15 2.40
CB#41 7' DIA JMed. Barrier Curb & Grate Inlet CB7DIAB 0.29] 40.00 4.36 2571  4.90 2.61] 545 2.66] 5.99 2.700 653 2.74
CB#41 7X7 IMed. Barrier Curb & Grate Inlet CB7X7B 0.29] 28.00 4.20 241 474 2.45] 528 249] 582 2.53) 6.37 2.58
CB#41 8' DIA JMed. Barrier Curb & Grate Inlet CB8DIAB 0.33] 40.00 4.41 2.58] 4.95 2.62] 549 2.66] 6.03 2.700 6.57 2.74
CB#41 9X9 JMed. Barrier Curb & Grate Inlet CBIX9B 0.38] 28.00 4.29 241] 483 2.45) 537 249] 591 2.53] 6.45 2.57
CB#42 32'X32"  [Drop Inlet Grate DI32X32 0.12] 5.08 2.94 132] 348 1.36
CB#42 4X4 Jorop Inlet Grate DI4X4 0.17] 28.00 3.82 2.15] 436 2.19]  4.90 2.23] 545 2.28
CB#42 5' DIA Jorop Inlet Grate DI5DIA 0.21] 40.00 3.94 2.23] 448 2.27] 5.02 2.31] 556 2.35] 6.11 2.40
CB#42 5°2'X52" |Drop Inlet Grate DI62X62 0.22] 28.00 4.04 2.32] 458 236) 512 240] 5.66 244)  6.20 248
CB#42 6' DIA |Drop Inlet Grate DI6DIA 0.25] 40.00 3.98 2.23] 453 2.28] 507 2.32] 561 2.36] 6.15 2.40
CB#42 7' DIA JDrop Inlet Grate DI7DIA 0.29] 40.00 4.36 2571  4.90 2.61] 545 2.66] 5.99 2.700 653 2.74
CB#42 7X7 JDrop Inlet Grate DI7X7 0.29] 28.00 4.28 249] 482 253 537 258] 591 2.62] 6.45 2.66
CB#42 8' DIA JDrop Inlet Grate DISDIA 0.33] 40.00 4.41 2.58] 4.95 2.62] 549 2.66] 6.03 2700 657 2.74
CB#43 8X4 JDrop Inlet Grate DI8X4 0.33] 20.00 3.99 2.16] 453 220 507 2.24] 561 228] 6150w 232
CB#43 8X52"  [Drop Inlet Grate DIBX62 0.33] 20.00 4.15 2.32] 470 23701 524 241] 578 245) 6.32 2.49
CB#43 8' DIA Jorop Inlet Grate DIBDIA 0.33] 40.00 4.32 249] 487 2.54] 541 2.58] 5.95 2.62] 6.49 2.66
CB#44 9X9 Jorop Inlet Grate DI9X9 0.38] 28.00 4.37 249] 491 2.53] 545 2.57] 5.99 2.61] 6.54 2.66
CB#45 8X4 JMed. Barrier Curb & Grate Inlet CB8X4B 0.33] 20.00 4.07 2.24] 461 2.28] 5.15 2.32] 5.70 227 624w 241
CB#46 9X9 JMed. Barrier Curb & Grate Inlet CBIX9C 0.38] 28.00 4.45 2571  4.99 2.61] 554 2.66] 6.08 2.70 6.62 2.74
CB#51 52'X52" JRetaining Wall Curb & Grate Inlet ~ JCB62X62R 0.22] 28.00 4.12 240] 4.66 2.44) 5.0 248] 5.74 252 6.24 2.52
CB#51 7X7 JRetaining Wall Curb & Grate Inlet  JCB7X7R 0.29] 28.00 4.37 258] 491 2.62] 545 2.66] 5.99 2.700 653 2.74
CB#51 9X9 JRetaining Wall Curb & Grate Inlet ~ JCBIX9R 0.38] 28.00 4.62 2.74] 5.16 2.78] 570 2.82] 6.24 2.86] 6.79 291
CB#52 9X9 JRetaining Wall Curb & Grate Inlet ~ JCBIX9R 0.38] 28.00 4.62 274 516 2.78] 5.70 282 6.24 2.86] 6.79 2.91
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Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
IT‘ype: Junction Structure Cover Cover Cover Cover Cover Cover
MH#3 4' DIA IManhole MH4DIA 0.17) 40.00 3.89 2.22 4.43 2.26
MH#3 5'DIA |Manh0|e MH5DIA 0.21] 40.00 3.94] 2.23 4.48 2.27 5.02 2.31 5.56 2.35 6.11] 2.40)
MH#3 5'2"X5'2" |Manh0|e MH62X62 0.22] 28.00 4.18 2.46 4.72 2.50 5.26) 2.54] 5.81 2.59 6.35) 2.63]
MH#3 6' DIA [Manhole MH6DIA 0.25] 40.00 3.98 2.23 453 2.28 5.07 2.32 5.61 2.36 6.15) 2.40)
MH#3 7' DIA [Manhole MH7DIA 0.29] 40.00 4.36 2.57 4.90 2.61 5.45) 2.66) 5.99 2.70 6.53] 2.74)
MH#3 7X7 [Manhole MH7X7 0.29] 28.00 4.43 2.64] 4.97 2.68 5.51 2.72 6.05 2.76 6.60) 2.81
MH#3 8' DIA [Manhole MH8DIA 0.33] 40.00 4.41) 2.58 4.95 2.62 5.49 2.66) 6.03 2.70 6.57 2.74)
MH#3 9' DIA JManhole MH9DIA 0.38] 40.00 4.45 257 4.99 2.61] 554 2.66] 6.08 2.70) 6.62 2.74
MH#3 9X9 JManhole MH9X9 0.38] 28.00 4.43 2550 497 259 551 2.63] 6.06 2.68] 6.60 2.72
MH#310'DIA  JManhole MH10DIA 0.42] 40.00 4.50 2.58] 5.04 2.62] 558 2.66] 6.12 2.70]  6.66 2.74
JB#1 32"X32" Junction Box* JB32X32 0.12] 50.00 3.29 1.67] 3.83 1.71
JB#?2 4X4 Junction Box* JB4X4 0.17] 50.00 3.29 1.62] 3.83 1.66] 4.38 171 4.92 1.75
JB#3 5'2"X52"  JJunction Box* JB62X62 0.22] 50.00 3.63 191 4.17 1950 4.71 199 5.25 2.03] 5.79 2.07
JB#4 7TX7 Junction Box* JB7X7 0.29] 30.00 3.83 2.04] 4.38 2.09 4.92 2.13] 5.46 2.17 6.00] 2.21
JB#5 9X9 Junction Box* JBIX9 0.38] 30.00 4.17, 2.29 4.71) 2.33 5.25) 2.37 5.79 2.41 6.33] 2.45)
JB#6 4' DIA Junction Box* JB4DIA 0.17] 20.00 3.88 2.21 4.42 2.25
JB#6 5' DIA Junction Box* JB5DIA 0.21] 40.00 3.92 221 446 2.25] 5.00 2.29] 555 2.34] 6.09 2.38
JB#6 6' DIA Junction Box* JB6DIA 0.25] 40.00 3.97 2.22 451 2.26 5.05) 2.30] 5.59 2.34] 6.13] 2.38]
JB#6 7' DIA Junction Box* JB7DIA 0.29] 40.00 4.34] 2.55 4.88 2.59 5.42 2.63] 5.97 2.68 6.51 2.72
JB#6 8' DIA Junction Box* JBSDIA 0.33] 40.00 4.38 2.55 4.92 2.59 5.46) 2.63] 6.00 2.67 6.54] 2.71
JB#6 9' DIA Junction Box* JBIDIA 0.38] 40.00 4.42 254]  4.96 2.58] 550 2.62] 6.04 2.66] 6.58 2.70
JB#6 10' DIA Junction Box* JB10DIA 0.42] 40.00 4.46 2.54]  5.00 2.58] 554 2.62] 6.08 2.66] 6.63 2.71
Stub Stub into Culvert STUB 0.00§ none] 0.00 0.00 0.00 0.00 0.00 0.00 0.00; 0.00; 0.00 0.00 0.00; 0.00;
* Maximum Depth for use in Geopak equals tabulated depth (to top of structure) + Minimum Depth based on pipe size.
Add an additional 2 feet for mimimum cover over structure to Minimum Depth of Cover if junction box is within the clear zone.
Type: Outlet
Pipe
Endwall Endwall for outlet pipe(generic) EW 0.00} Size* 1.25 0.00] 150 0.00] 2.00 0.00] 250 0.00] 3.00 0.00] 3.0 0.00
Outlet Stub Stub into existing structure STUB 0.00] none 0.00 0.0001  0.00 0.000  0.00 0.0001  0.00 0.000  0.00 0.0001  0.00 0.00
Ditch Outlet Special ditch end STUB 0.00} none 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00

* During initial design, set the Maximum Depth to a value greater than the expected pipe size and the Minimum Depth of Cover to 0.00. Once pipe s

size + the distance to the top lip of the endwall to be used with the pipe and reset the Minimum Depth of Cover to the distance to the top lip of the endwall.

ze is determined, reset the Maximum Depth to the designed pipe
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Table A Pipe Sizes 15" - 42"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 15 18 24 30 36 42
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
—_— Structure Cover Cover Cover Cover Cover Cover
Type: Other
Pipe
EW Inlet JEndwall inlet into drainage system JEW 0.00] Size* 1.25 0.00 1.50 0.00 2.00 0.00 2.50 0.00 3.00 0.00 3.50 0.00
Ditch Begin IBegin special ditch STUB 0.00] none 0.00 0.00] 0.00 0.000 0.00 0.00] 0.00 0.000 0.00 0.00] 0.00 0.00
Ditch Change |Specia| ditch shape change STUB 0.00] none 0.00 0.00] 0.00 0.00p 0.00 0.00] 0.00 0.00p 0.00 0.00] 0.00 0.00

* During initial design, set the Maximum Depth to a value greater than the expected pipe size and the Minimum Depth of Cover to 0.00. Once pipe size is determined, reset the Maximum Depth to the designed pipe size +
the distance to the top lip of the endwall to be used with the pipe and reset the Minimum Depth of Cover to the distance to the top lip of the endwall.

Type: Headwall |

Culvert Endwall__JPipe Culvert Endwall(generic) EW 0.00] none 0.00 0.000  0.00 0.00] 0.00 0.000  0.00 0.00] 0.00 0.000  0.00 0.00
ﬁype: Grate - Bridge Drains
IBD 2'X8'7" IBridge End Drain BD2X8 0.00 3.50 3.50 2.00
|BD 4'X8'7" |Bridge End Drain BD4X8 0.00 3.50 3.50 2.00
| | 6 9
|zD 2:x9" Jzricge Deck Drain BDIX2 000] 150] 1.25] 075]  150] 0.75 | | | | | | | |
Type: Curb - Bridge Drains

BD-PRPT [Bridge Deck Drain - Parapet BDPRPT 0.00f none | 0.00] 0.00]  0.00] 0.00]  0.00] 0.00]  0.00] 0.00]  0.00] 0.00] 0.00] 0.00]
'Type: Slotted Drain 12" CMP 15" CMP 18" CMP 24" CMP 30" CMP 36" CMP

SD 12" Slotted Drain SLOT12 0.00 1.50) 1.50 0.50

SD 15" Slotted Drain SLOT15 0.00] 1.75 1.75 0.50

SD 18" Slotted Drain SLOT18 0.00]  2.00 2.00 0.50

SD 24" Slotted Drain SLOT24 0.00] 2.50 2.50 0.50

SD 30" Slotted Drain SLOT30 0.00] 3.00 3.00 0.50

SD 36" Slotted Drain SLOT36 0.00] 350 3.50 0.50
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Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 48 54 60 66 72 78
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
[Fype orate | Structure Cover Cover Cover Cover Cover Cover

CB#10 32"X26"  JLowered 6-30 Curb & Grate Inlet CB32X26S 0.12] 5.08

CB#10 4X3 6" NonMount. Curb & Grate Inlet CB4X3S 0.17] 20.00

CB#10 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIAS 0.17] 20.00

CB#10 4X4 6" NonMount. Curb & Grate Inlet CB4X4S 0.17] 20.00

CB#12 32"X32"  |6" NonMount. Curb & Grate Inlet CB32X32 0.12] 458

CB#12 4X3 6" NonMount. Curb & Grate Inlet CB4X3 0.17] 20.00

CB#12 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIA 0.17] 20.00

CB#12 4X4 6" NonMount. Curb & Grate Inlet CB4X4 0.17] 28.00

CB#12 5' DIA 6" NonMount. Curb & Grate Inlet CB5DIA 0.21] 40.00] 6.65 2.44

CB#12 52"X5'2" |6" NonMount. Curb & Grate Inlet CB62X62 0.22] 28.00] 6.83 2.61

CB#12 6' DIA 6" NonMount. Curb & Grate Inlet CB6DIA 0.25] 40.00] 6.69 2.44

CB#12 7' DIA 6" NonMount. Curb & Grate Inlet CB7DIA 0.29] 40.000 7.07 2.78) 761 282] 815 286] 870 291] 9.4 295 9.78 2.99

CB#12 7X7 6" NonMount. Curb & Grate Inlet CB7X7 0.29] 28.00] 6.91 262 745 266] 7.99 2.70] 883 3.04

CB#12 8'DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.00] 7.12 2.79] 7.66 283] 820 287] 874 291] 9.28 295 9.83 3.00

CB#12 9' DIA 6" NonMount. Curb & Grate Inlet CBIDIA 0.38] 40.00] 7.16 2.78) 7.70 282] 825 287] 879 291] 933 295 9.87 2.99

CB#12 9X9 6" NonMount. Curb & Grate Inlet CB9X9 0.38] 28.00] 6.99 261] 754 2.66] 8.08 2.70] 862 274 9.16 2.78] 9.70 2.82

CB#12 10' DIA 6" NonMount. Curb & Grate Inlet CB10DIA 0.42] 40.00] 721 279) 7.75 283] 829 287] 883 291) 9.37 295 9.92 3.00

CB#13 4X3 6" NonMount. Curb & Grate Inlet CB4X3 0.17] 12.00

CB#13 4' DIA 6" NonMount. Curb & Grate Inlet CB4DIA 0.17] 20.00

CB#13 5' DIA 6" NonMount. Curb & Grate Inlet CB5DIA 0.21] 40.00] 6.65 2.44

CB#13 6' DIA 6" NonMount. Curb & Grate Inlet CB6DIA 0.25] 40.00] 6.69 2.44

CB#13 7' DIA 6" NonMount. Curb & Grate Inlet CB7DIA 0.29] 40.00] 7.07 2.78] 761 282] 815 286] 870 291] 9.4 295 9.78 2.99

CB#13 8' DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.00] 7.12 2.79] 7.66 283] 820 287] 874 291] 958 325 9.83 3.00

CB#13 9' DIA 6" NonMount. Curb & Grate Inlet CB9DIA 0.38] 40.00] 7.16 2.78) 7.70 282] 825 287] 879 291] 933 295 9.87 2.99

CB#13 10' DIA 6" NonMount. Curb & Grate Inlet CB10DIA 0.42] 40.00] 721 279) 7.75 283] 829 287] 883 291) 9.37 295 9.92 3.00

CB#14 8X3 6" NonMount. Curb & Grate Inlet CB8X3 0.33] 10.00] 6.77]w 244 731]W 248 786QW  2.53

Vv XIpuaaay



SopoN abeulelq Medosas '1'0'A’'L 8-V

(z seas 10313S) 18A abeureig MVdOID

Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 48 54 60 66 72 78
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
I‘I'ype:T Structure Cover Cover Cover Cover Cover Cover

CB#14 8' DIA 6" NonMount. Curb & Grate Inlet CB8DIA 0.33] 40.004 7.12 2.79] 7.66 2.83] 8.20 2.87] 8.74 2.91

CB#14 9X9 6" NonMount. Curb & Grate Inlet CBIX9 0.38] 28.00] 7.16 2.78] 7.70 2.82] 8.25 2.87] 8.79 291 9.33 2.95] 9.87 2.99

CB#16 8X4 6" NonMount. Curb & Grate Inlet CB8X4 0.33] 20.00] 6.78)W 245 7.32)W 249 7860 W 253

CB#17 8X5'2" 6" NonMount. Curb & Grate Inlet CB8X62 0.33] 20.00] 6.95 2.62] T749\W  2.66 8.03JW 270

CB#25 32"X32" 16" Mountable Curb & Grate Inlet CB32X32 0.12] 4.58

CB#25 4X3 6" Mountable Curb & Grate Inlet CB4X3 0.17] 12.00

CB#25 4' DIA 6" Mountable Curb & Grate Inlet CB4DIA 0.17] 20.00

CB#25 4X4 6" Mountable Curb & Grate Inlet CB4Xx4 0.17) 28.00

CB#25 5' DIA 6" Mountable Curb & Grate Inlet CB5DIA 0.21] 40.00] 6.65 2.44] 7.9 248) 7.73 2.52] 8.27 2.56

CB#25 5'2"X5'2" 6" Mountable Curb & Grate Inlet CB62X62 0.22] 28.00] 6.83 2.61

CB#25 6' DIA 6" Mountable Curb & Grate Inlet CB6DIA 0.25] 40.00] 6.69 244 7.23 248) 7.78 2.53] 8.32 2.57

CB#25 7' DIA 6" Mountable Curb & Grate Inlet CB7DIA 0.29] 40.00§ 7.07 2.78] 761 2.82] 8.5 2.86] 8.70 2.91

CB#25 7X7 6" Mountable Curb & Grate Inlet CB7X7 0.29] 28.00] 6.99 2.70] 753 2.74] 8.08 2.79] 8.62 2.83

CB#25 8' DIA 6" Mountable Curb & Grate Inlet CB8DIA 0.33] 40.00F 7.12 2.79] 7.66 2.83] 8.20 2.87] 8.74 2.9

CB#25 9X9 6" Mountable Curb & Grate Inlet CBIX9 0.38] 28.00] 6.99 2.61] 7.54 2.66] 8.08 2.70] 8.62 2.74)  9.16 2.78] 9.70 2.82

CB#26 8X3 6" Mountable Curb & Grate Inlet CB8X3 0.33] 1000y 6.77)w 244 73w 248 7.86] W 2.53

CB#27 8X4 6" Mountable Curb & Grate Inlet CB8X4 0.33] 20.00] 6.78)w 245 7320w 249 7.86] W 2.53

CB#28 32"X32" 4" Mountable Curb & Grate Inlet CB32X32 0.12] 4.58

CB#28 4X3 4" Mountable Curb & Grate Inlet CB4X3 0.17] 12.00

CB#28 4' DIA 4" Mountable Curb & Grate Inlet CB4DIA 0.17] 20.00

CB#28 5' DIA 4" Mountable Curb & Grate Inlet CBS5DIA 0.21] 40.00] 6.65 2.44] 7.9 248) 7.73 2.52] 8.27 2.56

CB#28 6' DIA 4" Mountable Curb & Grate Inlet CB6DIA 0.25] 40.00] 6.69 2.44] 7.23 248) 7.78 2.53] 8.32 2.57

CB#28 7' DIA 4" Mountable Curb & Grate Inlet CB7DIA 0.29] 40.00§ 7.07 2.78] 761 2.82] 8.5 2.86] 8.70 2.91

CB#28 8' DIA 4" Mountable Curb & Grate Inlet CB8DIA 0.33] 40.00f 7.12 2.79] 7.66 2.83] 8.20 2.87] 8.74 2.91

CB#29 8X3 4" Mountable Curb & Grate Inlet CB8X3 0.33] 10.00] 6.77]y 244 731w 248 786w 2.53

CB#31 7' DIA JMed. Barrier Curb & Grate Inlet CB7DIAC 0.29] 40.00f 7.07 2.78] 761 2.82] 8.5 2.86
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Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
s;):]ee Description Name Qg;toosni Depth 78 = 50 3 =5 s
of Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
W Structure Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of
cover cover cover cover cover cover

CB#31 7X7 JMed. Barrier Curb & Grate Inlet CB7X7C 0.29] 28.00] 7.07 2.78] 7.62 283] 816 287] 870 291

CB#31 9X9 IMed. Barrier Curb & Grate Inlet CB9X9C 0.38] 28.00 7.16 2.78 7.70 2.82 8.25 2.87 8.79 291 9.33 2.95 9.87 2.99
CB#32 32"X80" IMed. Barrier Curb & Grate Inlet CB32X80C 0.12 6.00

CB#38 32"X32" IMedian Ditch Grate CB32X32M 0.12 4.58

CB#38 4X4 IMedian Ditch Grate CB4X4M 0.17] 28.00

CB#38 5'DIA IMedian Ditch Grate CB5DIAM 0.21] 40.00 6.65 2.44 7.19 2.48 7.73 2.52 8.27 2.56

CB#38 5'2"X5'2" IMedian Ditch Grate CB62X62M 0.22] 28.00 6.74 2.52

CB#38 6' DIA IMedian Ditch Grate CB6DIAM 0.25] 40.00 6.69 2.44 7.23 2.48 7.78 2.53 8.32 2.57

CB#38 7' DIA IMedian Ditch Grate CB7DIAM 0.29]1 40.00 7.07 2.78 7.61 2.82 8.15 2.86 8.70 291

CB#38 8' DIA IMedian Ditch Grate CB8DIAM 0.33] 40.00 7.12 2.79 7.66 2.83 8.20 2.87 8.74 291

CB#39 4X4 IMedian Ditch Grate CB4X4M 0.17] 28.00

CB#39 5'2"X52" IMedian Ditch Grate CB62X62M 0.22] 28.00 6.79 2.57

CB#39 7' DIA IMedian Ditch Grate CB7DIAM 0.29] 40.00 7.03 2.74 7.57 2.78 8.11 2.82 8.66 2.87

CB#39 7X7 IMedian Ditch Grate CB7X7TM 0.29]1 28.00 6.87 2.58 741 2.62 7.95 2.66 8.49 2.70

CB#39 8' DIA IMedian Ditch Grate CB8DIAM 0.33] 40.00 7.16 2.83 7.70 2.87 8.24 291 8.78 2.95

CB#39 9X9 IMedian Ditch Grate CBIX9M 0.38] 28.00 6.95 2.57 7.50 2.62 8.04 2.66 8.58 2.70 9.12 2.74 9.66 2.78
CB#40 8X4 IMedian Ditch Grate CB8X4M 0.33] 20.00 586w 153 6.40Qyy 157 6950w 162

CB#40 9X9 IMedian Ditch Grate CBIX9M 0.38] 28.00 7.12 2.74 7.66 2.78 8.20 2.82 8.75 2.87 9.59 3.21 9.83 2.95
CB#41 32"X32" IMed. Barrier Curb & Grate Inlet CB32X32B 0.12 4.58

CB#41 4X3 IMed. Barrier Curb & Grate Inlet CB4X3B 0.17] 12.00

CB#41 4X4 IMed. Barrier Curb & Grate Inlet CB4X4B 0.17] 28.00

CB#415'DIA IMed. Barrier Curb & Grate Inlet CB5DIAB 0.21] 40.00 6.65 2.44 7.19 2.48 7.73 2.52 8.27 2.56

CB#415'2"X52" IMed. Barrier Curb & Grate Inlet CB62X62B 0.22] 28.00 6.83 2.61

CB#416' DIA IMed. Barrier Curb & Grate Inlet CB6DIAB 0.25] 40.00 6.69 2.44 7.23 2.48 7.78 2.53 8.23 2.48

CB#41 7' DIA IMed. Barrier Curb & Grate Inlet CB7DIAB 0.29]1 40.00 7.07 2.78 7.61 2.82 8.15 2.86 8.70 291

CB#41 7X7 Med. Barrier Curb & Grate Inlet CB7X7B 0.29] 28.00] 6.91 262] 745 266] 799 270] 853 2.74
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Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 48 54 60 66 72 78
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.

of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of

Type: Grate Structure Cover Cover Cover Cover Cover Cover

CB#41 8' DIA IMed. Barrier Curb & Grate Inlet CB8DIAB 0.33] 40.00 7.12 2.79 7.66 2.83 8.20 2.87 8.74] 2.91

CB#41 9X9 JMed. Barrier Curb & Grate Inlet CB9X9B 0.38] 28.00] 6.99 2.61] 754 2.66] 8.08 2.70] 8.62 2.74)  9.16 2.78] 9.70 2.82

CB#42 32'X32"  [Drop Inlet Grate DI32X32 0.12] 5.08

CB#42 4X4 JDrop Inlet Grate DI4X4 0.17] 28.00

CB#42 5' DIA JDrop Inlet Grate DI5DIA 0.21] 40.00] 6.65 244 719 248) 7.73 252] 827 2.56

CB#42 572"X572" |Drop Inlet Grate DI62X62 0.22] 28.00 6.74 2.52

CB#42 6' DIA |Drop Inlet Grate DI6DIA 0.25§ 40.00 6.69 2.44 7.23 2.48 7.78) 2.53 8.23 2.48

CB#42 7' DIA |Drop Inlet Grate DI7DIA 0.29) 40.00 7.07 2.78) 7.61 2.82 8.15) 2.86) 8.70 2.91

CB#42 7X7 |Drop Inlet Grate DI7TX7 0.29) 28.00 6.99 2.70 7.53 2.74] 8.08 2.79] 8.62 2.83

CB#42 8' DIA |Drop Inlet Grate DISDIA 0.33] 40.00 7.12 2.79 7.66 2.83 8.20 2.87 8.74] 2.91

CB#43 8X4 |Drop Inlet Grate DI8X4 0.33] 20.00 6.700W  2.37 7240y 241 7.78)W 245

CB#43 8X52"  |Drop Inlet Grate DI8X62 0.33] 20.00) 6.86 253] 7400w 257] T7.95)W  2.62

CB#43 8' DIA JDrop Inlet Grate DISDIA 0.33] 40.00] 7.03 2700 757 2.74) 812 2.79] 8.66 2.83

CB#44 9X9 JDrop Inlet Grate DI9X9 0.38] 28.00] 7.08 270 7.62 2.74] 8.16 2.78] 8.70 282] 9.25 2870 9.79 291

CBi#45 8X4 Med. Barrier Curb & Grate Inlet CB8X4B 0.33] 20.00] 6.78]W 245 732w 249 786w 2.53

CB#46 9X9 JMed. Barrier Curb & Grate Inlet CB9X9C 0.38] 28.00] 7.16 2.78] 7.70 2.82] 825 2.87] 879 291] 933 295 987 2.99

CB#5152"X5?2"  JRetaining Wall Curb & Grate Inlet ~ JCB62X62R 0.22] 28.00] 6.83 2.61

CB#51 7X7 JRetaining Wall Curb & Grate Inlet  JCB7X7R 0.29] 28.00 7.07 2.78) 7.62 2.83 8.16) 2.87 8.70 2.91

CB#51 9X9 |Retaining Wall Curb & Grate Inlet ~ JCBIX9R 0.38]) 28.00 7.33) 2.95 7.87 2.99 8.41 3.03) 8.95 3.07 9.50 3.12) 10.04 3.16

CB#52 9X9 JRetaining Wall Curb & Grate Inlet ~ JCBIX9R 0.38] 28.00] 7.33 2951 787 299] 841 3.03] 8.95 3.07] 950 3.12] 10.04 3.16
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Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 48 54 60 66 72 78
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of | Depth | Depth of

Type: Junction Structure Cover Cover Cover Cover Cover Cover

MH#3 4' DIA IManhole MH4DIA 0.17] 40.00

MH#3 5'DIA [Manhole MH5DIA 0.21] 40.00

MH#3 5'2"X5'2" |Manh0|e MH62X62 0.22] 28.00 6.89 2.67

MH#3 6' DIA |Manh0|e MHG6DIA 0.25] 40.00 6.33 2.08

MH#3 7' DIA |Manh0|e MH7DIA 0.29] 40.00 6.33 2.04 6.88 2.09 7.42 2.13

MH#3 7X7 [Manhole MH7X7 0.29] 28.00] 7.14 2.85] 7.68 2.89] 822 293 8.76 2.97

MH#3 8' DIA JManhole MH8DIA 0.33] 40.00] 6.42 209 6.96 213 750 2.17)  8.04 221

MH#3 9' DIA JManhole MHIDIA 0.38] 40.00] 6.42 204 6.96 2.08] 7.50 2.12)  8.04 2.16] 8.58 2.20

MH#3 9X9 JManhole MH9X9 0.38] 28.00] 7.14 2.76] 7.68 2.80] 822 2.84) 877 289 931 293 9.85 2.97

MH#3 10' DIA IManhole MH10DIA 0.42] 40.00] 6.42 2.00] 6.96 204 750 2.08] 8.04 2.12] 858 216 9.13 221
JB#1 32"X32" Junction Box* JB32X32 0.12] 50.00

JIB#2 4X4 Junction Box* JB4AX4 0.17] 50.00

JB#3 5'2"X5'2" Junction Box* JB62X62 0.22] 50.00 6.34 2.12

JB#4 7TXT7 Junction Box* JB7X7 0.29] 30.00 6.58 2.29 7.12 2.33 7.66 2.37 8.20 2.41)

JB#5 9X9 Junction Box* JBIX9 0.38] 30.00 6.92 2.54 7.46 2.58 8.00 2.62 8.54] 2.66) 9.09 2.71 9.63 2.75
JB#6 4' DIA Junction Box* JBADIA 0.17] 20.00

JB#6 5' DIA Junction Box* JB5DIA 0.21] 40.00 6.65 2.44

JB#6 6' DIA Junction Box* JB6DIA 0.25] 40.00] 6.69 2.44)

JB#6 7' DIA Junction Box* JB7DIA 0.29] 40.001 7.07 2.78) 761 2.82] 815 2.86] 8.70 291] 9.24 295 9.78 2.99

JB#6 8' DIA Junction Box* JBBDIA 0.33] 40.001 7.12 279 7.66 2.83] 8.0 287 8.74 291] 9.28 2.95] 9.83 3.00

JB#6 9' DIA Junction Box* JBIDIA 0.38] 40.00] 7.16 278} 7.70 2.82] 8.25 287 8.79 291] 9.33 2.95) 9.87 2.99

JB#6 10' DIA Junction Box* JB10DIA 042] 40.00] 7.21 279y 7.75 2.83] 829 2.87] 8.83 291] 9.37 2950 9.92 3.00

Stub Stub into Culvert STUB 0.00] none 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
* Maximum Depth for use in Geopak equals tabulated depth (to top of structure) + Minimum Depth based on pipe size.

Add an additional 2 feet for mimimum cover over structure to Minimum Depth of Cover if junction box is within the clear zone.

Type: Outlet

Pipe

|Endwa|| Endwall for outlet pipe(generic) EW 0.00} Size* 4.00 0.00] 450 0.00] 5.00 0.00] 550 0.00] 6.00 0.00] 6.50 0.00
Joutlet Stub Stub into existing structure STUB 0.00] none 0.00 0.00 0.00 0.00, 0.00 0.00 0.00 0.00 0.00 0.00 0.00, 0.00,
|Ditch Outlet Special ditch end STUB 0.00§ none 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

* During initial design, set the Maximum Depth to a value greater than the expected pipe size and the Minimum Depth of Cover to 0.00. Once pipe size is determined, reset the Maximum Depth to the designed pipe
size + the distance to the top lip of the endwall to be used with the pipe and reset the Minimum Depth of Cover to the distance to the top lip of the endwall.
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Table B Pipe Sizes 48" - 78"

Drainage Node Cell Drop Max. Pipe Sizes
Node Description Name Across | Depth 48 54 60 66 72 78
Name Bottom Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min. Min.
of Depth | Depth | Depth | Depth | Depth| Depth | Depth| Depth | Depth ] Depth | Depth] Depth
Type: Other Structure of Cover of Cover of Cover of Cover of Cover of Cover
JEW Inlet Endwall inlet into drainage system JEW 0.00 gi'f(f* 4.00 0.00] 450 0.00] 5.0 0.00] 550 0.00] 6.00 0.00] 6.50 0.00
IDitch Begin Begin special ditch STUB 0.00§ none 0.00 0.00, 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
IDitch Change Special ditch shape change STUB 0.00] none 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00] 0.00 0.00

* During initial design, set the Maximum Depth to a value greater than the expected pipe size and the Minimum Depth of Cover to 0.00. Once pipe size is determined, reset the Maximum Depth to the designed pipe
size + the distance to the top lip of the endwall to be used with the pipe and reset the Minimum Depth of Cover to the distance to the top lip of the endwall.

Type: Headwall

Culvert Endwall  JPipe Culvert Endwall(generic) |EW 0.00§ none 0.00 0.00 0.00 0.00, 0.00 0.00 0.00, 0.00, 0.00 0.00 0.00 0.00
Type: Grate - Bridge Drains

BD 2'X8'7" IBridge End Drain BD2X8 0.00] 350

BD 4'X8'7" JBridge End Drain BD4X8 0.00] 350

BD 2'X9" |Bridge Deck Drain BD9X2 0.00] 150

Type: Curb - Bridge Drains

BD-PRPT |Bridge Deck Drain - Parapet BDPRPT | 0.00] none | | | | | | | | |




Appendix B

Completing Drainage Areas

This exercise shows options for the user to calculate drainage areas not included in the survey

TIN file.
Step 1.

Step 2.

Step 3.

Step 4.

Create a TIN Surface for areas outside the Survey TIN. Follow the processes
outlined in the TIN Surfaces from DEM document available from the Roadway
Design Division — CADD Standards and Downloads website.

Merge the project Final TIN with the TIN surface created in Step 1.
a. Open DTM Tools by clicking Applications> GEOPAK> Road> DTM Tools.
b. Within the DTM Tools dialog select Build Merge TINSs.

Build Triangles
Build Lattice

Build Merge TINs

Build Clip TIN

Build Pad

&
% 3
o e = [ e e

Build Delta TIN

Open as ToolBox

c. Set Old TIN: to the TIN File created in Step 1. Set Mrg TIN: to the Final
Project TIN file. Create a unique name for the New TIN: file.

M Merge TIN Files | = | ‘ﬂh‘

Mrg TIM: | final.tin

212 Lo

Mew TIN: | expanded.tin

d. Click Process.

Visualize contours for the New Merged TIN utilizing steps from the TDOT
GEOPAK Road Course Guide, Exercise 22b.

Use this process with DTM tools presented in this document in conjunction with
MrSID images or other aerial photography to determine approximate flow paths
and drainage areas.

NOTE: MrSID images can be attached by following the process in the Using
MrSID Image Files in MicroStation document.

Example image with expanded surface information:

GEOPAK Drainage V8i (SELECT Series 2) Completing Drainage Areas B-1


https://www.tn.gov/content/dam/tn/tdot/roadway-design/documents/cadd_files/documents/TIN%20Surface%20From%20DEM.pdf
https://www.tn.gov/content/dam/tn/tdot/roadway-design/documents/cadd_files/documents/TDOT%20GEOPAK%20Road%20Course%20Guide.pdf
https://www.tn.gov/content/dam/tn/tdot/roadway-design/documents/cadd_files/documents/TDOT%20GEOPAK%20Road%20Course%20Guide.pdf
http://intranet.tdot.tn.gov/asstchiefengrdesign/Design/v8design/Using%20MrSID%20Image%20Files%20in%20MicroStation.pdf
http://intranet.tdot.tn.gov/asstchiefengrdesign/Design/v8design/Using%20MrSID%20Image%20Files%20in%20MicroStation.pdf
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Appendix C

Common Network Errors and Fixes

This information shows common network errors experienced and possible solutions to correct
them.

Error:
Link SS- # velocity less than minimum desired.
Solutions:
Increase the slope of the pipe/ditch.
Decrease the size of the pipe/ditch (if possible) (Smaller flow area means
higher velocity).
Change the type of pipe/ditch (if possible) (Smoother pipes typically have
higher velocities).
Error:
Link SS - # velocity greater than maximum desired.
Solutions:
Decrease the slope of the pipe/ditch.
Increase the size of the pipe/ditch (if possible) (Larger flow areas means
lower velocity).
Change the type of pipe/ditch (if possible) (Rougher pipes typically have
lower velocities).
Error:
Capacity for Inlet CB - # Exceeded Bypass Flow Unassigned.
Solutions:
Assign a downstream node to accept the bypass.
Use double or other multi-grate catch basin or drop inlet.
Add additional upstream catch basin(s) to ensure all runoff is captured
within the system.
If none of the above are feasible/practical, ensure the bypass flow has a
place to flow into another storm drain system or roadside ditch and the
error can be ignored.
Error:
Computed Ponded Width for Inlet CB - # Exceeds Maximum.
Solutions:

Move closer to upstream catch basin.
Add additional catch basin upstream.
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Error:
HGL Blowout upstream of Link SS - # minimum freeboard not achieved

Solutions:
For Storm Sewers: Increase pipe size.
Increase pipe slope.
For Ditches: The top of node should be above the Hydraulic
Grade Line (HGL). Confirm the HGL is below
the soffit and ignore error.
Error:

Min/Max Depth Exceeded at Upstream/Downstream of Link SS- #.

Solutions:
For Storm Sewers: Check held elevations and slopes in the Link
Configurations Conditions dialog.
For Ditches: Confirm node/link elevations are correct and
ignore error.
Error:

Profile Warning for Link SS - #:
—>Minimum Slope used for Positive Drainage
—>Check Held Elevations and Slopes

Solutions:

Check held elevations and slopes in the Link Configurations Conditions
dialog. Make changes as necessary.

Error:
Soffit elevation adjusted for ditches:
Solutions:

No correction required, normal adjustment required when ditch inverts are
held at specific elevations.

Error:

Catch Basin Minimum Depth exceeded on most catch basins,
depth gets progressively deeper from beginning of network to end.

Solutions:

Check Link preferences, turn off rounding of link slopes if on.
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Manning's N and Intercept K Values

Appendix D

From Hydraulic Engineering Circular No. 22, Third Edition
URBAN DRAINAGE DESIGN MANUAL

USDOT & FHWA Pub No FHWA-NHI-10-009 September 2009

Table 3-2. Manning's Roughness Coefficient (n) for Overland Sheet Flow

Surface Descripiion n

Smooth asphalt 0.011
Smooth concrete 0.012
Ordinary concrete lining 0.013
zood wood 0.014
Brick with cement mortar 0.014
Vitrified clay 0.015
Castiron 0.015
Corrugated metal pipe 0.024
Cement rubhle surface 0.024
Fallow (no residug) 0.05
Cultivated soils

Fesidue cover = 20% 0.06

Fesidue cover = 20% 017

Range (natural) 013
Grass

Short grass praine 015

Dense grasses 0.24

Bermuda grass 0.41
Woods®

Light underbrush 0.40

Dense underbrush 0.80

*When selecting n, consider cover to a height of about 30 mm. This is only part of
the plant cover that will obstruct sheet flow.

Shallow Concenfrated Flow Velocity. After short distances of at most 130 m (400 ft), sheet
flow tends to concenirate in rills and then gullies of increasing proportions. Such flow is
usually referred to as shallow concentrated flow. The velocity of such flow can be estimated
using a relationship between velocity and slope as follows

V=Kyk Sp'ls
where:
Ky = 1.0{3.28 in English units)
W = Velocity, m's (ftfs)
k = |Intercept coefficient (Table 3-3)
Sy = Slope, percent

39

(3-4)
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From Hydraulic Engineering Circular Mo. 22, Third Edition
URBAN DRAINAGE DESIGN MANUAL
USDOT & FHWA Pub Mo FHWA-NHI-10-009 September 2009

Table 3-3. Intercept Coefficients for Velocity vs. Slope Relationship of Equation 3-4."
Land CoverfFlow Regime k

Forest with heawy ground litter; hay meadow (overland flow) 0.076
Trash fallow or minimum tillage cultivation; contour or strip cropped; woodland 0.152
(overland flow)
Short grass pasture (overland flow) 0.213
Cultivated straight row {overland flow) 0.274
MNearly bare and untilled (overland flow); alluvial fans in western mountain regions 0.305
Grassed waterway (shallow concentrated flow) 0.457
Unpaved (shallow concentrated flow) 0.491
Paved area (shallow concenfrated flow); small upland gullies 0619

Qpen Channel and Fipe Flow Velocity. Flow in gullies empties into channels or pipes. Open
channels are assumed to begin where either the blue stream line shows on USGS quadrangle
sheets or the channel is visible on aerial photographs. Cross-section geometry and roughness
should be obtained for all channel reaches in the watershed. Manning's equation can be used
to estimate average flow velocities in pipes and open channels as follows:

V= (Ky/n) R2® 512 {3-8)
where:
n = Roughness coefficient (see Table 3-4)
Yo = Welocity, mis (ft/s)
R = Hydraulic radius (defined as the flow area divided by the wetted perimeter), m (ft)
S = Slope, mim (ftfi)
Ky = Units conversion factor equal to 1 (1.4% in English units)

For a circular pipe flowing full, the hydraulic radius is one-fourth of the diameter. For a wide
rectangular channel (W = 10 d), the hydraulic radius is approximately equal to the depth. The
fravel fime is then calculated as follows:

Ta=L/S(B0V) {3-6)
where:

Ty = Travel ime for Segment |, min

L = Flow length for Segment [, m (ft)

Yo = Welocity for Segment |, mis (fi/s)

3-10
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Manning's N for Uniform Flow Appendix E

TOAT DESIGN GMSION DRAINASE MANUAL

ey 15, 211
Type of Channel and Description hiinimum Mormal flasimum
LIKED CHARMELS (Selected Linings)
a. Concrete
Trowel Finish 0.011 ootz oo1s
Flaat Finizh 0.013 o014 o016
Gunite, good section 0.016 ooig oox:
b. A=sphaht
Smiooth 0.013 o013z
Fiough 0.016 o016
EXCAVATED OR DREDGED
a. Earth,straightand uniferm
Clean, recenthy completed 0.016 oo1g oozo
Clean, ater weathering 001 ooz oozs
Grawel, unifrm section, dean 0.0zz oozs oozn
WNith shortgrass, few weads 0.0x2 ooz? oo3s
b. Brh, winding and =luggizh
Mo vegetation 0.02% 1M1 0030
Grass, some weads 0.025 o030 oo3z
Densze weeds or aquatic plants in deep channels 0.030 0035 oo4n
Earth bottorn and rnubble sides 0.025 o030 0035
Stony bottorm and w eedy sides 0.025 0035 0045
Cobble bottarmn and dean sides 0.030 oo40 oos0
. Dragline excawvated or dredged
Mo wegetation 0.025 ooza 003
Light brush on bank= 0.035 ooso 0 o60
d. Faock Cuts
Smiooth and uriform 0.025 0035 0040
Jagged and imegular 0.0%5 0040 ooan
&, Channels not maintained, uncat weeds and brush
Densze weeds as high as 1ow depth 0.0450 ooan o.azo
Clean bottom, brush on sides 0.040 oos0 oosn
Same, highest stage of fow 0.045 oovo o110
Denze brush, high stage 0200 o.ao0 0140
MATURAL STREAMS
1. Minor streames top width at 4ood stage <100 )
a. 5tmams on Plain
1. Clean, straight, full s3ge, no rits ordeep pools 0.025 oozo ooa:
2. 5ame as abowe, but mone stones and weeds 0.030 o035 o040
3. Oean, winding, =ome poals and shoals 0.033 o040 0 0ds
4. 5ame as abowe, but some weeds and stones 0.035 o045 ooan
4. Same as abowe, lower stages, more
ineflective slopes and sedions 0.040 oo4s 0045
Table 52-1

Yalues of Roughness

Coefiicient 'n' (Jniform Flow)
Referenca: Chow, Wwin T., Oper Chanme! Huoawics (1959)
Cantinne on following page

28-11
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Total Energy in Open Channel Flow

TOAT DESIGN DPASION DRAIMASE MANUAL

ey 15, X1
% Vi
+| = [=h + == |[+h =
&) [2 g] y [2 e [P (5-7)
Where: by = upstream weter surface elevation, ()

ha = downat ream water surface elevation, ()

“1= mean velocty upstream, (ftis)

Yo = mean velocity downstream, (fis)

b = head loss due to local cross sedional changes and fridion loss, (1)
g = acceleration dueto grasdty, (32.2 ft.fseczj

Figure 5-3illustrates the temn s inthe Energy equation. The eguation states that the total
energy head at the upstream location of & channel iz equal tothe sum ofthe energy head at the
next downsream location plus the energy head loszes between the two conseotive sections.
To apply the energy equation, greamlines mud be approximately straight and parallel =o that
vertical accelerstion can be negleded.

Total Enargy Line
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Figure 5-3

Total Energy in Open Channel Flow

5.03.3 MAHHING'S CHAHMHEL ROUGHHESS COEFFICIEHTS

Manning's equation is an em pirical relstionship in which the roughne sz coeficient, n, is
uzed to gquantit atively express the degree of retardation of flow. The ssledion of a Manning's
channel roughness coeffidert is wsually based on consideration of many factors, induding the
depth of flow, the s2aszon, the height of any obstructions, and the types of wegetation. Further,
the seledtion of a coeficient for a natural stream channel iz more dependent on engineering

GEOPAK Drainage V8i (SELECT Series 2)
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Pipe Selection Criteria Appendix G

TDOT DESIGH DIVISION DRAINAGE MAHUAL
June 15, 2016

Fill Height [feet)
|z PA0ftand <16 f [ > 16 and 3244 | > 24ft ard 2 288 | = 30 #
Irterstate systern and any arterial with ful access cortrd [Freeways)
Cresdahs,
TrawfFue e med @
EE"“ RCRCL I RCE CLIII RCRCL M RCRCLY e 3
Lowgtied lval stom
=174
Brterials
Croes da s RCRCL I RCF CLIII
g CMP 109 CHP 104 RCRCL W
Transus i5e med @ PG P R RCRCLY g
dalis HOREMR HOFE/MP
Lok qind i3l £t F“S.,:F':L i F“E.,:P ELin RCRCL W — J—
aa@ii HOPERP HDFE/MF P
Collectors
RCRGL I RCF GLIII
g“”“"‘ CME12g CNPR 129 RCRCL 1w RCP LY
P P CIF 12 g e 1
;Er.ssueme med b RETRE BETRD s CMP 129
HOREM®P HDR ERP
Lok gitd Ikal stom ES.,:F':L i E.E.CF ELin RGP GL 1w — .
da HOPERR HDOR EAF P
Local Roads
RCRGL I RCF GLIII
CME1ig CHPR i g RCRGL W
Croes das P P CIPR i g Eﬁﬁ';; e
SRTRF SRTF P
HOREMR HOR ERP
RCRCL I RCF CLIII
Lot gited lkal Som P P RCRCL W
D SRTRF SRTRP P REFCLY o ?
HOREMR HOR EMF
For &1l Road Systems
RCRCL I RCF CLI
§Ide Cralnmi
CME 16 CHE 14 g RGP GL W
Ses ohenies ot mekt | PG P CHE 14g CHRiig e
b SR SRTE PG
£ HOPE/FF HOR ERR
gﬁﬁé;' RCF GLIII
Longudirel Median P RGP GL 1w
Croia PG D i RCRGL Y e
i HOR EMP
HOPEM®P
Table 641

Pipe Zeledion Criteria Based on Svaem and Fill Height
[see hotes on hext page)
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Storm Sewer Sketch Appendix H
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IDF ZONE Location Map Appendix |

TDOT DESIAN DMSIOM DRAIN ASE MANUAL
January 1, 2010
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Hydrologic Design Criteria Appendix J

TDOT DESIGN DIVISION DRAINAGE MANUAL
January 1, 2010

Interstate Arterial

System and |\ out Full

Arterial With Access Collector Local Road

Full Access Control

Control

Inlet Design 1 1
Frequency 50-yr 10-yr 10-yr 10-yr
Sewer
Design 50-yr 10-yr ! 10-yr ! 10-yr
Frequency
Culvert 50-yr 50-yr 50-yr 50-yr
Design Check for Check for Check for Check for
Frequency 100-yr 100-yr 100-yr 100-yr
Roadway
Freeboard 2 50-yr 50-yr 50-yr 50-yr
Ditch Design 1 1
Frequency 50-yr 10-yr 10-yr 10-yr

! 50-year in Roadway Sag Sections

2 The design high water elevation should be at or below the bottom of the roadway

subgrade.

Table 4-1

Hydrologic Design Criteria

GEOPAK Drainage V8i(SELECT Series 2)
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Catch Basin Data Table Appendix K

Exercise 5 Catch Basin Values

CB Drainage Area Tc Discharge Spread Width
1 1.03 31.361 1.58 5.411
2 1.741 33.65 2.429 6.99

3 0.182 9.15 0.785 3.0179
4 0.581 3.724 1.877 6.029
5 1.275 34.154 1.282 3.073
6 0.257 1.595 1.343 5.5181
7 7.143 36.141 7 5.786
8 0.895 28.956 0.941 1.444
9 0.689 35.051 0.886 4.0723
10 2.733 37.2 2.63 1.725
11 0.191 34.8 0.337 1.759
12 0.199 1.421 1.106 4.836
13 0.156 1.238 0.877 7.273
14 0.286 2.372 1.767 4.81

GEOPAK Drainage V8i (SELECT Series 2) CB Data Table K-1



Runoff Coefficients Appendix L

January 1, 2010

Runoff
Surface Type and Condition' Coe:‘fét]nent
Rural Areas
Concrete or sheet asphalt pavement 08-09
Asphalt macadam pavement 06-08
Gravel roadways or shoulders, 04-06
Bare earth 02-09
Steep grassed areas (2ZH:1V) 05-07
Turf meadows 01-04
Forested areas 01-03
Cultivated fields 02-04
Urban Areas
Flat residential, with about 30 percent of area impervious, 0.40
Flat residential, with about 60 percent of area impervious 0.55
Moderately steep residential, with about 50 percent of area impervious 0.65
Moderately steep developed area, with about 70 percent of area impervious 0.80
Flat commercial/industrial, with about 90 percent of area impervious 0.80

1 B - )
For flat slopes and/or permeable soil, use the lower values. For steep slopes and/or impermmeable soil, use the
higher values.
For areas where there is a shallow bedrock surface, use the higher values.

Table 4-2

Runoff Coefficients (C) for Use in the Rational Method
Reference: USDOT, FHWA, HDS-4 (2001)

GEOPAK Drainage V8i (SELECT Series 2) Runoff Coefficients L-1



IDF Curve Appendix M

TDOT DESIGN DIVISION DRAINAGE MANUAL
January 1, 2010
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Lebanon IDF Curve

NOTE: Te = 5 minutes is a minimum value to use in all cases
Refersnce: Mational Weather Service, NOAA Atlas 14, Violume 2 (2004)
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